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1 - Introduction
Welcome to the next generation of Railroad Simulation and the fourth in the
current Trainz series.

With this, the 2005 Edition of Trainz Railroad Simulator (TRS2006), we have
created an open-ended, interactive, living, breathing world that lets you
customize the experience to suit your own personal tastes. Whether you want
to drive trains, manage the movements of passengers and goods, control
industry outputs or create your very own unique railroad route or layouts,
TRS2006 is the platform that helps your dreams come true.

The team at Auran wish to thank you for purchasing this evolutionary product
and we trust you will not only enjoy what’s in the box, but that you will also join
the rapidly growing online Trainz community to expand and enhance your
experience. Here you are able to download new content for free, share your
creations and ideas. Discover more about the world of Trainz at
www.railroadsimulator.com.
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3 - What’s New In TRS2006?
If you have enjoyed previous versions of the Trainz product, we’d like to
bring you up to date with a list of the major new features you will find in
TRS2006.

• All new localized content appeals to regional markets.
• Deeper and more complex routes take advantage of the many 

new features added since the release of TRS2004.
• Cab Control Graphical Interface available when in Cab Control. 
• Wheelslip and Coupler breakage enhancements made to the 

physics engine.
• New Animated Turnouts give trackwork a more realistic 

appearance.
• iTrainz in game chat allows users to talk to other users while 

playing.
• Backdrops: a new object type that is rendered regardless of the 

view distance settings.
• View camera can now be placed within passenger cars.
• New Content Manager Plus makes it easier to access and

organise content.
• Improved tutorials help first time users into the game.
• Hint and Tips added to Loading Screens.
• Added functionality on the Mini-map screen; query industry and

consist information.
• Re-styled Driver and Session menu screens allow for easier 

navigation of installed routes and sessions.
• New PaintShed with more flexible interface that is included as part 

of the installation.
• Over 50 rules, more than double the amount included with 

TRS2004.
• Bogey and bridge sounds supported.
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2 - About This Manual
The manual you are reading is designed to show you how to install TRS2006,
configure it to suit your PC and then get started with each of the major
components.

To gain a deeper understanding of each module and component, and to make
the most out of your Trainz experience, there are a number of other Guides
included in this manual.

As Trainz is constantly evolving, you should also visit the online community
section of the Trainz website to discover more about the latest updates and
improvements.

The website also contains additional documentation which provides more
information for those users who want to have a go at creating their own custom
content.
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Product Any commodity produced or required by industries 
that can be transported by a capable vehicle.

Passengers A special type of Product associated with passenger 
stations and passenger cars.

Railroad Equivalent to the term "railway" in Australia and 
Britain.

Bogey British/Australian term for a truck (wheelset) on a 
piece of rolling stock.

Industry Interactive scenery component placed on a route.
BR British Rail
QR Queensland Rail
SAR South Australian Railways

Tip: Train terminology varies greatly throughout the world (even
between English speaking nations), so please take note of any
unfamiliar terms in this section.
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4 - Conventions
Throughout this manual we use abbreviations and terminology that are
explained here.

TRS2006 Trainz Railroad Simulator 2006
CMP Content Manager Plus
CCP Content Creator Plus
DS Download Station
Click LMB Click on the left mouse button
Click RMB Click on the right mouse button
Click LMB+H Click on the left mouse button and hold it down
Click RMB+H Click on the right mouse button and hold it down
Zoom Zooming in or out using the mouse wheel or 

PageUp/PageDown keys
Compass The three-dimensional compass cursor in Surveyor.
Red Lights Red LED-like buttons
Green Lights Green LED-like buttons
KUID/KUID2 Unique identifier for an object
Turnout To simplify things this refers to a point or a 

junction, so as not to confuse it with a switch lever, 
which is used to control a turnout.

Switch Lever used to control a turnout
Driver An artificial intelligence (AI) avatar that can be given 

commands in a Driver session (also the name of 
the driving simulation module).

Consist Any mixture of rolling stock and/or locomotives
Loco Short term for Locomotive. Normally refers to the 

powered unit of any consist.
Vehicle Refers to a piece of railroad rolling stock. Can be a 

loco, passenger car or freight wagon.
Route A map defining world objects, (rails, industries, 

scenery, etc.) textures and terrain.
Session A Driver session associated with a Route capable of 

being run as a self-contained activity.



9

Install Shield
The Install Shield will now guide you through the steps of the installation
process. When prompted, enter your CD Key in upper case.

For further help in installing TRS2006, please refer to the Readme file found
in the install directory of Trainz or on the TRS2006 Disk.

Tip: Once you have installed TRS2006, be sure to register with Planet
Auran to get all the benefits that come with being a registered user
such as new content and the forums. See section 7.1 for further
details.

8

5 - Installation
Before installing, ensure that you have sufficient disk space (of at least 4GB)
and that you have no other programs running.

WARNING: Please turn off any virus scanning programs for the
installation! Don’t forget to turn your virus scanner back on once
the installation is over.

Begin the installation process by inserting the TRS2006 DVD Disk or CD Disk
1 into your CD/DVD drive. 

CD Users
Begin the process by inserting disc #1 into your CDROM drive.  If you have
auto play enabled you will be presented with the install shield program that will
guide you through the installation process.  If the install shield does not appear
try double clicking on your CDROM drive through My Computer or manually
browse the contents of the CD and double click on the SETUP.EXE file found
in the root directory of the CD to start the installation process.

DVD Users
Begin the process by inserting the DVD into your computers DVD drive.   If
you have auto run enabled on your computer you will be presented with the
Trainz2006 DVD menu.  If you don't have auto run enabled and no menu
appears try double clicking on your DVD drive through My Computer or
manually browse the contents of the DVD and double click on the
AUTORUN.EXE file found on the root directory of the DVD. 

Once you are presented with the DVD menu you can choose to either install
TRS2006 or view the bonus movie that has been included. 

When you choose to install TRS2006 the DVD menu will close and the Install
Shield will now begin to guide you through the installation process.
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Manual
Opens up the .PDF version of the Trainz manual (i.e. what you are reading
now). The Adobe® Reader® application must be installed for you to view this
manual.

Website
This will open up your browser to the TRS2006 community website where tens
of thousands of Trainz fans are ready to help you with your questions and
share experiences.

Extras
A number of extra documents from Auran and the 3rd Party Content Creators.

Read Me
Opens the readme text file which details last minute information about this
release of Trainz.

Quit
Closes the TRS2006 Launcher menu.

We strongly suggest that you check out these other menu items and
familiarize yourself with the Options, Read Me and Trainz Website.
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6 - TRS2006 Launcher
Once you have successfully installed TRS2006, Double Click on the TRS2006
icon on your Desktop (or at Auran > on the Start menu) to access the Trainz
Launcher menu.

The Trainz Launcher menu has a number of items:

Start
This will launch Trainz.

Options
Enables you to customize your settings for Trainz, including your Planet Auran
settings, display settings and advanced graphics features such as shadows.
Chapter 7 of this manual examines these settings in detail.

Manage Content
This will start Content Manager Plus, a utility to help you manage your Trainz
content and to download additional content. Chapter 17 of this document
examines the CMP utility.
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If you have not already joined, click on the "Sign up for a new account"
button to register. This will launch your default browser with the Planet Auran
registration page that will guide you through the registration process. You will
need to have an Internet access and be online to do this. 

Once you’ve registered, by using Content Manager Plus you’ll have access to
over 40,000 different items such as routes, engines, rolling stock, buildings,
bridges, track, etc so that you can build exactly the rail empire you want to.

Once you have joined Planet Auran, you can enter your Username and
Password and check the "Always Online" box.
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7 - Configure TRS2006
This is where you can customize various options to maximize your enjoyment
of Trainz Railroad Simulator 2006.

7.1 Planet Auran
Planet Auran is the rapidly growing online community that is free for all
TRS2006 users to join.

Why join? Because there is an incredible wealth of additional information and
content available that will enormously expand your enjoyment of TRS2006.
Highlights include: 

• Additional files and utilities that help you get the most out of 
TRS2006;

• Online forums (message boards) where you can ask questions 
you have about using TRS2006 and learn from others; and

• Interactive online features like iTrainz Chat and iPortal.
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scene, it is possible to make the latest hardware struggle. Quite simply, the
better your hardware, the better the performance.

To balance scene density and frame rate, your challenge is to decide whether
to decrease the sliders, thereby lowering the quality or upgrade your hardware
to improve performance.

Note: These settings are also accessible in the Driver and Surveyor
modules under the main menu. See sections 9.14 and 11.13.8 for
further details.

Ground - Texture Passes
Determines the number of ground textures per area. Set Texture Passes to the
first notch (0) and you will see square textures. Moving the setting to '1' and
you will notice one set of textures blend into the next one. Some graphics
cards handle multiple textures better than others.
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7.2 Display Settings
Next, click on the Display Settings menu tab. DirectX mode or OpenGL mode
can be used depending on your graphics hardware requirements. For older
systems, DirectX generally improves rendering speed. Experiment to see
which graphics setting works best with your hardware. Display Resolution
determines what resolution your screen will run at. Bit Depth should be left at
32 bit unless your graphics card doesn’t support 32 bit graphics.

Note: Ensure that your latest graphics drivers are installed for
maximum performance.

7.3 Tuning Settings
This is where you can configure TRS2006 to create a balance between your
hardware and your graphical performance and frame rate. Each of the sliders
affects the way the graphics are handled in Trainz and only the latest systems
will allow you to run with "full sliders" (moved to the right) and maintain
satisfactory frame rates. Even then, by adding more objects or trains to a
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Effects - Bad Weather Fog
Works in the same manner, but is only drawn when it is raining or snowing.

Effects - Particle Effects
Level of effects such as smoke from a locomotive or factory chimney. The
lower the setting, the less smoke etc. you will see, but your graphics
performance will increase.

7.4 Advanced Options
These options let you tweak some of the other hardware related systems to
improve performance even more. The main bottleneck on current graphics
cards is the Shadows option. Turning this option off will generally improve your
performance dramatically. For a full explanation of the other options, please
read the Readme found on the Trainz Launcher.
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Ground - Detail Level
Defines the degree of definition in the terrain. The lower the settings, the lower
the number of ground polygons drawn.

Ground - Draw Distance
Defines the maximum viewable distance of the ground. A higher setting will
stop the ground "popping" into view, but requires a more powerful video card.

Scenery - Draw Distance
Determines the maximum viewable distance of the scenery objects. Generally
you should set this at a similar scale to the ground draw distance.

Detail Maximums - Trains Poly Count
Determines how many polygons will be allocated to the locos and wagons on
screen. The number of cars displayed at one time also affects this rate, so a
low setting with lots of cars will result in some deformation of the models.

Detail Maximums - Spline Editing
Can be set at 3 levels. At the simple setting, the splines are drawn in "white
line" form until you have finished laying the last spline point. At the detailed
level, the splines are updated dynamically as you are laying them.

Effects - Gamma
Sets the brightness of the screen while in TRS2006. If you are finding the
screen too dark move the Gamma slider to the right, if it's too bright move the
Gamma slider to the left.

Effects - Good Weather Fog
Adjusts the distance the "fog" is drawn. The lower the setting, the less fog is
drawn. Fog itself, however, doesn't place a high load on your system. Rather,
it is used to disguise the visual artifacts that can occur in the distance if your
sliders are set low. Therefore, it is recommended that if you have your general
performance sliders set low, you should increase the fog slider to hide the
visual "clipping".
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-disablestencil
Overrides the StencilBits selection and forces it to zero.

-ColorBits=XXX
Selects the number of bits used for the color buffer. Usually 16, 24, or 32.
Larger numbers result in better color accuracy and less dithering. Some cards
may require ColorBits = (DepthBits + StencilBits)

-Jet=XXX
Provide the path to the Jet folder. In the release version of Trainz, this is the
path from the Trainz directory to the bin directory, ie. "bin". For internal builds,
this usually points at the "Jet" directory, not "Jet/Bin". This option is required,
if it is set incorrectly Trainz will crash at load time.

-ResourceMemory=XXX
Specifies the amount of memory reserved (in megabytes) for resource disk
caching. This will prevent Trainz from accessing the disk as often, reducing
caching time and 'stutter' caused by slow disk access. This option defaults to
0.

-vsync
Activates 'vertical sync'. This option may be overridden by the video card
driver settings. When active, vertical sync results in smoother updates (no
visual tearing) but lower frame rates. This is usually a good thing. This is
equivalent to "-vsync = 1".

-vsync=XXX
See "-vsync" for more info. Allows finer control over vsync, attempting to synch
to every second frame ("-vsync=2") or every third frame ("-vsync=3") etc.
Larger numbers lower the maximum possible frame rate further but may
improve the chance of achieving a steady frame rate. Probably not useful for
most people.
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7.5 Configuration File Settings
You can also tweak performance of TRS2006 to suit your PC hardware by
using a text editor like Notepad to edit the "trainzoptions.txt" file. You will find
the "trainzoptions.txt" file in the directory into which you've installed TRS2006.

WARNING: Please be aware that these command line parameters
are to be used at your risk. If you experience any problems with
your copy of TRS2006, including crashing or visual problems,
return your "trainzoptions.txt" to its original state (see Section
9.4) before contacting the Auran helpdesk. Auran will not be able
to provide support on issues that relate to the use of these
options. Before you start playing with the "trainzoptions.txt" file
why not make a backup of the default "trainzoptions.txt" file by
saving the file with a different filename, say "trainzoptions.BAK".

7.5.1 Command Line Parameters

-DepthBits = XXX
Select the number of bits used for the z-buffer (depth buffer.) Available choices
are generally 16, 24, or 32. Some video card drivers incorrectly interpret '32'
as '16', so '24' may give better results on these cards. When a stencil buffer is
used, the depth bits may need to be adjusted down according to the size of
StencilBits; ie. 24 depth + 8 stencil = 32 total. It is possible that this option can
be overridden by the settings for the video card driver.

-StencilBits=XXX
Selects the number of bits used for the stencil buffer. Usually 0, or 8. A stencil
buffer is required for Trainz to render shadows. Some cards do not support
stencil buffers, or do not support stencil buffers in certain resolutions / modes.
Where a card does not support a Stencil Buffer, the driver will sometimes
attempt to use a Software stencil buffer, which is very slow. Generally a 24 or
32 bit DepthBits is required in order to enable the Stencil Buffer.
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graphics cards. Larger numbers will improve the z-buffer accuracy and may
provide less artefacts, especially in 16-bit depth buffer modes, however there
may be problems viewing nearby objects such as inside cabin view.

-zfar=XXX
Override the default z-buffer far distance. Specified in meters. The default is
1500m. Decreasing the far distance will result in slightly improved z-buffer
accuracy but will result in far-away objects not being visible (Note: this may not
result in a speed gain if a high draw distance is specified in the Trainz tuning
screens as Trainz will still consider the far-away objects as visible even if the
video card is unable to render them.) Increasing the z-buffer distance probably
isn't useful as Trainz doesn't allow the selection of draw distances greater than
about 1300m, and the z-buffer accuracy will be decreased causing visual
artefacts.

-disablefog
Causes fog to be completely disabled.

-fullscreen
Causes Trainz to take over the chosen display. This is the preferred mode.

-windowed
Causes Trainz to run in a window. This is useful for debugging, however may
result in reduced frame rate and cause visual 'stutters', especially in DirectX
mode.

-dualhead
Enables support for dual-display mode. This will only work if you have two
displays attached to a single video card acting as a single, large display (i.e.
single frame-buffer). This wont work if there are two displays on different video
cards or configured to act as independent displays. Currently dualhead
support is only utilized in the Driver module. This option requires that a
dualhead resolution is selected (ie. 8:3 ratio) and that Trainz is run in fullscreen
mode. On some video cards this option may require you to switch to the
appropriate resolution prior to launching Trainz.
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-frequency=XXX
Attempt to force the refresh rate of the display to the specified frequency (in
Hz.) If the video card does not support the specified frequency at the specified
resolution, this may cause Trainz to exit on load with a "check your settings"
message. Some common frequencies are: 60, 70, 72, 75, 85. Higher numbers
provide visually better results as long as the display properly supports the
requested frequency. Selecting a frequency which is supported by the video
card but too high for the display is untested and could cause the display to
become garbled.

-width=XXX
Manually specify the window/screen width (in pixels). When in fullscreen
mode, this must match one of the available display resolutions, and an
appropriate height must be selected. When in dualhead or surround modes
this is the horizontal resolution across all displays, not across a single display.

-height=XXX
Manually specify the window/screen height (in pixels). When in fullscreen
mode, this must match the Width setting used. Width-to-Height ratios other
than 4:3 are untested. When in dualhead or surround modes, this is still the
vertical height of a single display.

-640
Equivalent to specifying "-width=640" and "-height=480".

-800
Equivalent to specifying "-width=800" and "-height=600".

-1024
Equivalent to specifying "-width=1024" and "-height=768".

-znear=XXX
Override the default z-buffer near distance. Specified in meters. The default is
0.1 meters. Smaller numbers allow the viewing of objects closer than 10cm but
rapidly decrease the z-buffer accuracy and will cause visual artifacts on most
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-intro=XXX
Changes the playing mode of the Trainz loading movies. Available options are
"disable" and "fullscreen". Fullscreen causes the movies to be played in
fullscreen mode instead of centered on the screen. Disable skips the intro
movies.

-quit
Causes Trainz to quit after the loading sequence has completed. Used for
diagnostic purposes only.

-DisableEnvMap
Causes Trainz to not render Environmental maps. This may improve
performance on certain minimum-spec (or lower) graphics cards.

-framerate=XXX
Requests that Trainz limit the frame rate to the specified number of fps. Not
tested. Doesn't appear to work with vsync enabled. May help with maintaining
a stable frame rate on faster machines.

-render=renderdirectx
Cause Trainz to use the Direct3D API for graphics rendering as opposed to
OpenGL (default). This may improve performance or compatibility where the
video card drivers do not correctly support OpenGL.

-autopilotsignaldistance = XXX
Modifies the autopilot signal-visibility distance, specified in meters. Default
value is 200m. Smaller values are not permitted. This will affect how the
autopilot reacts to the signals - how soon it will begin to slow down and how
close to the signal it will attempt to stop.

-disableztest
Turns off z-buffer testing for coronas (signal flares, headlights, sun.) This will
make the flares shine *through* other objects, however will reduce artefacts
with the ground and train clipping the flare.
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-surround
Enables support for triple-display (triple-head / surround gaming) mode. This
will only work if you have three displays attached to a single video card acting
as a single, large display (ie. single frame-buffer.) This wont work if there are
three displays on different video cards or configured to act as independent
displays. Currently surround gaming support is only utilised in the Driver
module. This option requires that a surround gaming resolution is selected (ie.
12:3 ratio) and that Trainz is run in fullscreen mode. On some video cards this
option may require you to switch to the appropriate resolution prior to
launching Trainz.

-disablecarz=X
Default 0 (carz enabled). If set to 1 (carz disabled), then carz will not appear
on roads. This may (untested) result in smoother framerates. Experimental
only.

-framestoaverage=XXX
This option controls the 'smoothing' of frame rate timing. Increasing this option
may result in less visual 'stutter', however can cause period 'surges' if rapid
changes in frame rate occur. Increasing this option may be useful for high-end
machines with fast graphics cards where the frame rate remains fairly
constant. Default is 4, maximum is currently 16, minimum is 1 (no averaging.)

-heartbeat=XXX
Specify the time interval at which the physics heartbeat occurs (in seconds).
Defaults to 0.03sec. Larger intervals decrease processor usage for physics at
the expense of accuracy. Intervals larger than 0.05sec are not recommended.
Changing this option is probably unnecessary and may have a negative
impact on physics accuracy.

-filter=XXX
Specify the texture filtering mode. Default is trilinear which provides the best
visual results. Other options are bilinear and none. This option is unlikely to
provide performance gains, except perhaps on minimum-spec (or lower)
graphics cards.



25

7.6 Troubleshooting
If you get any error messages or have problems while running Trainz, please
read the Readme found on the Trainz Launcher for general information on how
to solve these issues. Make sure that you have the latest video card drivers
installed and that you have installed DirectX 9 or above.

You can also visit the website and go to the Technical Support section for the
latest fixes and solutions. Another excellent source of information is the Trainz
forums where users just like you offer tips and tricks for almost any aspect of
using Trainz or getting the most out of your experience.
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-showcachebar
This option enables the display of the cache bar. The cache bar is the
horizontal red bar that appears in the bottom left corner of the screen when
assets are being loaded such as when you open a route up or a moving
around in a large route. Unlike previous versions of Trainz, TRS2006 does not
have the cache bar displayed by default.

-debug
Including this option enables debug mode. The main feature of debug mode is
that it allows you to accelerate the game speed by holding down the Shift key.
This can be useful for content creators that might want to test their sessions
more quickly. However debug mode is not a supported feature and the
behavior of Trainz in not guaranteed when using the Shift speed-up.

-allownoctrlrightclick
Disables the requirement of having to hold the Ctrl key when using RMB top
open the menu of a vehicle or industry in Driver. Previous versions of Trainz
did not require the Ctrl key to use RMB to access the menu and this option
allows for those who prefer the older way.

7.5.2 Defaults
If you have been tweaking the "trainzoptions.txt" file and caused your
TRS2006 install to become unstable you can either copy in the backup file we
asked you to create in Section 9.2 or you can return it to the default
"trainzoptions.txt" file by making it read as follows:

-DepthBits=24 
-StencilBits=8
-fullscreen
-Jet=bin
-cabinfov=65
-driverfov=55
-DefaultAutoMip=none
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9 - Driver

9.1 Introduction
The Driver Module provides a lot more than just a train driving simulation.
TRS2006 provides you with a number of different ways of controlling the trains
on your railroad.

Firstly you can hop into the cab and explore the tracks from behind the throttle.
You can choose either the simple DCC speed control system or the realistic
Cab controls using each of the levers and switches in the cab. You can watch
the trains from trackside as they come thundering past, or from a bird’s eye
view tracking along with the train.

You can even switch to a Map View and control all the junctions, monitor
signals and control traffic flows from a 2D perspective.

While running multiple consists, you can choose to control each train yourself,
or let the computer AI system control the trains as you control the switches.

Finally, you can even issue specific orders to Drivers that you allocate to each
train.

In addition to the various systems of control, there is also a fully interactive
industry model that automatically generates waybills for goods that need to be
delivered to the various industrial sites. Your task under this mode is to
maintain the operation of these industries by controlling movement of goods
and resources along your railroad. You can watch as your train or the trains
under the control of your drivers are each loaded and unloaded at the various
industries. For more information about configuring an industry, see section
10.4.4 of this manual.

Note: This chapter is only an introduction to Driver. More detailed
instructions can be found in Chapter 12 - Engineer’s Guide.
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8 - Launching TRS2006
Use your mouse to highlight the menu options in the Trainz Launcher then use
the LMB on the "Launch Trainz" menu option and you will see the loading gear
rotating whilst Trainz takes a few moments to load.

In the Trainz Main Menu, there are 3 game modules to choose from: Surveyor,
Driver and Railyard, as well as the Trainz Exchange option.

The following sections of this TRS2006 Manual give you a basic
understanding into each of these areas.

Note: To find out more about the Driver module, read Chapter 9.
Surveyor is covered in Chapters 10 and 11.
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When you click on a Session, check the text information contained in the
Description window that appears in the top left of the screen. Note how the
"Load” button appears at the bottom right of the screen when a session has
been selected.

9.2.1 Tutorial Sessions
TRS2006 includes 6 introductory tutorial sessions to help you get started with
using Driver. The 6 tutorials listed in order are:

• Tutorial 1 - Controls (British Midlands 2)
• Tutorial 2 - Waybills (British Midlands 2)
• Tutorial 3 - Diesel Cab (City and Country USA 2)
• Tutorial 4 - Steam (Outback Australia 2)
• Tutorial 5 - Drivers (Highland Valley Industries)
• Tutorial 6 - Commodities (City and Country USA 2)

Note: The tutorial sessions take place on several different routes and
won’t appear in order on the Driver Main Menu. To get to a tutorial, find
its corresponding route in the above list and expand that route in the
Driver Main Menu.

To get started Click LMB on the "British Midlands 2" route. Then select
"Tutorial 1 - Controls". Once the session has been selected, Click LMB on the
load button found in the bottom right corner of the screen.
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9.2 Starting your Railroad Career
Once you have launched TRS2006, start Driver by Clicking LMB on the Driver
menu option.

Once Driver loads you will see a list of available Routes with the number of
sessions available for each route shown in the brackets next to it. Click on a
route, then select a session.
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that the selected car now becomes the focus of the view. You can also press
the "-" and "+" keys on the main keyboard to select the next or previous car in
the consist. You can even Click LMB on other trains to shift the focus to the
selected train or click on the consist icons in the 2D Map View as well.

9.3.3 Tracking Views
Now Click LMB on the Tracking View icon and your view changes
to the nearest Tracking camera. There are two types of cameras;
Static and Tracking, and these are placed in the 3D world in

Surveyor mode. Static cameras will stay fixed in direction and allow the
tracked object to move out of the frame. Tracking cameras are fixed in place,
but pan with the tracked object, keeping it in the center of the view. If there are
no Tracking/Fixed Cameras within visual range of the tracked object, the view
reverts back to the external view until a Tracking Camera comes within range.

9.3.4 Free Roaming View
The Free Roaming view is extremely flexible and operates in a
similar fashion to navigating in Surveyor. To move the camera focus
point, simply Click RMB in the 3D world to where you want the new

central focus point to be. The view smoothly moves to the new focus point.
Now you can use the cursor keys to rotate or change elevation and the mouse
wheel or Page Up/Page Down keys allow you zoom in and out. By holding
down RMB and moving the mouse you can continuously change the focus
point and hence the view. By combining this mouse movement with the cursor
keys and the zoom function it lets you roam around the scenery at your will.

9.3.5 Map View
The icon for the Map View is at the bottom right of the screen or you
can use the Ctrl-M shortcut key. You will find the Map View is useful
to get an overview of where your trains are in relation to the

industries, the track configuration, plotting your train movements, and
checking turnout settings and signal states.

On the 2D Map View you will see the position, length and name of each
Consist, the direction set for each turnout and important names for assets
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Trainz will now start running Tutorial 1 where you will be guided through all the
basic controls that make up the TRS2006 Driver interface. Once you have
gone through Tutorial 1, go through the other tutorials and see what else there
is to do.

9.3 Camera Controls – Controlling Your View
There are many different views of the 3D world in TRS2006 as well as a Map
View that gives you a 2D top down view. You can zoom in or out, pan around
and change the camera focus point with each of these views.

Shown here is the Camera HUD Panel. The different camera view icons and
their shortcut keys are listed as follows. Try to explore the Trainz world with
them.

9.3.1 Cab View
Firstly, make sure the view is focused on a locomotive (Click LMB
on a loco to focus the view) then Click LMB on the Cab View button
(or use the "1" key). Your view is now from in the driver’s seat of the

cab. Use RMB+H to look around the cab and out of the different windows. You
can also change your viewpoint in the cab by pressing the "[" and "]" keys. If
the locomotive is a dual cab unit you can press the "Alt+C" key to switch
between the cabs.

9.3.2 External View
When you first start Driver you will generally be in the External View
with the scene focused on a particular locomotive. Use RMB+H and
move the mouse around to rotate and elevate the view (you can

also use the cursor keys), with the locomotive at the center of the screen at all
times. Want to get closer? You can use your mouse wheel to zoom in and out,
or use the Page Up/Page Down keys on your keyboard.

If you Click LMB on one of the cars attached to the train, the view changes so
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such as turnouts, industries and stations. Zoom in and out using the "Page Up"
or "Page Down" keys (or your mouse-wheel) to see more or less of the route.

The map follows the movement of the currently selected Consist. The currently
selected Consist shows as green and all other Consists show as gray on the
map. Click LMB on one of the gray Consists to center the map view on that
Consist.

Click RMB on a point in the map to center the map view to a new location,
losing focus on any particular Consist.

You can also set the turnouts by clicking on them and seeing the direction
arrows change. Also visible are the state of any signals on the Route.

Exit the map screen by Clicking LMB again on the Map Screen button, or
press Ctrl-M.

9.4 Driver Commands – Who Goes Where
Open the "FreeformiPortal" session on the "Tidewater North" route. Click LMB
on the Driver picture in the lower left of the screen and a list of allocated
Drivers appear along the left side of the screen. Click LMB on the Driver "Ami"
who should be at the bottom of the list. The camera focuses on the loco of the
selected Driver.

We will get this driver to pick up the logs from the Logging Co. and take it to
the Lumber Mill.

Click RMB on the driver's picture to bring up the Driver Command menu.
Select Drive To > RichWood Logging Co. > Log pickup from the
subsequent pop out menus. Note that an icon representing the logging yard
appears at the bottom of the screen next to the driver picture. The Driver will
immediately begin to carry out his duties, and you can queue up additional
orders whilst he is driving.

Click RMB on the driver’s picture and select Load from the Driver Command
menu. The Load icon appears to the right of the logging yard icon. Continue
on with the sequence and selecting Drive To > Lumber Mill 1 > Logs Drop
off and then the Unload command.

You should now have a group of four “Command” icons across the bottom of
the screen that represent the commands you have given to this Driver.

Your Driver will continue with his duties in the order that they appear along the
bottom of the screen, taking into account speed restrictions and other rail
traffic. Each time a task is completed, the Command icon disappears and the
Driver commences his next task.

Not only can you issue orders to several Drivers at once (up to 7), you can also
give Drivers orders to accomplish tasks based on the Waybill list of industry
requirements at the same time. Once your orders are allocated, watch as your
railroad comes to life around you.
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9.6 Driving in Diesel/Electric Cab Mode – Are you ready?
Cab Mode provides a more realistic driving experience taking into account
factors such as the different power levels at each throttle notch, or the length
of the train when applying the brakes. Each of the levers, switches and dials
in the 3D cab can be used to operate the locos or you can use the Hotkeys or
Cab Control HUD to carry out the same function. (This lets you control the
locos from outside, even in Cab Mode).

The following tips will get you started, but we recommend that you check out
Chapter 12 - Engineer’s Guide of this manual more detailed information about
driving using Cab controls.

Launch Driver and select "Tutorial 3 - Diesel Cab" from the expanded list of
the "City and Country USA 2" route. Click LMB on the "Load" button at the
bottom right of the screen to launch the Driver Session. Follow through the
tutorial’s instructions to learn how to drive a locomotive in cab mode.

To start a locomotive in cabin mode, release the train brakes ("Q"). If the brake
cylinder has not emptied you may need to also release the independent brake
("D"). Put the reverser into forward pressing "F". Increase the throttle ("W")
slowly and the train will begin to move forward. Use "X" to decrease the throttle
and "S" to set the throttle to idle. Use "A" to apply the brakes, and "Z" to lap
the brakes. Watch the information in the Cabin HUD Panel to get information
on speed, throttle, brake settings and Reverser direction.
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When you need to exit, move the mouse to the top left of the screen, a menu
scrolls down and you Click LMB on the Exit button (X) or hit the Esc key. A
pop-up window asks if you want to save this session – very handy if the real
world interrupts your Railroad Operations.

9.5 Drive that Train – You Take Control
There are times when you will want to get into the cab of your very own
locomotive and take charge. When any one of your Drivers has no current
commands, the Driver HUD appears on the right hand side of the screen. If
you are in DCC mode, you will see a speed dial. This is a simplified control
system not unlike the DCC (Digital Command Control) systems used on model
railroads. Using the dial you can control the speed of your loco and get a feel
for driving without having to worry about monitoring brake pressures or
knowing which lever to pull and when.

Click LMB+H on the speed dial and drag to change speed. Click LMB on the
Stop icon to stop the train. There are momentum effects built into this control
system, so don’t expect the train to stop and start immediately. Alternatively
use the "W" and "X" keys to accelerate and decelerate respectively. Use the
"S" key to get to idle state and the "A" key to apply the handbrake.

The current speed and the track speed limits are shown at the top right of the
screen in the Time and Display HUD Panel. Make sure you obey all signals
and speed restrictions along the way.
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gauges; they should show be half to two-thirds in the glass. Water level in the
boiler is increased by use of the injectors.

Once full pressure has been attained and the brakes released ("Q" and "D"),
you can move the locomotive by opening the regulator. The "cutoff" is the
percentage of the piston's travel that steam is applied to it and is affected by
use of the reversing gear. Full stroke length is 75% and is used for starting the
train. As the train begins to gather momentum, the cutoff is reduced and the
expansive qualities of steam are used to generate power without depleting
boiler pressure so rapidly. As the cutoff is reduced, there is increased potential
maximum speed and reduced cylinder power output.

Long cutoff (40-75%) delivers higher tractive effort and increased coal/water
consumption. Short cutoff results in lesser tractive effort, but more efficient fuel
consumption. Operating at high speeds in full forward gear will soon deplete
the boiler. A parallel can be drawn with an automobile, where fifth gear is great
on fuel, but not so efficient when you come to a hill. The cutoff is a very
important tool in managing the available steam.

When nominal boiler pressure is exceeded, Safety Valves lift to vent excess
pressure to the atmosphere. A good crew will avoid this waste of steam and
fuel by striking a good balance between the temperature of the fire, the
pressure in the boiler, and the conditions of the road ahead. When
approaching a heavy ascent for example, a hot fire will be required to maintain
adequate steam pressure. Conversely when approaching an easy section with
a very hot fire, pressure can be eased to prevent lifting safety valves by adding
more water to the boiler.

Observe the water level in the locomotives tender periodically, especially after
working the locomotive hard, as it may require a visit to a steam filling station
several times en route.

See Chapter 12 - Engineer’s Guide of this manual for more detailed
information about driving a locomotive in cabin mode.
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Note: You cannot engage the Reverser unless the throttle is at idle.

See Chapter 12 - Engineer’s Guide of this manual for more detailed
information about driving a locomotive in cabin mode.

9.7 Driving a Steam Engine – Are you up to the challenge?
Entering the cab of a steam locomotive for the first time during a new session,
you will find that the light-up crew will have prepared you a nice hot fire. Fire
temperature can be gauged by looking at the color; an orange fire is relatively
cool, and a white-hot fire is required to raise the necessary pressure to power
the locomotive. You should have a nice head of steam already raised and you
can check the gauge pressure either in the cab or on the Cabin HUD Panel
(pictured below).

Launch Driver and select "Tutorial 4 - Steam" from the expanded list of the
"Outback Australia 1" route. Click LMB on the "Load" button at the bottom right
of the screen to launch the Driver Session. Follow through the tutorial’s
instructions to learn the basics of a driving a steam locomotive in cabin mode.

Opening the firebox doors to increase the airflow and add more coal to the fire
by pressing the spacebar. The doors MUST be open to shovel coal. Care
should be taken not to add excessive coal, as this will lower the temperature
of the fire for a time. As the fire heats up, the boiler pressure should start to
rise. Always ensure there is sufficient water in the boiler by checking the water
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2. A part of a train may be occupying a part of the block it protects,
the signal shows red preventing any further traffic from entering
the block; or

3. A part of a train may be occupying a part of the adjacent block 
when the signal will display Caution to indicate that the next
signal is at stop.

When a train encounters a green light, it is permissible to pass the signal at
normal speed. The signal will stay green until the rear of the train enters the
block, at which time it will change to red. Once the train leaves the block, i.e.
passes the next signal, the first signal will turn yellow, meaning it is safe to
proceed as far as the next signal which is now at stop.

When a light is at Yellow, the Driver must proceed at half speed and of course
you must always stop at a Red signal unless the Controller allows you to pass.

During Driver sessions, any of the circumstances that result in a red or yellow
signal can be revealed. Move the mouse pointer over the signal lamp, and a
message will display the status of the block. Clicking on the signal lamp will
transport you to the obstacle whether it is a turnout that needs switching, a
terminating line or another train. Alternatively, your path can be cleared using
the 2D Map Screen overview.

Tip: If your AI Drivers seem to be misbehaving, you may have placed
your signals incorrectly. Read the Signaling Guide for more
information on how to place signals correctly.

9.10 Industry Information
Behind each interactive industry in TRS2006 is a complete resource model
where industries consume resources and produce goods. Click Ctrl+RMB on
an interactive industry and a pop up menu will appear. You can Click LMB on
View Details to open up a pop up window that describes the industry and the
current Commodity levels.
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9.8 Operating Turnouts
You change the direction of the Turnout (Junction/Switch) by Clicking LMB on
arrows associated with the Switch. The green arrow points in the direction the
Turnout is set to. If you are in the Cab, hold the Ctrl key when you Click LMB
or use the J key to change the junction ahead (Ctrl-J if you are reversing).

You can also change turnouts in the 2D Map View, which is useful for planning
your train’s movements well in advance of its progress.

Tip: Click between the arrows to change their direction.

9.9 Signals
TRS2006 primarily uses a basic block signal approach but there is a large
amount of flexibility built in to allow customized signaling systems that
reproduce many of the different types of signaling found around the world.

The most typical light signal states are shown below. For a more complete
discussion of signaling (including semaphores) see the Signaling Guide.
Indications are as follows:

Green - Line Clear
The next signal is either green or yellow, proceed at normal speed.

Yellow - Caution
The next signal is red, proceed at low (half) speed.

Red - Stop
The block is occupied, terminates, or is closed.

All of the signals are red unless a train is approaching one, in which case it will
turn green to allow passage of the train. There are several reasons why a
signal may not be showing green in the presence of a train:

1. The line may terminate or be closed, meaning a turnout within
the block it protects is set against it;
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9.11 Waybills – Who Needs What
Click LMB on the Waybill icon to bring up a list of industries that have
created waybills showing that they require certain products for
delivery. Click LMB on each industry icon in the list to show what

quantities of products are required.

Waybills are automatically produced by an industry when that industry reaches
a percentage of capacity of a particular commodity. Once the full amount
required by the Waybill has been delivered, the Waybill is deleted from your
list (although another one may well have appeared in its place).

The tutorial sessions "Tutorial 2 - Waybills" (British Midlands route) and
"Tutorial 5 - Drivers" (Highland Valley Industries route) introduce you to how
Waybills can be used to keep you informed.

9.12 Commodities
You can allocate which commodities are carried by a particular item
of rolling stock. Click on the Commodities icon on the lower right of
the screen to bring up the Commodities Menu. Click on an

appropriate icon and then click on an item of rolling stock. The icon shows that
the rolling stock is now limited to carrying only that type of Commodity. To stop
any commodity being loaded or unloaded, use the "Stop" icon. To allow the
default load only, use the "Default" icon. You can only assign commodities to
vehicles built for carrying that type of commodity.

Play through "Tutorial 6 - Commodities" on the "City and Country USA" route
for an introduction to working with commodities.

9.13 Decoupling
To activate decouple mode, click on the Decouple icon (or press the
"Ctrl-D" key), then move your cursor over the couplers between train
cars until you see a red decouple icon. When the red decouple icon

appears, click LMB to decouple the consist at this point. When you have
successfully performed the decouple operation, the red coupler icon “opens”
and a message is displayed on the screen. The act of decoupling creates a
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See the section 10.4.4 of this manual for more detailed information on how to
configure commodity levels in an industry.

Close the window by Clicking LMB on the "X" in the top left corner.
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Imperial/Metric (G)
Toggles the settings from Imperial to Metric or vice versa. This will affect
parts of Trainz that involve the display of measurement/speed

information such as the Time & Speed HUD Panel.

Find (Ctrl-F)
Lets you locate a particular item such as a junction, station, loco or
interactive industry. Selecting the item will move the camera position to

that position on the route. See section 11.13.4 for further details of the Find
functionality.

On Screen Help (Ctrl-H)
Toggles the display of on screen icons such as turnout direction
markers.

More details of what these icons do can be found in section 12.6 of this
manual.

9.15 Mastering Operations
The tutorials mentioned in section 9.2.1 show you how simple it is to get
started in Driver mode to operate the railroads that come with TRS2006 or
those built by yourself or others. For an expanded explanation of the
capabilities of Driver Mode, see Chapter 12 - Engineer’s Guide of this manual.
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new consist and your camera remains focused on the same car or loco as
before the decoupling operation. To re-couple, ensure that you are operating
at speeds below 5mph (8kph). Experiment with different camera positions to
make this task easier.

Tip: In DCC mode you must apply the handbrake ("A") before
uncoupling to avoid runaway wagons.

9.14 Other Functions
At the top left, there is a group of icons that let you carry out other general
functions.

Exit (Esc)
Quit the current session back to the Driver Main Menu or Surveyor
screen with the option to save the session before exiting.

Pause (P)
Suspend the current session so that you can answer that important
phone call or finally stop for a lunch or dinner break.

Save (Ctrl-S)
Lets you Save your progress including where each train is located and
the state of each industry. To reload a Saved Session, choose the

"Saved Session" option from the Driver Main Menu screen.

Performance Settings (Ctrl-T)
This is where you can tweak the graphics slider settings to improve the
visual quality of your game. See section 7.3 for more details of what

these settings do.



10 - Surveyor

10.1 Introduction
Welcome to Surveyor, the user-friendly World/Route/Layout builder. Surveyor
is a tool where you can jump in straight away and have some fun, but also may
take some time and patience to master.

Using Surveyor and your imagination you can create terrain, paint it with
textures and then populate it with trees, shrubs, buildings, roads, power lines,
animals and people. You can create lakes and rivers, change the weather
conditions and even change the color of the sunset.

There is the ability to create your railroad, with track, stations, signals,
maintenance facilities, turntables and the plethora of trackside infrastructure
that combine together to form a working railroad. You can edit the default
Routes or start out from scratch making your own creation. You can also
download a huge number of Routes created by others from the Trainz
Download Station and modify them to suit your tastes.

In Surveyor you also place the locomotives, rolling stock and drivers that are
the "actors" on the stage you create for each of your Driving Sessions.
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10.2 What’s new in Surveyor Mode in TRS2006?
If you are familiar with earlier versions of the Trainz product, we thought we'd
give you a quick list of significant differences in the Surveyor module between
TRS2006 and the earlier versions:

• Backdrop scenery items
• Animated turnouts
• More than 50 rules
• Custom content search filter

10.3 Flexibility and Framerates
Welcome to the Surveyor world builder tool. Surveyor is a tool that needs
some experimentation. It is free-form, open-ended software at its best and our
users will probably find ways to utilize it beyond anything we originally
envisioned.

With this freedom also comes a dilemma. The Surveyor tool has no
constraints on the amount and variety of objects that can be placed in your 3D
world. Therein lies the issue, the more types of objects, the slower will be the
performance of the Driver component of the software. You can minimize these
frame rate effects by keeping the variety and number of objects minimal. Their
effect on frame rate is in that order, first variety and then quantity. Keep this in
mind when putting your world together and you will have a more pleasant
driving experience.

With Surveyor you can create terrain, populate it with trees, shrubs, buildings,
roads, vehicles, aircraft, ships, power lines, animals and people. Then of
course there is the ability to create your railroad, with track, stations, signals,
maintenance facilities, turntables and the plethora of trackside infrastructure
that combine together to form a working railroad.

Let's not forget the new working industries that give your railroad purpose and
the locomotives and rolling stock that are the actors on the stage you create.

We will start with a step-by-step guide to creating a very basic operational
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d

The details of this screen will be discussed later in this document.

For the purpose of this tutorial, Click LMB on Create New. We are going to
create our route from scratch. A new window will pop up as follows, asking you
for some map details.
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route. This will demonstrate the main aspects of Surveyor. The sections that
follow that provide a detailed description of each of the tools available to you
within Surveyor.

Surveyor is a powerful editor that lets you create your own worlds, landscapes
and railroads. Create hills, mountains, valleys and streams, populate the world
with all types of scenery objects, and of course lay your track, signals,
turnouts, consists and even program the operation of the Route.

You can edit the default Routes or those created by others. Or you can start
out from scratch making your own creation. You can also download a huge
number of Routes created by others just like yourself from the TRS2006
Download Station and modify them to suit your tastes.

The following tutorial provides you with just the basics to help you get started
in making your first TRS2006 route.

10.4 My First Railroad
In this section we will be building a single baseboard map with a hill in the
center and a simple oval of track connecting a power station to its source of
fuel, a coal mine. If you feel you are ready you may wish to skip this section
and move to the more detailed instructions beginning with Chapter 11 -
Surveyor in Depth.

Begin by selecting the Surveyor option on the TRS2006 Main Menu. The
following screen appears.
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screen is re-centered on the compass.

Next, Click RMB+H and move your mouse slowly towards the edge of the
screen. You will notice the compass following the cursor as you move around
the terrain. Learn to control the speed of movement by moving the compass
close to or away from the center of the screen. Keep practicing these
movements until you can successfully control the direction and speed you
wish to move.

Use the arrow keys on your keyboard to rotate the camera around the
compass. The left and right arrows rotate the camera. The up and down
arrows change the elevation of the camera. Press the Page Up and Page
Down keys to zoom in and out or you can use the mouse-wheel on your
mouse if you have one.

When you zoom in close, notice how the compass has the four directions N,
S, E and W. This is helpful to stay orientated in your TRS2006 world,
positioning your railroad properly with respect to the rising and setting sun. Yes
on a clear day, the sun does rise and set in your TRS2006 World!!!

Tip: Spend some time using a combination of the mouse and
keyboard commands that control the viewing pane in Surveyor. This is
an important skill to develop and some time invested now will reward
you with effortless flitting around the map as you construct your
railroad empire.

Tip: The Undo/Redo buttons are found on the top menu panel. Use
them if you want to retrace your steps backwards and forwards
respectively.
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For now click in the "Route Name:" field and type "My First Layout" and leave
the rest of the fields as they are. Click LMB on the tick (checkmark) to be taken
to the Surveyor editor.

The next thing you notice is the baseboard marked out with a grid and with a
3D compass in the center of the screen.

This compass is always centered on your screen. If you get close enough to
the compass, you will see that the compass is marked with the East, West,
North and South compass directions to assist you in aligning your route
geographically.

10.4.1 Compass Movement and Camera Skills
The first task to learn in Surveyor is how to move around the baseboard and
control your camera. Mastering these two basic skills will make your time in
Surveyor much more enjoyable.

In the middle of the baseboard is your Surveyor Compass. There is also a
small white arrow on the screen. The arrow is your default cursor, which you
can control by moving your mouse. Move your cursor to the right of the
Compass and Click RMB. The compass will move to that position and the
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10.4.3 Ground Texturing
When you are happy with your hill Click LMB on the Painting Tab from the tabs
at the right of the screen (it's the second one down).

The Topology menu disappears to be replaced by the painting menu. Scroll
down the texture palette until you find a texture you like. Again select the
radius of the texture effect by Click LMB+H on the Radius dial and moving it
until you are happy with the size of the painting circle. Then Click LMB to apply
the texture to the terrain.

Select a couple of different textures and play with blending them (overlapping),
rotating them using the Direction tool or the "[" or "]" keys. Select a Texture with
a directional pattern in it. Click LMB+H on a spot on your route and then press
the "[" or "]" keys repeatedly to see how this works.

Change the size of the pattern (the scale of the texture) by using the Scale
tool. Change the size of the area covered (the white circle) using the Radius
tool or the "+" or "-" keys.

You can get some very artistic and realistic effects. Keep playing until you are
happy with the result.
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10.4.2 Make a Mountain
Okay let's start by clicking on the Topology Tab. It's the Tab at the top of a Tab
Panel on the far right of the screen. Out from the right of the screen flies a
menu panel.

For now select the Height Up tool (each tool has a label which pops up when
you move the cursor over the tool) with a Click LMB. Then Click LMB+H on
the Radius tool and drag it around until its dial is in the 12 o'clock position. Do
the same with the Sensitivity dial. When you move the mouse cursor back onto
the Surveyor map it has changed to a dotted circle.

Place the circle around the center of your square baseboard and Click
LMB+H. the longer you hold the LMB the higher and bigger the hill becomes.
Move the mouse around while LMB+H and you can create various peaks and
ridges as shown above. Don't go overboard here as you'll want to leave some
room for trackwork…not that mountain ranges have ever stopped a track
laying engineer.
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10.4.5 Give me Power
Next we'll set up a coal-fired power station. As we did for the Coal Mine, select
the Power Station. It is in the same list as you found the Coal Mine. Place it
on the other side of the baseboard (and the mountain). Move and rotate the
power station as required to line up the tracks as shown below. Set its
properties which in this case is only to name it to "Kinetic Power Co".
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Now make sure that you are back to having only the mountain, nicely textured
in the center of the route. Use the Undo function to undo any extra texturing
that you may have been playing with.

10.4.4 Coal for Industry
Now let's place a couple of linked industries. First select the Object tab from
the tab panel and select the Coal Mine object.

You will find this under Object Type "Industrial". Make sure you are in the Add
Object mode by Click LMB on the Add Object button. Then move the view to
one side of your board and Click LMB on the map to place the Coal Mine. You
can move and rotate the object by Click LMB on the Move and Rotate buttons
respectively. To do this, Click LMB+H on the mine in the view window and then
move the mouse accordingly. Position the Coal Mine as shown below.

Next set the coal mine's properties by first Clicking LMB on the Edit Properties
button (highlighted in bright green in the screen above) and then Click LMB on
the Coal Mine. First let's give it a name. Type in "Lignite Coal Co" in the name
box. We will set the rate of coal production to 200. Do this by Clicking LMB on
the underlined default production rate and entering 200 in the pop up window.
Similarly we will change the diesel consumption to a value of 0. Set the Start
Amount for each to 0. Click LMB on the tick and we have defined our active
Coal Mine.
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Attach one end of the track to one of the coal mine loading tracks (there are
four) and the other end to the power station track by Clicking LMB one new
end point onto the track as shown in the screen shot above. Do the same on
the other side so you have a continuous loop. You can also smooth out your
track laying efforts by Click LMB the Move mode button in the track menu and
then Click LMB+H on any of the track spline points in the view window. Move
the mouse to move the spline points and watch as the track follows. Play with
this until you are happy with your loop of track.

Just for fun, let’s add a siding. Click LMB on the Add Track Button and click on
your existing loop of track. A new spline point appears and you can now Click
LMB again, away from the loop and create a siding.

10.4.7 Locomotives, Rolling Stock and Trains
We will now place a train of a locomotive and rolling stock on the track. Select
the Trains Tab from the Tab Panel. Then scroll down and select a locomotive
from the list of available items. Let's choose a ATSF F7A unit. Once it is
selected, Click LMB on any spot on the track you laid in the view screen to
place the locomotive. The locomotive will appear on the track with arrows
above it defining the ends of the consist and which direction will be forward
when you drive it.
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10.4.6 Lay your Tracks
Now we will link up these two industries via a simple oval loop. The goal is to
link up the Coal Mine's loading track to the oval and run it around to the Power
Station's coal unloading track. Go to the tab panel and select the Track tab.

Choose the type of single track you want to use.
Make sure you are in the Add Track mode (the large
green button above is lit when you are in that mode).
Start laying track by Click LMB on the board where
you want to start the track. You will notice a white
circle associated with the track wherever you Click
LMB on the board. These are called Spline Control
Points. We will manipulate these points later to
move the track either horizontally or vertically.
These Spline Control Points are also attachment
points for bridges, tunnels and other spline enabled
objects.

The track is drawn between consecutive spline points. Click LMB on the map
to add another spline point and the track smoothes itself out between the two
points, a very useful feature. However, there are limits!
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in green below at the bottom of the tab). Then Click LMB on the locomotive in
the view panel. In the pop-up window type, click on the existing name (ATSF
F7A 2 in the screen shot below) and type in "Coal Train" to replace it. Give it
a running number of 10 by clicking on the underlined "running number" text
and typing "10".

10.4.8 Assign a Driver
Our next challenge is to assign a driver to the Consist.

Tip: This is optional as you may wish to drive your own trains in your
route. But using Drivers adds a whole new dimension to TRS2006 so
we will do that next.

Tip: If you save a session without entering any Rules, a default set of
Rules is applied for you.

Move the mouse to the top of the screen to bring down the top menu and Click
LMB on the word "Surveyor" in the menu to pull down the Surveyor menu. We
will explain all of these options later in this document.
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Next, select the green coal car (called "coal hopper") from your list of engines
and rolling stock. Click LMB on the placed locomotive towards the back of the
loco and the coal car will appear behind the locomotive. Keep on Click LMB
on the last car in the consist to add more coal cars. Stop when you have added
5 coal cars. You will now see a consist on the track.

Let's name our consist by first Clicking LMB on the Properties button (lighted
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Click LMB on 2nd rule named "Driver Set Up Rule" such that it is highlighted
in blue. Then Click LMB on the Edit button to open the properties window for
that rule.

Tip: In any of these windows if you decide not to go through with the
change, click on the red "X" to cancel your selections.

The Driver Setup Rule is responsible for assigning driver characters to trains
for the session. It will automatically try to find every loco and have a driver
character assigned to it already. In this case, you will see how a driver
character has been assigned to the ATSF F7A locomotive.

As this is a simple session without the need for complex driver arrangements,
the automatic assignment done by the rule is sufficient, but for the sake of
configuring a rule, click on the driver character icon to bring up a list of drivers. 
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For now, Click LMB on the Edit Session option. A pop-up window named "Edit
Session" appears.

This window is where the rules that define a session’s behavior are added and
configured. As this is a new empty session, three default rules are already
included and configured so some minimal functionality is already available and
the session can be run.
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Ideally, you will have previously learned to use Driver mode either through the
previous chapter of this manual and the tutorial sessions. If not, this is a good
time to do so. Once you have learned how, you can load "My First Layout" into
Driver and experience the thrill of driving on a route that you have built from
scratch!!!

Tip: In TRS2006 you can try out your new route and session simply by
hitting "Ctrl-F2". This will transfer you directly into Driver. When you
leave Driver mode, you will automatically return to Surveyor so that
you can continue to work on your route having tried it out.

Well done! You have created your first Railroad by going through the steps of
building the terrain, texturing it, placing objects, laying track, putting down
consists and assigning drivers. This has been a quick peek into the powerful
capabilities of Surveyor, feel free to experiment within Surveyor and discover
its flexibility.

10.5 Becoming a Master Railroad Empire Builder
The preceding "quick start" tutorial has shown you how simple it is to get going
with Surveyor to build your railway empire. In the following section you will
learn how to further develop your routes and sessions into vast railway
empires.
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Choose any driver from the pop-up list and click on the green check (tick) to
return back to the Driver Setup rule properties window. You will notice that the
driver character icon has changed and that the driver you chose is now
assigned to the locomotive.

Close the Driver Setup rule properties window by clicking LMB on the green
check mark at the bottom right. Then close the Edit Session window with
changes saved by clicking LMB on green check near the bottom right corner.

Sessions and the rules used to define them are looked at in more detail in
sections 11.13.7 and 11.4 of this manual.

10.4.9 Save and Drive
Once again move the mouse to the top menu and Click LMB on the word
Surveyor to pull down the Surveyor menu. Click LMB on the Save option to
save your creation and make it available in the Driver module.

Tip: Save your work in Surveyor regularly to ensure you don't lose
your work should the unforeseen happen. You can also use the Save
As option in the menu to save different versions of your route.
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In the list above the routes and sessions that do not have a "c" beside them
are those that have come prepackaged with the TRS2006 software. They
cannot be deleted or removed nor can they be changed and replaced. But you
can load them up and then change them and save them with a new name if
you wish.

The route and sessions with "c" beside them are ones that you have created
or that have been created by others and which you have downloaded from the
Internet. These may be changed by you and replaced or saved with a new
name. In the above example, there is one route (Ontario Northland Railway)
which is created by others and it has two session stored with it - the
Capuskasing Freight and the Polar Bear Express session.

If you wish to work with a route or session in this list, Click LMB on that route
and then Click LMB to load it into Surveyor.

Tip: Changing objects that are part of the "world" such as ground,
buildings, track, signals etc means that you're are changing the Route.
Altering the dynamic components such as locos, rolling stock, industry
parameters and Rules, means that you are changing the Session that
belongs to the Route.
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11 - Surveyor In Depth

11.1 The Surveyor Main Menu in Detail
Let's go back to the Main Surveyor screen as shown below and explore it. At
the left in the description field will be a description of the route if the author of
the route has included one.

To create a new route from scratch, Click LMB on the Create New button as
you did in the tutorial we just described above.

On the right of the screen, you will see a list of Routes. For each route, there
may be one or more sessions. If the route does not have a session, that
means the route has been built but:

• No rules have been set to govern operations on that route.
• No consist has been developed and placed on that route.

In order to operate trains on the route (using Driver mode) you need to add at
least one train to that route. You may of course optionally add rules as well.
How to do this will all be described below.
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Please note that on your way back from Driver, you will be asked if you wish
to save your Driver session for reloading in future just as you might do in a
regular driver session.

11.4 The Baseboard and the Surveyor Tabs
Once you have completed the New Route setup, you will see this screen. It in
effect is the "table" up on which you build your route. The baseboard you see
here is 720 meters by 720 meters square and each grid square is 10 meters
by 10 meters in size. If you chose Imperial measures instead of metric the grid
squares still remain that size. As described later, you can use the Extend
function in Surveyor to add more baseboards and the Merge function to merge
routes.

Surveyor Tool Tabs
Down the right hand side of the Surveyor main screen are seven menu tabs
representing all the tools you need to know about to successfully make your
own route and session in Surveyor.

Leave your mouse cursor hovering over the first tab and you will notice a
yellow text box appear saying Topology 'F1'. This message is a ToolTip and
gives you information about the function of that icon. You will also notice the
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11.2 Create a New Route
Here we will assume that you have clicked on Create New from the Surveyor
Main Menu to build a new route and associated sessions from scratch. This is
the first screen that you will see.

How to complete this screen is section 11.13.1 of this manual.

11.3 Testing Your New Route in Driver (CTRL-F2)
Before we explain how you can start to build a new route in Surveyor, let us
alert you to a handy new feature which is very useful during route construction.

In TRS2006 you can now try out your new route and session simply by hitting
"Ctrl-F2" while you are in Surveyor mode. This will transfer you directly into
Driver. When you leave Driver mode, you will automatically return to Surveyor
so that you can continue to work on your route having tried it out. This avoids
your having to save your session and then sign out of Surveyor and then load
your session into Driver.
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11.5 Topology Menu (F1)

11.5.1 Basic Topology Functions
The Topology Menu provides the tools for creating
various types of terrain. In this section you will
learn how to make hills, valleys, mountains, lakes
and rivers.

Tip: You will learn these features faster if you
first start a new route per the instructions
earlier in the tutorial before trying the features
to be described now.

Click on the Topology Tab (or press the F1 key) to open the Topology
Menu. Here you will see a number of different tools that can be used to
shape the terrain. Hold your mouse cursor over each one to see a short
description as well as the appropriate Hotkey to press. To see the whole
menu as in the diagram above, click on the Advanced button to expand
the menu.

Height Up (U)
Click on the Height Up (U) and notice that the Mode changes to
Height Up. Click on Height Down (D) and Adjust Height (A) to see
how each time a tool is selected, the Mode changes.

Click on the Height Up icon once again to select the Height Up tool, and notice
that your mouse cursor changes to a circle. This circle is the "area of
influence" for your cursor when using the land shaping tools.

Click LMB once near the center of your baseboard. Notice that the terrain is
stretched upwards. Next, Click LMB+H, and the terrain continues to rise up as
long as you hold the LMB down. Notice how the hill becomes very steep and
the base of the hill is the approximate size of the cursor circle.

Click LMB on the Radius Tool ("+") to enlarge the circle of influence to its
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"Hotkey" information ('F1') telling you which keystroke you can press as an
alternative to clicking on the icon. Most functions in Surveyor have a ToolTip
and Hotkey associated with them.

If you are in doubt as to what a particular icon will do, simply hold your mouse
over it and the ToolTip will tell you what action that icon performs. Hotkeys in
this document are shown in brackets after the tool description.
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Combined with the zoom function (Page Up, Page Down), spinning the
camera (arrow or cursor keys), and adjustment of the radius and sensitivity
dials, you can now make a wide variety of different hills and valleys. Practice
this until you are comfortable to move on.

Get Height (G)
Select Get Height (G), then Click RMB on the side of a hill. Notice that
the number in the Height Value field changes. You have captured the

height of the spot you clicked on. This is useful when you want to then go to
another spot and set the spot to the same height.

Watch the Height Value field change as you Click RMB on different parts of the
terrain.

Use Height (H)
Click on Use Height (H) Then Click LMB to apply the selected Height
Value to the terrain. The Use Height tool creates a plateau at your

selected height and the radius of your cursor circle determines the amount of
land that is leveled at one time.

Click LMB+H then move your mouse around the terrain to plateau a broader
section.

Plateau (P)
Plateau (P) works in a similar fashion, and simply creates a plateau at
the current height of the compass. Click LMB on the side of a hill to

create a plateau at that level by raising or lowering the terrain.

As an alternative to Get Height to select a Height Value, you can also enter
specific height in the Height Value field. You can enter positive or negative
values. Negative values allow you to depress the terrain.

Add Water (W)
To create a "riverbed", make your circle radius as small as possible.
Next, enter -10 in the Height Value field. Then click on Use Height. Now
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maximum size. Click LMB and hold near the compass icon once more. The hill
this time is a lot wider and flatter. Click LMB on the Radius Tool ("-") to reduce
the size of the circle of influence.

Tip: The "+" and "-" are the keyboard keys between the "0" and
"backspace" keys on your keyboard. They are not the keys on the
number pad at the right of your keyboard.

Zoom Out (Page Down) so that you can see the whole circle. In Surveyor, you
will often need to zoom in and out and use the arrow keys to rotate your
camera to get the best view of what is happening. Whilst holding the LMB,
move the mouse around the terrain and the hill "follows" your cursor. Zoom In
(Page Up) for a closer view.

Next, increase the sensitivity by moving the Sensitivity Dial ("]" and "[") to the
maximum setting and Click LMB. Now the hill grows a lot faster. You may need
to zoom out again (Page Down) to see the whole hill.

As you make hills, you will find you need to Click RMB to move your camera
position and also orient the camera in the direction you wish to face by using
your arrow keys. A little practice makes hill creation a breeze.

Height Down (D)
Height Down works the same as Height Up tool. Firstly move to a flat
area then make an indentation by Clicking LMB where you want the
terrain to be lowered. Again, notice that size of the cursor circle

determines the amount of land that is lowered and the sensitivity determines
how quickly it lowers.

Adjust Height (A)
Adjust Height (A) allows finer control of the up and down movement.
Click LMB and hold then push your mouse away from you to raise
the terrain. Click LMB and hold then pull the mouse towards you to

lower the terrain.
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your mouse forward and back, adjusting the water texture height until it is the
appropriate height. Note how it properly fills the riverbed as you move the
water downward.

Remove Water (Q)
Click LMB on Remove Water (Q) and you then delete the water texture
one panel at a time by Clicking LMB on each water panel.

11.5.2 Advanced Topology Functions (Shift-F1)
The Advanced features menu can be opened and
closed by using Shift-F1 or clicking on the
Advanced Tab.

Extend Section (X)
Navigate to the edge of a baseboard by
Clicking RMB to move the compass. Then

select the Extend Section (X) tool. Click LMB in
the void just off the edge of the baseboard to add
another baseboard in that direction.

Bring up the Surveyor Main Menu by clicking on
the word Surveyor on the top menu which drops
down if you move your cursor to the top of the screen.
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make your riverbed by Click LMB+H, then "painting" the new height along the
terrain creating your riverbed as shown below.

Now Click LMB on Add Water (W) and paint the water texture along the
riverbed by Clicking LMB and moving your mouse around. The radius of the
cursor circle determines the texture panel size. You results will look like that
shown below where we have partially completed the "water painting" job. Paint
enough squares so that they will cover the area of your riverbed.

Adjust Water Height (E)
At first as you see above, the water "floats" above the terrain. Adjust
Water Height (E) works like the Adjust Height tool. Select the Adjust

Water Height tool and Click LMB and hold (on the water texture) then drag
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Fill Area (F)
Scroll through the Displacement Maps (by clicking on the left and right
arrows) until you find one called the Volcano, then click on Fill Area (F).

The terrain is instantly transformed into the shape determined by the
grayscale images of the displacement map chosen. In this case, we have our
volcano.

Note: If you can't Click LMB on this button, it is probably due to your
not having used Select Area (B) to select an area to fill.
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Select Mini Map (Ctrl-M). You will see a mini map showing 2 baseboards.
Zoom in and out by clicking on the "+" and "-" icons.

Tip: The "+" and "-" are the keyboard keys between the "0" and
"backspace" keys on your keyboard. They are not the keys on the
number pad at the right of your keyboard.

Close the mini map by clicking on the Red Light (Ctrl-M) to toggle back to the
full screen view.

Navigate to another edge and add two more baseboards then press Ctrl-M to
view the mini map once more. Navigate around the mini map by Clicking RMB.
Notice the main map also moves. This is very useful for navigating on large
maps. Use Ctrl-M to close the mini map once more.

Delete Section
Click LMB on the Delete Section button. Then Click LMB on any
baseboard section to delete it.

Displacement Maps
The final group of Topology tools relates to using a displacement map. A
displacement map is a grayscale image used to create an instant height map.

Select Area (B)
Click on Select Area (B). Click LMB and drag the mouse to make a large
square as shown below. The size of the square (or it can be a rectangle)

determines the area that will be affected by the next operation.
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11.6 Paint Menu (F2)

11.6.1 Basic Paint Functions
The Paint Menu provides access to a wide
variety of ground textures. Textures in
Surveyor are "bitmaps" which are created
to look like various ground types such as sand,
grass, rocks or gravel. You can even create
your own textures using a simple paint
program or a digital camera. (The resultant
.bmp file must be 128x128 pixels)

Click on the Paint Tab (F2) to open the Paint
Menu. You will see a number of default
textures, grouped by region. Use the slider
button to scroll through the list.

Click the left and right arrows to view textures from the different regions.

Click on one of the textures, and you will see a copy of it appear in the small
current texture window. Click LMB on the terrain and use your mouse as a
paintbrush to paint on the texture.

Scroll through the textures until you find a striped texture. Paint a section of
terrain. You can see that a complex texture pattern makes easy work of
creating stunning ground textures.

Rotate the Direction Dial 90 degrees. Apply the texture again. Notice how the
texture direction has changed.

Hold down the "[" key and apply the texture once more. Notice the direction
dial is spinning and the texture is being applied in various directions. This tool
helps to eliminate repetitive patterns in your textures when you don't want
them.
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Click Undo to remove the volcano.

Repeat the process using the Valley gray scale map to build a valley. Then
move the Direction dial and increase the Threshold dial. Click LMB on Fill Area
once more. This time the valley is bigger and faces a different direction. By
holding Shift whilst selecting your area, larger areas are selected at one time.

Cancel Selection (D)
Click LMB on Cancel Selection (D) to cancel the selection.

Making Your Own Displacement Maps
You can also make your own displacement maps using a simple paint program
(e.g. MS Paint) and then drop them into the \World\Custom\Displacements
folder in your TRS2006 directory to make them accessible.
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11.6.2 Advanced Paint Functions (Shift-F2)
The Advanced Tab (Shift-F2) has a "favorites"
texture palette. Drag and drop textures from
the top palette into the box in the advanced
menu area to build up a set of your favorite
textures for ease of access. Just Click LMB+H
upon a texture and drag it to the box below. To
remove a textures from the favorites box, just
Click LMB+H on the texture and drag it out of
the box and then stop holding the LMB.

Select Area (B)
You can also texture a rectangular area
by clicking on the Select Area (B) and

using the mouse to drag a rectangle of any
size.

Fill Area (F)
Then Click LMB on a texture in the favorites box and use the Fill Area
(F) tool to texture the whole rectangle. If you do not select an area first,

Clicking LMB on Fill Area (F) and Surveyor will fill all areas on which there are
no textures with the selected texture.

Note: If you can't Click LMB on this button, it is probably due to your
not having any textures in the favorites box.

Cancel Selection (D)
Click LMB on Cancel Selection (D) to cancel the selected area.
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Now move the Scale dial to the minimum setting and apply the texture, then
move the scale dial to the maximum setting and notice the difference when
you apply the texture this time. You can avoid repetitive texture patterns and
create ultra-realistic effects by using the scale and direction tools along with
choosing the right textures.

Get Texture (G)
Click on the Get Texture (G) tool then Click LMB on a texture already
painted onto your terrain. Notice the current texture window changes to

show the newly selected texture. This is a useful way to find a texture that you
have already used without scrolling through all the textures to find it again.

The Radius Dial ("+" or "-") changes the area of influence of your cursor circle.
Use the larger radius for quicker painting and the smallest radius for more
accurate and detailed work.

Tip: The "+' and "-" are the keyboard keys between the "0" and
"backspace" keys on your keyboard. They are not the keys on the
number pad at the right of your keyboard.

Fill Grid (L)
The Fill Grid (L) will fill all unpainted areas of an entire baseboard with
one texture. This is useful for finishing off an area where fine texturing

is not required.
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Tip: If there is a green checkmark with the letters "IND" shown in the
lower left corner of the Viewer window, this is an indication that this is
an "interactive" piece of industry capable of participating with
"interactive" rolling stock.

Move Object (M)
Click on the Move Object (M) and Click LMB+H on any object and then
drag the object around the terrain to new positions.

Rotate Object (R)
Now click on the Rotate Object (R) and Click LMB+H and move the
mouse left and right to rotate the objects. Note that a display shows you

the number of degrees of rotation.

You can use the move and rotate tools to create rows of trees or to align
houses next to a road. You can set objects to "randomly rotate" or not by
choosing the Randomly Rotate option in the Surveyor Options menu in the
Surveyor Main Menu.

To find a particular object in the list of objects, click on the Object Selection
text box, and then type the first few letters of the object name. Type in "tree"
and the list automatically positions alphabetically at "tree". Click on the Up and
Down arrows (or use the "+" or "-" keys) to scroll up and down the list.

Tip: The "+" and "-" are the keyboard keys between the "0" and
"backspace" keys on your keyboard. They are not the keys on the
number pad at the right of your keyboard.

Above the Object Viewer Window are the Object Region and Object Type lists.
Scroll through and select either a region or an object type or both in order to
shorten the selection list.
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11.7 Objects Menu (F3)

11.7.1 Object Management Functions
There are a huge number of objects
in TRS2006 that you can place onto
the terrain. There are two different

types of objects - objects and splines. We'll
explain spline objects later. For now we will
concentrate on single objects.

Open the Objects Menu by clicking on the
Objects Tab (F3). The default mode is Add
Objects

Begin by scrolling through the list of objects by
clicking on the left and right arrows of the object
list. The selected object shows as a rotating 3D
object in the viewer window.

Note: You can control what is shown in your list by selecting specific
Object Regions (such as USA) and Object Types (such as Trackside). 

Add Object (A)
Check that you are in Add Object mode, or Click LMB on Add Object (A)
to select this mode. Click LMB on the terrain and the selected object is

placed wherever you click. You can repeat this several times quickly adding a
number of trees or buildings.

Tip: It is easy to click twice and get multiple copies of your object. Just
use Undo to delete the unwanted copies of the objects.
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Delete Object (D)
Select Delete Object (D) then Click LMB to delete an object. Continue
Clicking LMB to delete a number of objects. If you click on the wrong

object, click on Undo (Ctrl-Z) to undo the last action and replace the last
deleted object.

Edit Properties (N)
Click LMB on Edit Properties (N). Then Click LMB on any object in your
route. A menu will then open up allowing you to edit the properties of

the object. For wimple objects, this usually involves naming the object if you
wish.

For more complex operating industries, you are given the opportunity to
change production and consumption rates for resources and other properties
as we experienced in the earlier tutorial with the power plan and the coal plant
objects.

11.7.2 Special Object Types
As well as the regular objects that are static and exist primarily for cosmetic
purposes, there are also a range of interactive and special object types with
unique features. These objects usually have track included that can be linked
to the track on your main route.

Industries
An industry is a scenery item with track that also produces and consumes
products. Train vehicles can load and unload products at an industry allowing
real world railroad activity (i.e. the transportation of goods) to be simulated.
The products produced and consumed by an industry can be viewed and
tweaked by using the Edit Properties button as mentioned above.

Section 10.4.4 of this manual has a simple example showing how to place and
integrate an industry into a route.

Tip: Industries can be easily found in the scenery object list by
selecting the "Industry" category.
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Get Object (G)
Click on the Get Object (G) tool and then Click LMB on an object
already placed on the terrain. Notice that the object selected now

appears in the selection window.

Change the mode to Add Object (A) and Click LMB again on the terrain where
you wish to place another copy of the newly selected object.

Adjust Height (H)
When placed on a route, Objects are placed at ground level at that point
in the route. If the ground is raised the object follows it. But you can

place an object at a relative height to the ground at any point.

Click LMB on Height Adjust (H) to enable the adjustment of the height of any
Object. Note that only objects which have been designed to be height
adjustable will allow you to adjust their height. So if you cannot adjust the
height of an object, the likely reason is that it wasn't designed to do so.

While in the flight of fancy shown below, we have height adjusted a station to
make it defy gravity (only in TRS2006!!!), this function is very useful. For
example, you can place objects on top of each other such as a building on a
platform.
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Tip: Fixed track pieces can be easily found in the scenery object list
by selecting the "Fixed Track" category.

Note: Gradients are not really supported with fixed track. It is
advisable to use fixed track for flat areas only.

Animated Junctions
New to TRS2006 are animated junctions. These junctions differ from normal
junctions in that they are pre-defined fixed track pieces and have animated
components. As an animated junction is a pre-defined fixed track piece, extra
detail like guide rails can also be present in an animated junction.

Animated junctions are added and manipulated on the Surveyor baseboard in
the same way fixed track pieces are.

Note: You will find the animated junctions in the "Fixed Track"
category. The names of all animated junctions included with TS2006
are prefixed with "Turnout".
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Note: To be of any use, an industry’s track must be connected up to
your railroad and to load/unload, the vehicles used must be capable of
carrying that particular product.

Fixed Track
Fixed track scenery items are fixed, non-flexible segments of track and can be
thought of as the Trainz equivalent to the sectional track model train
manufacturers have.

A piece of fixed track can be placed like any ordinary scenery object and then
connected to normal track splines. It is also possible for fixed track pieces to
snap together when one piece is moved in close proximity to an end point of
another.

The end points of a fixed track are identified by the red arrow seen hovering
above the track.

When rotating a piece of fixed track, other pieces of fixed track attached to it
will also be rotated resulting in the track pattern being maintained during
rotation. The same also applies for moving connected pieces of fixed track.
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Crossings support animated gates that are automatically activated as a train
enters and leaves a proximity region surrounding the crossing. 

The operation of crossings is automated and even the Carz will stop when the
gates are lowered for a train to pass through.

Tip: The names of all crossings included with TS2006 are prefixed
with "Tside Crossing". There is no crossing object category.

Backdrops
Backdrops are a new object type introduced with TRS2006 that are rendered
regardless of the view distance settings. This means they will always be visible
and won’t disappear like other distant scenery items, thus making them
suitable for scenic backdrops.

Tip: The names of all backdrops included with TS2006 are prefixed
with "Backdrop". There is no backdrop object category.
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Turntables
Turntables are scenery objects with multiple incoming pieces of track where a
special traverser track segment (usually rotating) can move around to offer
access to all track pieces. Simply placing a turntable object on the baseboard
and connecting the tracks is all that is required to have it functioning.

Tip: The names of all turntables included with TS2006 are prefixed
with "Tside Turntable". There is no turntable object category.

Crossings
A crossing is a scenery object that allows rail track and a road to cross each
other. As well as being a scenery object that can be connected to the route’s
track, a crossing can also be linked up to road splines (see section 17.7.3 for
details on road splines), as the screenshot below shows.
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Move Spline (M)
You can move any spline point by selecting the Move Spline (M) tool
and then Click LMB+H and dragging the spline point to a new position.

Sometimes when you place a spline point, the spline "snaps" to a nearby
spline point and creates a curved spline. To avoid this happening, hold the
Shift key down when placing the spline points. This "forces" the spline point to
go where ever you tell it to go.

You can also use Shift-Click LMB to a spline to be placed on top of another.
This is useful to create a right angle turnout such as a fence.

Get Spline (G)
Click LMB on the Get Spline (G) tool and then Click LMB on a spline
object already placed on the terrain. Notice that the spline object

selected now appears in the selection window. This is a quick way of finding
the spline you want in case you wish to place additional ones into your route.

Change the mode to Add Spline (A) and Click LMB again on the terrain where
you wish to place the newly selected spline object.
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11.7.3 Spline Management Functions
The next mode to explore is Spline Mode.
Splines are generally long thin objects such as
roads, power lines, fences and rows of trees.
They consist of two or more "spline points"
denoted by white circles. These spline points
can be placed any distance apart and the
spline object is then "stretched" between
the spline points as you place them on the
route.

Spline Mode (S)
To enter Object Spline mode, Click
LMB on the large Spline Mode (S)
button at the top left of the tab menu.

Add Spline (A)
When you Click LMB on Spline Mode
(S), the default selection will be Add

Spline (A).

Click LMB on the terrain to anchor the first spline point, and Click LMB again
some distance away to place the second spline point. You will see white circles
at each end of the spline. These spline points determine the points of a spline
that may be selected or moved. For example, in the picture below, we have
paced the "Powerline B" spline on the route.

To extend the spline further, Click LMB again on the last spline point, then
Click LMB once more nearby to extend the spline.

You can simplify this process by holding down the Ctrl key then placing several
spline points. Release the Ctrl Key and place your final spline point to anchor
the spline in place.



89

11.7.4 Advanced Spline Management Functions (Shift F3)
Click LMB on the Advanced Menu (Shift F3) to
access even more tools. A drop down menu is
then revealed as shown at the bottom of the
tool tab above. This provides you with the
following tools.

Spline Height (H)
The Spline Height (H) tool can be used to raise or lower the height of
certain types of splines (for example catenaries or road bridges). Click

LMB on Spline Height then Click LMB+H on a spline point (the white circle)
and drag the mouse forward or backwards.

Delete Spline Point (X)
Click LMB on Delete Spline Point (X) and then Click LMB on a white
spline circle to remove unwanted spline points. You cannot delete an

end spline point, but you can delete the whole section using the Delete Spline
(D) tool.

Insert Spline Point (I)
Click LMB on Insert Spline Point (I) then Click LMB between two
existing spline points. Notice that a new spline point is created. You may

need to zoom in closer in order to insert a new spline point.

Note: Don't overuse spline points as each one will add load onto your
graphics card and may noticeably degrade performance.

Smooth Spline (S)
Lay a road spline down on level ground on your route using at least four
spline points. Use Spline Height (H) to pull up two spline points in the

middle of the road. The road now floats above the ground.

Click LMB on Smooth Spline (S). Now Click LMB on the raised spline section
and the spline is instantly raised up to meet the road. To make a few minor
adjustments, click LMB again on the road a few more times. Sometimes it
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Delete Spline (D)
Click LMB on Delete Spline (O) then click on a section of spline
between two adjacent white circles to remove unwanted spline

sections. If you delete a section that is not an end section of a spline, the
spline will be split into two splines.

Split Spline (Q)
If a spline is already curved, you can split it into two sections by using
the Split Spline (Q) tool. Simply Click LMB on the middle spline (or any

non-end spline point) and you now have two separate splines.

Toggle Traffic
Many of the roads (which are splines) that you will be placing on
your route will have vehicles (affectionately known as "Carz")

traveling on them automatically. You will see them moving in Surveyor after
placing the roads. Clicking LMB on Toggle Traffic turns all traffic off on these
types of roads. Clicking LMB on the button again will have traffic resume. If the
Toggle Traffic mode is ON, the button will be lit up in a bright green color.
Please note that when you toggle traffic on and off, it affect all spline roads on
your route.

Roads are placed as splines as shown below.



91

Tip: Place a rail crossing as you would do a normal object and then
connect track segments to the track spline points. Next, connect road
splines to the road spline points. If you have laid the crossing correctly,
when you load the map into Driver, road traffic will stop and allow your
trains to run through the crossing.

Tip: To get your catenaries to match your track in an electric route, it
is generally best to place the spline points directly on top of the track
spline points. This ensures that the curvature matches that of the track
and makes it easier to match the height of the track also. Whilst laying
your catenaries, press Alt-O to show the track spline points then hold
the shift key to allow placement of the catenary spline on top of the
track spline.

Get Vertex Height
Click LMB on the Get Vertex Height and Click LMB on the highest spline
point on your spline. The height is displayed in the Height Value box.

Apply Vertex Height
Click LMB on Apply Vertex Height then Click LMB on another spline
point. The spline point is raised to the same height as you first vertex.

This is useful for ensuring level spline segments.

Remove Gradient
Click LMB on Remove Gradient and then Click LMB on a spline section
to remove the gradient between two spline points.
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takes a few passes to get the road just right.

Find another level untouched area of your baseboard. Next, make and texture
a small hill using the Topology tools.

Lay a single section of road spline over the top of hill with a single pair of spline
points at either end. Note that it clings to the surface of the hill. Now Click LMB
on Smooth Spline (S) and then Click LMB on the road. As shown below, this
will level the terrain between the two spline points, thereby creating a cutting
through the hill to flatten the road.

Smooth Spline (S) levels the track between two spline points, bringing the land
up or down to match the leveled spline.

Tip: Turntables and railroad crossings are actually standard objects
rather than track objects but they both have spline points so that you
can attach spline objects such as roads and track to them.



93

your mouse around the terrain and notice how the track bends. The shape of
the curve is also affected by how close the spline point you are pulling is to the
next spline points.

Straighten Track (B)
Click on Straighten Track (B) and then Click LMB on a bent section of
laid track. Notice that the section of track straightens between the two

spline points and the next track segment is also affected.

Note: Double track cannot be straightened.

Click again on the straightened track and it returns to a curved track. This tool
is especially useful when creating turnouts and yards and tidying up messy
track sections.

Choose a different type of track by clicking on either the Track Region or Track
Type dialogue box and scrolling down the list until you find a bridge. Lay a
short section of bridge on the flat ground just as you did for the single track.

Get Track (G)
Click on Get Track (G) and then Click LMB on your original track. The
bridge showing in the selection window is replaced by the track. Press

"A" to change the mode to Add Track and you are ready to lay another section
of track.

Delete Track (D)
Click on Delete Track (D) then click on the bridge section to delete it.
(Note: any trackside objects you place on a track segment will also be

deleted when the track is deleted).

Split Spline (Q)
Click on the Split Spline tool (Q) and click on a middle spline point
(white circle) in the track. The track breaks in two at that point.
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11.8 Track Menu (F4)

11.8.1 Track Mode Tools
Learning how to lay track, place
signals and create turnouts can be
the key to running a successful

TRS2006 Driver session. Track sections in
TRS2006 are made up of flexible length track
pieces created by placing 2 spline points. We
call this "flexi-track" and it makes laying any
lengths of track extremely simple. Select
the Track Menu (F4) and the default
selection will be Track Mode (T).

Add Track (A)
The Add Track (A) tool should already be
highlighted, so you are ready to lay your

first length of flexi-track. Click on the left or right
arrows of the track selection dialogue to select
the type of track you wish to lay, then Click LMB on the baseboard where
you want to anchor your starting point. (We suggest you start with Single
Track).

Click LMB again a short distance away to place another spline point. A straight
section of track has now been laid between the two spline points.

To extend the track further, Click LMB again on the last spline point (the white
circle), then Click LMB once more nearby to extend the track. Unless all three
spline points are exactly in a straight line, you will notice that the track is now
curved. To connect two sections of track, just drag the end spline point of one
on top of the end spline point of another and they will automatically connect.

Move Track (M)
To bend the track in any direction, select the Move Track (M) tool and
then Click LMB and hold on one of the white spline point circles. Drag
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Use Move Track (M) to grab the new spline point and move it around until you
are happy with the shape of the turnout. You now have a perfectly created wye
turnout

Note that a turnout lever has automatically been added to the Turnout. The
Red and Green arrows indicate which way the turnout will be set when you
begin to operate your new route. To change the turnout’s set direction, either
Click LMB on the turnout in Mini-Map mode or use the "Junction Direction" tool
as discussed in section 11.8.5.

The Switch lever can be deleted using the Trackside Object Delete function.
But you must replace it with another of your choice if the Turnout is to function
properly.

Later we will show you how to change turnout levers and add signals to
complete the job.

Tip: If you are trying to move or delete a piece of track and it won't
move or delete, you will receive an audible beep. This means that the
track is attached to a non-movable item such as an interactive industry
object, rail crossing or perhaps even a loco or item of rolling stock. In
the case of vehicles, they need to be moved at least 2 spline points
away from the section of track you wish to edit.

Animated Junctions
Animated junctions are supported in TRS2006 but cannot be created as track
splines. Instead, you need to place an animated junction object on the
baseboard. See section 11.7.2 for details.
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Creating a Turnout
Depending on which part of the world you live in, there are different names for
where one section of track branches off from another. Sometimes these are
called turnouts, junctions, points or switches. We call them turnouts in this
document.

This section will teach you the basics of creating turnouts.

To create a wye turnout, begin by laying two spline points.

Next, Click LMB to the left of your first section of track and drag the new
section towards the existing track.

Click LMB about half way along the first track and the track bends to the shape
of a turnout. You have just created your first turnout.

To tidy up the turnout and make it look a little better, select the Straighten
Track (B) tool then click on the lead out track to straighten the section leading
into your new turnout.

Add a new spline point to your turnout by going to the Advanced Menu (Shift
F4) and selecting the Insert Spline (I). Click on the left-most track to add the
new point.
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Find a level untouched area of your baseboard. Next, make a small hill using
the Topology tools.

Lay a single section of track over the top of hill with a single pair of spline
points at either end. Note that it clings to the surface of the hill. Now Click LMB
on Smooth Spline Height (S) and then Click LMB on the track. As shown
below, this will level the terrain between the two spline points, thereby creating
a cutting through the hill to flatten the track.

Smooth Spline (S) levels the track between two spline points, bringing the land
up or down to match the leveled track.

Delete Spline Point (X)
Click LMB on the Delete Spline Point (X) and Click LMB on a track
spline point (not a spline end point as they cannot be deleted). Notice

that the spline point is removed and the curvature is also affected.

Insert Spline Point (I)
Click on Insert Spline Point (I) to add a new spline point. Once again the
track curvature is affected. Careful placement of spline points is one of

the secrets to good track laying. But be careful not to put in too many as the
more you have the greater the complexity of the route and the harder your
computer has to work to give you smooth operations.
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11.8.2 Advanced Track Mode Tools (Shift-F4)
In TRS2006, there are two ways you can lay
track. Either lay the track and bring the land up
to meet it, or create the land, then lay your
track over it. We'll show you both ways using
Advanced Track Menu (Shift F4).

Click LMB on the Advanced button to drop
down the Advanced Track Menu.

Adjust Spline Height (H)
Begin by laying a short section of curved track using 4 or 5 spline
points. Click LMB the Adjust Spline Height (H) and Click LMB and hold

on a track spline point. Drag your mouse forward and back to raise and lower
the spline point. Raise the track off the ground, and then bring the camera
down close to the ground to get a better view.

As you can see below, the track spline points will have arrows attached to
them showing you the height of the track above the ground.

Smooth Spline Height (S)
Select the Smooth Spline Height (S). Click on the raised track section
and the ground is instantly raised up to meet the track. To make a few

minor adjustments, click again on the track a few more times between each
pair of spline points. Sometimes it takes a few passes to get the track just
right.
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Track in TRS2006 usually tries to "average" a curve so you can use Straighten
Track to "end" a curve. This stops the track trying to bend back in the other
direction.

Even using Show Curve Radius, creating a nice curve can be a little tricky at
first. Here are some tips. Move your camera vertically above the track and
zoom out. Lay down five spline points in a gentle 90-degree curve. The curve
is probably a little wobbly.

Use Move Track (M) to straighten the ends then use the Straighten Track (B)
to straighten the two end sections. You now have a nice consistent curve
through 90 degrees.

11.8.3 Building Bridges 
Bridges and tunnels work much the same way as for normal track but can be
a little harder to lay due to the type of terrain involved. It is sometimes easier
to make the bridges and tunnels on flat ground then move them into place.

Select the Track Type "Bridges" by clicking on the Track Type arrow keys, then
scroll through the list of bridges until you find the bridge type you are looking
for.

To place the bridge, select the Add Track (A) tool and lay the bridge just like
you did for the track by clicking to place spline points. It is best to lay bridges
between two hills although you can lay the bridge and then remove the terrain
beneath it.

Below we have placed the bridge called "Bridge Truss Spline" on some flat
terrain.
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.Get Gradient (J)
Next, select the Get Gradient (J) and Click LMB on your raised track
section between two track spline points. The gradient between those

points is shown in the Gradient Value box as a percentage slope. The value 2
means 2% or 1 in 50.

Apply Gradient (K)
Enter in a new gradient value in the Gradient Value text box, then Click
LMB on Apply Gradient (K). Click LMB on the track near your first spline

point to raise the track.

Now Click LMB on Undo (Ctrl-Z) and then Click LMB near the 2nd spline point.
Notice that the gradient has now been applied in reverse. The rule is that the
gradient is always applied "away" from the spline point closest to where you
click.

Remove Gradient
Click LMB on remove Gradient and then Click on a track section to
remove the gradient between two track points.

Get Vertex Height
Click LMB on the Get Vertex Height and Click LMB on the highest spline
point on your track. The height is displayed in the Height Value box.

Apply Vertex Height
Click on Apply Vertex Height then Click LMB on another spline point.
The spline point is raised to the same height as you first vertex. This is

useful for ensuring level track segments.

Show Curve Radius
Next, click on Show Curve Radius then move your mouse along a track
segment. The curve radius is shown next to your mouse cursor. The

number is the radius measured in meters so a low number means a tight curve
and a high number means a straighter track.
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To create a bridge that is level, you can use the Get Vertex Height tool. Click
on the spline point at one end of the bridge and you will notice the Height
Value is entered into the Spline Height dialogue box.

Click on the Apply Height tool then click on the other two spline points. This
applies the same height to each of those spline points.

11.8.4 Building Tunnels
Tunnels work in the same way as bridges. Repeat the steps above but firstly
select a tunnel rather than a bridge. For your first tunnel, lay it on a flat section
of ground so that the hills don't interfere with the operation. (You can always
add the hill afterwards). Here is an example of the double track "Tunnel Stone"
placed on flat terrain.
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You can insert a spline point in the middle of the bridge using Insert Spline
Point (I) and then Clicking LMB on the bridge section to insert the new point.

Click on Move Track (M) and Click LMB and drag the middle spline point. This
allows you to bend the bridge. Don't bend it too far or it will "break". Below we
have inserted a spline point into the middle of the bridge and curved it.

When you depress the ground under the bridge, the bridge piers will reveal
themselves as shown below. Note that we have painted the ground and added
water as well.
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11.8.5 Trackside Object Management

Trackside Mode (Y)
The second mode in the Track Menu
is Trackside Mode. Click LMB on
Trackside Mode (Y) to change the

Track Tab menu to the Trackside Mode menu.

Add Object (A)
To add a trackside object Click LMB
on the Add Object (A) button. The

select the object you wish to place from the list.
Click LMB at one or the other side at some
point of the track. Your object will be placed
beside the track and will be "attached" to it. So
if you move the track it will move with it.

Tip: Some of the most important Trackside objects are the AI Direction
Markers. These are used by the Drivers for navigating (pathfinding)
around your route. A Driver under AI control will not enter a track
segment against the direction of the AI Direction Marker. Therefore
these are useful for controlling Northbound or Southbound traffic etc,
but, used incorrectly, they can also provide barriers stopping Drivers
getting to where you want them to go.

Move Object (M)
Click LMB on Move Object (M). Then Click LMB+H on a Trackside
Object on your track. Drag your mouse along the track to move the

object to a different position.

Rotate Object (R)
To change the side of the track for a trackside object, click on the Rotate
tool (R) and Click LMB on the object. It will switch sides of the track and

rotate 180 degrees. The direction that a trackside object faces is controlled by
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Once you have 3 spline points in a tunnel, select Move Track (M) and Click
LMB and drag the middle spline point to create a bend in the tunnel. Notice
that in TRS2006, the tunnel exits "snap" to the terrain at 45-degree
increments. You may need to re-route your track to align it correctly to the
tunnel entrance and exit.

Ensure that you hide the tunnel exit properly by using the terrain Height Adjust
tools and the track Smooth Spline tool to tidy up the entrance.

To join track to bridges or tunnels you should always use single track (even for
a double track, bridge or tunnel). Lay the spline point away from the bridge first
and then move the track towards the end spline. The track will snap to the
bridge object. Use Smooth Spline to tidy up the terrain.
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11.8.6 Signaling Systems
You can place signals on your route by choosing them from the Trackside
menu. They may be moved and rotated in the same fashion as other trackside
structures, and like other objects, they are categorized by Region.

Australian & UK signals appear on the left of the track, USA signals appear on
the right. European signals vary depending on the track.
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the selection of Geographic region for the route.

Get Object (G)
Click on the Get Object (G) tool and then Click LMB on an object
already placed at the trackside. Notice that the object selected now

appears in the selection window.

Change the mode to Add Object (A) and Click LMB again at another point on
the track where you wish to place another copy of the newly selected object.

Delete Object (D)
Select Delete Object (D) then Click LMB to delete a trackside object.
Continue Clicking LMB to delete a number of objects. If you click on the

wrong object, click on Undo (Ctrl-Z) to undo the last action and replace the last
deleted object.

Junction Direction (J)
If you have a turnouts placed on your route, each should have a switch
lever attached to it. The switch lever at a turnout has a green and red

arrow. To change the default direction of travel (for when you drive on this track
in the Driver module), Click LMB on the Junction Direction (J) tool and then
Click LMB once on the green and red arrows. The direction is now changed
(green denoting the default direction of travel).

You can also make 3-way turnouts by simply adding a third track to the
turnout. There are now three direction arrows.

Define Name (N)
Next, select the Define Name (N) tool and click again on the turnout. A
dialogue box opens allowing you to type a name for the turnout in the

box. Click the Check (proceed) icon to save the name and proceed.
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11.8.7 Trackmark and Trigger Management Tools

Trackmark Mode (V)
The third mode in the Track Menu is
Trackmark Mode. Trackmark mode is
used for the management of

Trackmarks and Triggers. These are used to
assist in setting up the rules for a session,
which allows you to design operations for your
route.

Click LMB on the Trackmark Mode (V) to
change the Track Tab menu to the
Trackmark Mode menu.

Trackmarks
Trackmarks mark specific points out on the
track in a route. They are named and then used
in Rule building. For example, they can be
used to guide Drivers to take their trains to
specific points on the route. They are also used to program scenarios such
as those in the tutorials described in the Engineer's Guide.

Add a red Trackmark by Clicking LMB on the center of the track where you
would like a Trackmark to be placed.
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Careful placement of signals will allow you to operate complex operations
involving several moving consists without incident. It is important to consider
that the signals are there to protect the trains from each other, and any
situation where their paths may cross should be protected by a signal.

Extended sections of single line should be relieved by sections of double track
or "crossing loops" that enable trains to either pass or cross each other. At the
entrance to a section of single line there can be two signals protecting the
same block, i.e. one on each track to enable faster trains to pass slower ones.

Keep in mind that once your train passes a signal, any following train will not
be permitted to pass until your train reaches the next signal, so if traffic is
going to be heavy, don't place them too far apart.

To protect AI trains from over running terminating track, a rail end marker or
buffer must be used.

Note: At the time of writing, TRS2006 signals are not capable of
detecting a train crossing a block via a diamond crossing. If you wish
to operate a fully automated system, diamond crossings should not be
used in the path of AI trains. However it is possible through the use of
Trainz script to develop a signaled crossing which does control
intersecting trains properly. It is recommended that you place at least
one signal per track segment (i.e. between each junction).
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Finding a Trackmark
To find the trackmark, use the Find Object (using the Type: Trackside to
shorten the list if you wish) or Ctrl-F and select the trackmark from the list. The
trackmark is located, and the screen is re-centered. This is useful for finding
your way around the map.

Triggers
Similarly, you can also place Triggers, which are used when creating Rules or
TRS2006Scripts. A trigger is point that can trigger an event such as a train
starting off or sounding a horn. The can detect specific train passing a certain
point and will then trigger other rules to be executed when that happens. See
the section on Rules for more information.

Simply Click LMB on trigger instead of trackmark in the selection list and then
use exactly the same commands as for trackmarks to place your triggers as
shown below.
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Add Trackmark (A)
To add a Trackmark, Click LMB on the Add Trackmark (A) button. Click
LMB at a point on the track. A trackmark will be placed on the track and

will be "attached" to it. So if you move the track it will move with it. Note that
the trackmarks will not be visible when you are operating your route.

Move Trackmark (M)
Click LMB on Move Trackmark (M). Then Click LMB+H on a Trackmark
Object on your track. Drag your mouse along the track to move the

object to a different position.

Rotate Trackmark (R)
Select Rotate Trackmark (R) and the default direction of the Trackmark
is reversed.

Get Trackmark (G)
Click on the Get Trackmark (G) tool and then Click LMB on a trackmark
already placed at the track. Notice that a trackmark now appears in the

selection window.

Change the mode to Add Object (A) and Click LMB again at another point on
the track where you wish to place another copy of the trackmark.

Delete Trackmark (D)
Select Delete Trackmark (D) then Click LMB on a trackmark to delete it.

Define Name (N)
To name your trackmarks so that you can find them again later on and
use them in rules, Click LMB on Define Name (N). Then click on the

trackmark and a dialogue box comes up where you can name the trackmark.
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Priority Trackmarks
Priority trackmarks look exactly like regular trackmarks except they are purple
in color. They are used to indicate to the AI driver the priority level of a section
of track. 

All trains and track sections have a priority value in the range of [1 - 3] with the
default value being 2. This priority value does not indicate a numerical scale
of precedence, but rather is used for matching by the AI driver. This means the
driver will try and take the train along track sections that have a priority equal
to that of the train.

The priority trackmark is the mechanism used to give a track section a priority
value. Editing the properties of a train as shown in section 11.11.1 is how the
train priority is adjusted.

The AI driver will automatically take into account priority values so nothing else
further is needed apart from setting up priority values on trains and track as
needed.

Note: The priority system is not an explicit path setting mechanism as
a driver will still go over tracks of differing priorities if it can’t find a path
along track with matching priority settings.
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A trigger’s scope is defined by its radius which extends outwards from the
trigger along the track. The default trigger radius is 20 meters and in most
cases, this is sufficient. If needed, this can be altered and the advanced trigger
tools in section 11.8.8 explains this further.

For a train to be visible to a trigger, the train must be within range of the
trigger’s radius and there must be no obstructions such as a junction which
can block the trigger’s view. Therefore caution is advised when placing
triggers near junctions.

Once placed, triggers will most likely be used in session rules. Several rules
such as Trigger Check can monitor and react to trigger so it is possible to use
this to initiate other events whenever a train enters a trigger for example.
Sessions are examined in section 11.14 later on in this chapter.

Direction Trackmarks
Direction trackmarks look exactly like regular trackmarks except they are
yellow in color. They are used to indicate to the AI driver what direction is
allowed on a section of track. 

Only the placement of the directional trackmarks is required. The AI drivers will
automatically take the trackmarks into account. By placing direction
trackmarks carefully, the AI trains can be restricted and coerced to take certain
paths.

Note: An AI driver will not go against a direction marker, so be careful
where you place them, otherwise you could be blocking out a potential
path that is needed to travel somewhere on your route.



113

11.9 Tools Menu (F5)
The Tools Menu (F5) offers some additional
tools for helping to create your TRS2006 world.

11.9.1 Ruler Management Tools
The ruler tool is used to measure track lengths,
radius when laying curves, even the size of
your basement or garage.

Add Ruler (R)
To add a ruler, Click LMB on Add
Ruler (R), then Click LMB at your
chosen point in your terrain and

drag the mouse to the other end point for
the ruler and release the mouse button. The
ruler stretches out just like you experienced
with spline objects.

Changing the Scale of the Ruler
To change the scale of the ruler, go into the Surveyor Main Menu and choose
Edit Route. Change the units to real Scale, HO, OO or whatever scale you
prefer.

Move Ruler (T)
To move the ruler, Click LMB on Move Ruler (T) and then Click
LMB+H on either end of a ruler and then drag it to move that end of
the ruler.

Delete Rule (Y)
Use Delete Ruler (Y) to delete the ruler. Leaving a large number of
rulers on your route can cause severe slowdowns, so make sure you
delete them when they are no longer necessary.

11.9.2 Camera Management Tools
Cameras are used in Driver to follow where your trains are going. You can
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11.8.8 Advanced Trigger Management Tools
The advanced settings of the Trackmark tools
menu are used to set the radius of triggers.
The radius defines the scope of the trigger and
is explained in the previous section (11.8.7).

Get Radius
Click on the Get Radius tool and then Click LMB on a trigger. The
trigger’s radius will now be in the text field adjacent to the button. Note

that triggers have a default radius of 20 meters so this may not appear to have
changed.

Set Radius
Click on Apply Radius then Click LMB on a trigger to apply the value in
the radius field to that trigger.

Adjust Radius
Click on Edit Radius then Click LMB on a trigger and drag the mouse
with the LMB still being held down to chage the trigger radius. There is

no visual indication of the radius as you drag it however. Use Get Radius to
find out the new radius of that trigger.
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11.9.3 Copying and Pasting Tools
Another very useful tool is the copy and paste function.

Select Area (B)
Click LMB on Select Area (B) and Click LMB and drag to create a
rectangle around the area you wish to copy. The white box shows the

area that will be copied.

Paste Mode (P)
Click LMB on Paste Mode (P) and Click RMB to navigate around your
terrain to the new location. Click LMB where you want the selection

copied.

Cancel Selection (X)
Click LMB on Cancel Selection (X) to cancel the selection.

Paste Height, Textures or Paste Objects
You can control what is and is not copied and pasted.
You can copy height, textures, objects or any

combination by selecting and deselecting the appropriate icons. These are
"toggle" switches. Whilst in Paste Mode, click on Paste Height, Paste Textures
or Paste Objects to include or exclude those elements from your paste
function. The buttons will remain highlighted in bright green if toggled "on".

Paste Rotation ("[" or "]")
You can also rotate your selection using Paste Rotation ("[" or "]").

Relative Height (L) or Absolute Height (S)
You can paste either relative or absolute heights by
Clicking LMB on either icon to toggle between them. The
default is absolute height.
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place static cameras, which focus on a section of track until the whole train
passes by, or tracking cameras, which pan across following the train
movement. To select which camera to work with, Click LMB on either of the
arrows in the middle of the tool list to switch between Static and Tracking
camera mode.

Place Camera (A)
Before placing a camera, maneuver your normal viewpoint as close
as possible to where you want to place the camera. Click on Place
Camera (A), then Click LMB exactly where your Compass meets the

ground. This places the camera in 3D space, and puts you automatically into
Move Camera (M) mode. A Green box and a flashing green light appear.

Move Camera (M)
Use your zoom keys, and cursor keys to position the camera exactly
as you want it placed, then Click LMB again to lock the camera in
place. (Note that you stay in move mode until you choose to add

another camera). Zoom out a little and you will see the 3D camera object. A
red camera means it is a static camera, and green is a tracking camera. Below
we see the camera view and a Red static camera.

Delete Camera (D)
To delete an unwanted camera, select Delete Camera (D) and Click
LMB on a 3D camera object. Cameras have a "range" in Driver of
150-200 meters so careful placement is required.
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Mastering the Lighting
The main feature of the World Menu is the lighting clock and associated tools.
With these tools you can set different lighting conditions for different times of
day, creating varying moods and ambient tones.

RGB Color Controls
By controlling the mix of Red, Green and Blue in a
color, you can create any color. These controls are
used to set the color of the selected item. They will

brightly colored when an item has been selected which can be colored. If no
item is selected, they will be much darker in color and the dials will not be
moveable.

Time of Day ("+" or "-")
The main clock is a 24-hour clock and the small red lights
around the outside determine what the colors will look like
at that particular time of day. Click on the 12 o'clock light
and it will highlight and the three-color RGB dials will also
be highlighted allowing you to adjust the color at that time
of day.

To choose the time of day, Click LMB+H and drag your moue or use the "+" or
"-" keys. Note that the lighting in your route changes as you do so that you can
see the effect of your choice on your route.

Tip: The "+" and "-" are the keyboard keys between the "0" and
"backspace" keys on your keyboard. They are not the keys on the
number pad at the right of your keyboard.

Clouds Window
In the Clouds window a white line appears at the bottom of the
window. Click in the center of the Clouds window, and the
white line moves to the center. Click at the top of the window
and it moves to the top. These are the three-color bands in
the sky that you can adjust using the RGB dials.

116

11.10 World Menu (F6)
The final menu for Surveyor is the World Menu.
Here you can see what your route looks like in
various weather conditions and you can also
set the clouds and lighting conditions for your
Driver sessions.

11.10.1 Weather Management Tools

Weather Control ("[" or "]")
The Weather Control ("[" or "]") dial
shows what your route will look like in
rain (move the dial left) or snow

(move the dial right).

The Clouds text box determines which
clouds will appear on this route. Change
the clouds by scrolling through the list until your
find the clouds you would like to use. Or, as in
the illustration below, Click LMB on the current
selection and a drop down list appears from
which we have selected the QLD Sky.

The Water text box works in the same manner, identifying the default water
texture.
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Move Clock (M)
You can also select Move Clock (M) to move the lights to a new time
slot by dragging them around the clock.

Delete Clock (D)
Click LMB on Delete Clock (D) to delete the red lights by Clicking LMB
on them.

Reset Colors
If you wish to reset the RGB colors to the defaults used by TRS2006,
Click LMB on the Reset Colors button.

Diurnal Cycle
To run the full 24hour cycle and see the effects, click on the Diurnal
Cycle button. This runs the full day in around 30 seconds. Click on it
again to stop the cycle at any time. You can also Click LMB and drag

the hour hand to see how the colors blend over time.

11.10.2 World Origin Management Tools
The World Origin is a marker that you place anywhere on your route to set the
latitude, longitude and altitude of the Origin Marker.

You can then place Trig Stations (found in the Objects Menu) anywhere on
your route to identify the exact lat/long and altitude of the Trig Station. Zoom
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Note: You must have one of the red buttons on the clock selected to
be able to select a band in the sky.

Let's begin with the lower band. Click on the bottom of the clouds display
window (make sure you have one of the red lights around the clock selected).
Now move the three RGB color dials and notice the sky colors change. Repeat
this for the middle and upper bands.

There are three other colors that we can change and they are ambient, sun
and water.

Note: Remember to repeat the processes that follow for all the red
lights around the clock.

Ambient Color Preview
Click LMB on the top Ambient Color Preview box and adjust the RGB values
to set the directional lighting primarily changing the color hue of buildings and
other objects

Sun Color Preview
Click LMB on the middle Sun Color Preview box and adjust the RGB values.
This alters the ambient lighting, primarily affecting the terrain.

Water Color Preview
Click LMB on the lower Water Color Preview box and adjust the RGB values.
This alters the color of areas of water.

Add Clock (A)
To add new red lights, select the Add Clock (A) tool and Click LMB on
the outer rim of the clock to add new "lights" as required.
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Find World Origin
To find the World Origin in your world, Click on Find World Origin (F)
and the view will be centered on the World Origin.

Edit World Origin
To edit the properties of the World Origin, Click LMB on Edit World
Origin (E) and you can set up the latitude (setting it north or south of the

equator), longitude (setting it East or West of the Greenwich Mean Time line),
and altitude.
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in close to a Trig Station and rotate to see the digital readout of lat and long.

Tip: Use the '?' icon to name the Trig Station using the format "xx
xxx.xxx N/S xxx xx.xxx W/E" and then use Ctrl F to bring up a list of all
named objects. Click on the lat/long you are looking for from the list
and you effectively have an unlimited number of bookmarks.

The placing of a World Origin marker adjusts the sun position (the higher the
latitude, the lower the sun position). We don't currently model seasons, so the
sun position is approximated for a typical 12-hour length daylight cycle.

Add/Move World Origin
To add a World Origin and then move it if you wish, Click LMB on
Add/Move World Origin (O) and then Click LMB anywhere on your

world to add the World Origin or Click LMB+H to move it around. Having
added the World Origin, the next two commands below will become available
to you as well.
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Tip: If there is a green checkmark with the letters "IND" shown in the
lower left corner of the Viewer window, this is an indication that this is
an "interactive" piece of rolling stock capable of participating with
"interactive" industries.

Tip: There is a little red button at the top right of the list labeled the
Favorites Toggle. If you click on this button, it turns Green and the list
will display only those engine and rolling stock assets that you flagged
as a Favorite using the Railyard module (described in the Engineers
Guide). This allows you to eliminate those assets in which you have
no interest making asset selection easier. Click LMB on the Favorites
Toggle button once more to view all assets.

Continue to select items to be added to your consist, Clicking LMB on one end
of the consist or the other to add engines or rolling stock. The Red and Green
arrows adjust to mark the ends of the consist. Note that if you Click LMB too
far away from the end of the consist, your addition will begin a new consist.
The Green arrow indicates in which direction the consist will move when
moved forward when operated in Driver.

Tip: If you want to move the consist that you are building to another
point on the track, use the Move Consist function available by
switching to Consist Mode (described below)

Rotate Train (R)
Click LMB on Rotate Train (R) to enable rotation of the engine or cars
in a consist. Once enabled, Click LMB on any engine or car in a consist

to change the direction in which it is facing.

Get Train (G)
Click LMB on Get Train (G) to enable you to quickly find a copy of an
engine or car already placed on the track. Once Get Train (G) is

selected, Click LMB on any car in any consist on the route and that car will be
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11.11 Trains Menu (F7)
In TRS2006, you may assemble consists and
place them on track anywhere within the world
you have created in Surveyor. The Trains tab is
used for this purpose.

11.11.1 Building and Placing Trains

Train Mode (T)
Clicking LMB on the Train Mode (T)
button in this tab allows you to
assemble consists. A list of all

engines and rolling stock is displayed below
this button. Below the list are selection lists for
Train Origin and Train Company. If "All" is
selected in both of these lists, all consists and
rolling stock will be displayed. By selecting
a region or company in these lists the list
displayed can be restricted to just that
company or just that region or both.

Add Train (A)
Click on Add Train (A) to enable the building of a consist. Click LMB on
the engine or rolling stock asset in the list that you would like to place

on the route. Note that a picture of the asset appears in the Train Viewer
window in the bottom of the tab. If you Click LMB on the asset in the Train
Viewer window, the picture will rotate to show you different views of the
selected item. Click RMB+H on the item in the picture and move your mouse
forward and back to increase and decrease the size of the item in the Train
Viewer window.

Click on a location on a track in your route and your item will be placed at that
point.
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A name will be assigned to the engine or car by adding a number to its name
as found in the list of locos and cars. You may change the name to any unique
name that you wish. Names for locos and rolling stock persist only for this
particular session.

You may also change the running number for an engine or car by Clicking LMB
on the underlined text after the words Running Number. A new window opens
in which you may enter the number of your choice. If the engine or car has
been designed with a number that is changeable, the number will change to
match your selection.
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selected from the list in the Trains tab and displayed in the Train Viewer
window. This makes it easy to find any engine or car if you wish to add more
of them to the route.

Delete Train (D)
Click LMB on Delete Train (D) to enable you to delete any engine or car
already placed on the track. Once Delete Train (D) is selected, Click

LMB on any engine or car in a consist on the route and that engine or car will
be deleted. The consist will shorten if necessary to close the space taken by
the car or engine and keep the consist intact.

Decouple Carriage (X)
Click LMB on Decouple Carriage (X) and then move the cursor to a
point near the connection between two items in a consist until an image

(colored Red) of a coupler appears. Click LMB on the coupler and it will be
seen to open. Additional Green and Red arrows will appear above the point of
uncoupling to mark off the two consists that have now been made from the one
original consist.

Note: To re-couple these consists or any two trains, use the Move
Train (M) button described a bit later.

Edit Properties (P)
Each engine or car in TRS2006 can be assigned properties. Click LMB
on Edit Properties (P) to enable the setting of properties for engines and

vehicles. Click LMB on an engine or car in a consist on the route and a new
Properties window opens up.
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to delete the consist currently selected in the list. A window will open up in
which you will click on the Yes or No button to confirm or deny the deletion.

Add Consist (A)
Click LMB on Add Consist (A) to add one of your chosen consist to your
choice of points on the route. Click LMB at any point on the track to

place the complete consist there.

Move Consist (M)
Click LMB on Move Consist (M) to enable you to move any consist on
your route along the track to adjust its starting position. Click LMB+H on

any consist to move it back and forth along the track.

To join two separate consists together, move one consist along the track until
it touches the other consist then release LMB. The two sets of associated Red
and Green arrows that marked out the will then combine into one set for the
new consist.

Rotate Consist (R)
Click LMB on Rotate Consist (R) to enable the rotation of any consist
so that it is pointed in the other direction. Click LMB on the consist to

change its direction. The Red and Green arrows will also switch positions to
reflect the rotation.

Get Consist (G)
Click LMB on Get Consist (G) to enable the addition of newly built
consist to the consist list as well as the quick selection of copies of

consist already on the track from the list of consists. Then Click LMB on any
consist on the track.

If the consist is already in the consist list, it will be selected in that list so that
it is easy for you to add a copy of that consist to the route.

If the consist is not in the list (likely because you have assembled and placed
it previously in Train Mode, you may now give it a name in the window that
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11.11.2 Train Management Tools

Consist Mode (C)
Click LMB on Consist Mode (C), one
of two large buttons at the top of the
tab, to enable the placing of

complete consists available in the list of
consists below the button.

A consist window appears at the bottom of the
screen which display the currently selected
consist in the list at the top of the tab.

Click LMB on any consist in the list and it will
appear in the consist window for your
reference.

You can Click LMB on any of the vehicles in
the consist window to change their
direction. Click LMB and hold on a vehicle
and drag it outside of the consist window to
remove it from the consist.

Rename Consist Template
Click LMB on the Rename Consist Template (large gray
colored button labeled "Rename" under the consist list)

button to rename the consist currently selected in the list. A window will open
up in which you may do the renaming.

Delete Consist Template
Click LMB on the Delete Consist Template (large grey
colored button labeled Delete under the consist list) button
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11.12 Surveyor Title Bar
The Title Bar appears at the top of the Surveyor screen and has several tools,
plus the Main Menu drop-down box.

The Title Bar is set to hide by default. Moving your mouse to the top of the
screen will display the Title Bar.

Quit (Esc)
The Quit button is not really part of the Title Bar as it is always there
regardless of whether the Title Bar is visible. However when visible, the

Quit button sits on top of the Title Bar.

Surveyor Main Menu
Clicking on the word Surveyor on the title bar opens up the
Main Menu drop-down box. Full details on these menu

options are listed in section 11.13.

Quick Drive (Ctrl-F2)
The Quick Driver button is shortcut that you can use to run the current
session in Driver. This can be handy for session creators who can jump

quickly into their session and test it without having to quit Surveyor.

Edit Session Rules
This button opens up the Edit Session window where the rules that
define a session are added and configured. See sections 11.13.7 and

11.14 for further details on this window.

Content Search Filter
Clicking on this button opens the Content Search Filter window which
you can use to define you own filters for use in the asset lists found

across the various tool menus such as Objects, Track and Trains.
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opened up and the consist will be added to your list for future use. This is a
great way to build up a list of your favorite consists for use on many different
routes.

Tip: When you name a consist, that name persists in the consist
inventory across other routes and sessions where it is used.

Delete Consist (D)
Click LMB on the Delete Consist (D) button (not to be confused with the
big gray colored Delete Train Template button in the middle of the Tab)

to enable the deletion of consist placed on the track. Then Click LMB on any
consist to remove it

Decouple Vehicle (X)
Click LMB on the Decouple Carriage (X) button to enable the
decoupling of parts of a consist to break them up into smaller consists.

Then Click LMB on the coupler icon that will appear when you move the cursor
between cars or engines in a consist. You will see that the red and Green
arrows will show that you now have two consists. Use Move Consist (M) to
move them apart if you wish.

Change Heading (H)
Click LMB on the Change Heading (H) button to enable the changing of
the heading of a consist. Then Click LMB on any consist and the Green

and Red arrows will move to opposite ends of the consist setting the direction
that will be forward when the consist is started in Driver mode.
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When the name entry box appears, enter in a name for the filter and Click LMB
on the check icon. Close the Content Search Filter window be clicking on the
"X" in the top left corner and return to the main Surveyor screen. Open up the
Objects menu (F3) and select your filter. Click LMB to select your category and
note how the only assets in the object list are airport assets.

Undo (Ctrl-Z) and Redo (Ctrl-Y)
Undo and Redo are very useful functions for clearing up
mistakes and recovering deleted objects etc. The

number of levels you can undo or redo is determined by your computer
memory. To use, just click on the appropriate Icon and your last step is Undone
or Redone. If you have done a number of things quickly, such as painting a
number of textures, be aware that these may all be become undone in one
click.

Bookmarks
Bookmarks are used to set a location on your
map that you want to return to later. To set a

Bookmark, right click on the first Bookmark icon and notice that it changes to
a green color. This sets that bookmark at the point where the compass is
located.

Navigate to a new area on the map and Click RMB on the second bookmark
to set it to that location. To recall the first bookmark, Click LMB on the first
green icon. The map is re-centered to the original location.

You can also set and recall Bookmarks using Ctrl-1 through Ctrl-0 to set the
bookmarks and use keys "1" to "0" to recall them.

Wireframe View (F9)
The Wireframe View button (F9) replaces the textured terrain with a
see-through wireframe. This mode is useful for seeing what lies

beneath the ground such as under hills when placing and moving tunnels. Use
F9 again to return to the regular view.
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To create a new search filter, select a Region and enter the Author and an Era
if desired (1980s, 1990s etc.). The main text field is keywords for the filter to
use when finding assets. 

For the sake of an example, just enter the word "airport". To save this custom
filter, Click LMB on the text field next to the "Search Filters" field at the bottom
of the window. Scroll to the top of the pop-up list and Click LMB on the
"Save..." item.
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11.13 Surveyor Main Menu
There are additional functions in Surveyor that
are located in the Surveyor Main Menu at the
top of the screen. To open the Surveyor Main
Menu, Click LMB on the word Surveyor on the
main Title Bar. (If the Title Bar isn't visible,
move your mouse cursor to the top of the
screen and it will drop down).

11.13.1 Creating and Saving Routes & 
Sessions

New Route
Click LMB on New Route to replace your existing route with a totally new
route. You will be asked to Save if you have made changes to the route that
you were working on. In the Create a New Route window that next opens up,
enter or select the following information:
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Lock Menubar (F10)
You can lock the Menubar by toggling the Lock Menubar icon in the
upper left corner of the screen. If it is locked, the Menubar will always

be there for easy access. To hide the Menubar again, click again on the Lock
Menubar icon and move your mouse to the bottom of the screen and it will
disappear shortly.
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If you wish to save it with a new name, click on the name New Route and a
drop down menu appears as follows.
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Give the new route a Route Name (replacing the name New Route and give
this instance of the route a Session Name as well. This allows you to have a
single route with multiple instances of it available. For example, you may have
different sets of trains in different sessions. The options are endless.

Select a Geographical Region from the list for your route. One impact of
selecting a region is that the cars will drive on the appropriate side of the road
for your region. It will also affect the default latitude and longitude settings for
the World Origin, the placing of Trackside objects and the default selection of
Metric or Imperial measures.

Set the Working Scale to Real Scale if you wish to develop a virtual railroad
rather than a scale model one. This setting affects the markings on rulers that
you can use to size things up on a route as you build it. If you select HO scale
instead for example, the rulers will measure distance in actual inches or
meters in HO scale. If you are developing a virtual version of a model railway
select the appropriate scale.

Set Working Units to metric or imperial measures as you wish. This will affect
the measurements used when displaying the operating conditions in the
engines as you are operating them.

Save and Save As
Use Save if you simply want to save the route and session that your are
working on with the same names that you saved them with last time.

Use Save As if you wish to save either the route or the session you have
created with new names.

In either case you will see one or more of the following menus appear
depending on where you are in the route and session building process. Note
that the buttons that the items that you select have green buttons. If you
cannot click on a red button to turn it green, it is because that option is not
available to you at this time.
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If this variation of the menu appears, you now must decide if you are going to
override the route and the session information or just the route information.
Click LMB on one of the buttons to the left of the following three options.

Do Not Save Session
This will save the route as you now have developed it but will not replace the
session information such as the trains placed on the route and the information
you have modified using the Edit Session menu item described below. This
allows you to save just the route that you are working on with the same name
as you loaded it with.

Overwrite Existing Session
This will save the route as you now have developed it and it will also replace
the session information such as the trains placed on the route and the
information you have modified using the Edit Session menu item described
below. The existing session information will be overwritten.

Create New Session
This will save route as you now have developed it. It will also create a new
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You may now either type a name of your choice on top of the New Route name
or you can click on any of the names in the list below if they have a (c) beside
them. The (c) beside the name means that this is a route that has been
created earlier by yourself or is a downloaded route created by someone else.
The Names in dark black type such as "British Midlands" are routes that came
with the TRS2006 product and cannot be overwritten. So you have the option
of clicking on any of the routes with a (c) beside them if you wish to overwrite
them with the route you are working on now. If you do choose to overwrite a
route, you will see the following menu:

Click LMB on Yes or No depending on which choice you would like to make.

Tip: Be careful when overwriting a route as the route being overwritten
is erased forever. Some route builders chose to store successive
versions of a route with a different name or with a version number so
that they can recover a prior version if they wish.

WARNING: If you Save As and use the same name for the Route
you have just edited and Click LMB on the green tick you will get
a dialogue box appearing that asks if it is OK to overwrite the
route, If you Click LMB be aware that all dependent Sessions for
that Route will be lost. If you don't want to be in danger of losing
Sessions choose a different name for the Route. As the Routes
that come with TRS2006 cannot be overwritten, this warning does
not apply to Sessions dependent on these Routes.
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When this menu appears, you have the option of overwriting the existing
session information or creating a new session. Click LMB on the red button to
the left of Create a new session and enter a new session name by Clicking
LMB on the field below it and entering a new name. Note that a drop down list
of existing sessions appears. You may select one of these for overwriting if you
wish.

If you select Save or Save As and there have been no changes since the last
save operation, this message will appear. Click LMB on OK to return to
Surveyor.

11.13.2 Delete Missing Assets
Delete Missing Assets will remove any links to missing objects. This may have
occurred if you have downloaded a new map and don't have all the custom
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session with information such as the trains placed on the route and the
information you have modified using the Edit Session menu item described
below. So now you will have a route with more than one session saved for it
as the Session you loaded the route with will continue to be saved as well with
the old name.

If you choose this option, enter a new name for your session in the field
provided.

Tip: One of the great features of TRS2006 is that you can save many
different operations session setups with a given route. E.g. an early
morning passenger run or a midnight freight haul.

If this menu appears, you may save the new route and session with the current
route name (New Route) or you can click on the field and enter a new name
for the route. The existing session (Default) will be stored with the new route.
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Whilst in mini-map mode, you can navigate around the terrain quickly by
zooming out and Clicking RMB to move the baseboards around the screen.

There is also the ability to show/hide certain types of items in the Mini-Map
view. Click LMB on the "Map Display Options" text in the top left corner of the
Mini-Map window and select/deselect the items you want to show/hide as
desired.

Click on the "X" in the upper left corner of the Mini-Map to close this window.
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content installed, or have older content that is not compatible with your version
of TRS2006.

This menu will appear asking you to confirm or deny the action.

11.13.3 Mini-Map (Ctrl-M)
Click on Mini-Map to bring up an overview of your current map. Ctrl-M is a
quicker way of bringing up this map. You can also toggle the Mini-Map on and
off using Ctrl-M.
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11.13.5 Merge Route
Merge Route is an important tool for joining one saved route to another. Select
Merge Route and a list of all your saved maps are displayed.

Choose which map you would like to join to the current map from the list and
click on the Check Mark. You will see the baseboards from both maps and red
shading on the baseboards where the current map and the new map overlap.
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11.13.4 Find Object (Ctrl-F)
Find Object (Ctrl-F) brings up a dialogue box that lets you type in the name of
an object. The map will be re-centered if any "named object" with that name is
found. An error is displayed if there is no object by that name.

Only certain objects can be named such as turnouts, signs and stations. By
selecting a type other than "All" you can narrow down your search.



145

You may now change the Route name, add a Description, change the Working
scale and the Working Units (which were discussed above in section 11.13.1).

11.13.7 Edit Session
Click LMB on the Edit Session item to open up the Edit Session window. This
window is where sessions are constructed and configured using with rules. A
default minimal session with several basic rules is already provided.

Further details about this window and how it is used to construct a session can
be found in section 11.14 of this manual.

11.13.8 Performance Tuning Options (Ctrl-T)
One of the most important menu options in the Main Menu is the Performance
Tuning option (Ctrl-P). Here you can see how to adjust the settings to improve
performance depending on your PC specifications. In general, if your frame
rate is too slow then adjust the sliders towards the left. These setting are
discussed in more detail section 7.3 of this manual.
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Use the four small arrows at the bottom of the box to move the map to be
merged left, right, up or down and use the four white arrows on the mini-map
to navigate around the mini map. Click LMB on Proceed once you have
uncovered all the red overlapping sections.

Tip: You cannot rotate a new map but you can join to it on any side.
Large maps will take some time to merge. Before merging, rotate the
camera so that you are facing North. This helps you understand which
side of your existing route you want to join to.

Once you have merged two maps, you will have to edit the joins to smooth out
different level terrain, and also to join track from the old section to the new.

You can change the map name, scale or measurement units using the Edit
Project dialogue box.

11.13.6 Edit Route
Click LMB on Edit Route and a window opens in which you can modify the
properties associated with a route. This is the same screen that appears when
you clicked on Create New on the Surveyor main menu.
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Select Panning as the default Camera Behavior and the map slides left or right
when you navigate around the terrain. Rotation means that the map will rotate
slightly as you navigate.

Fixed Track Vertex Height if set to On ensures that as you lay track, the spline
points are "fixed" at that height so that when you adjust the terrain height, the
track doesn't move. You can then use Smooth Spline to adjust the terrain and
Adjust Spline Height to move the spline points up or down.

With Spline Point Rotation set to Off you can turn the white circles from
spinning to static.

You can set the Function Keys Open Panels so that the Function Keys (F1,
etc) open the panels by turning this option On. If you set this option to OFF,
the Function Keys will enable that panel but will not open the panel. Once you
know all the hotkeys, this function can speed up your map making.

Use Randomly Rotate New Objects when you are placing forests etc. You may
want to switch it to Off when laying rows of houses.

Contextual Information determines the level of help graphics that displays in
Surveyor. Set it to Off and only the current Menu graphics are displayed. (e.g.
Track spline points won't display whilst the Texture Menu is open).
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11.13.9 Surveyor Options (Ctrl-O)
The Surveyor Options menu (Ctrl-O) provides different default behaviors for
the TRS2006 interface. You can adjust the mouse scrolling speed and alter the
way the keys work.

If the mouse is moving too fast for you when you hold down the RMB, adjust
the Compass Speed slider to the left.

Select the keys option for Compass Movement to use the cursor keys for
moving the compass. The mouse will then move the camera.
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11.14 Session and Rules Management

11.14.1 Introduction
One of the powerful features of TRS2006 is the ability to apply Rules to a
Session. TRS2006 ships with some standard Rules to get you started, but like
other assets, new Rules will become available for download enabling you to
expand the possibilities.

What can rules do? Well they can set basic parameters in a Session including
which driver is in each Train, the weather state, control method, set up industry
dependencies, what Driver Commands are available in the Driver Module and
set the time and time rate.

They can also be combined, so that when a particular train hits a trigger the
weather may change or a sound may be played.
Then there is the ability to pull HTML pages and sound files into the game. On
top of that the Rules can be arranged to occur in a particular order.

All of this adds up to an open-ended system to manipulate the Driver
experience, even for someone who has no real programming experience. We
expect Rules to be one of the strongest features of TRS2006 as there really is
no limit to what can be done using Rules.

Note: If you don't want to have anything to do with Rules (Keep It
Simple) then fear not, a default set of rules including assigning Drivers
to Trains is automatically saved when you save a Session in Surveyor.

In this section we will describe how to use the Edit Session interface to add,
delete and edit rules. The rule themselves are a large complex topic with their
own document known as the "Session and Rules Guide" which is available
from the Trainz website.
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11.13.10 Help System
There is also a Help option in the Main Menu. The Help text menu that
appears describes the various functions of each of the keys in Surveyor.
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11.14.4 Editing Rules
Each rule may have a number of parameters associated with it that need
configuring in order to modify it to your requirements. Highlight the Rule in the
list that you wish to modify and Click LMB on the "Edit" button to bring up the
Rule's Properties Window. All editable parameters are made available to
configure in this window. By clicking on the available hyperlinks, you can edit
the rule’s parameter.
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11.14.2 Edit Session
Recall that a Session is different from a route as it may include for example
different trains. Click LMB on Edit Session on the Surveyor Menu and a
window opens in which you can modify the properties associated with a
Session. From here, you may change the Session Name, add a Description,
and the operating Rules to be used in this session.

11.14.3 Adding Rules
Click LMB on the Add Rule button (labeled "Add") to add a new rule to the
session. A window opens up with the set of rules that you can choose from.
Click on any one of the rules to add it to the list of rules to be included in this
session.

Once you have added the rules you want, it is time to edit them to make them
specific to your needs. See the individual descriptions of the major rules below
for guidelines on editing them.
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Note: The top level of the Rule Hierarchy is reached when the Rule is
lined up as far left as it can get (Further presses of the Outdent button
have no effect).

Indent (Rule)
To Indent a Rule by one level select the Rule by Click LMB to highlight
it and then Click LMB on the "Indent" button. This makes the selected

Rule dependent on the next higher Outdented Rule above it. The indented
Rule will not be executed unless the Rule next up in the Hierarchy is activated.

Promote (Rule)
To Promote a Rule up the Rule List select the Rule by Click LMB to
highlight it and then Click LMB on the "Promote" button. Once the Rule

has reached the top of the Rule list it can no longer be Promoted.

Demote (Rule)
To Demote a Rule down the Rule List select the Rule by Click LMB to
highlight it and then Click LMB on the "Promote" button. Once the Rule

has reached the bottom of the Rule list it can no longer be Demoted.

Delete (Rule)
If you want to remove a Rule from the list select it by Click LMB on it and then
Click LMB the "Delete" button. A dialogue box pops up confirming the deletion.
Click LMB the "Yes" button to confirm the deletion or Click LMB the "No" button
to cancel.
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You can also edit the name of any Rule by Click LMB on it's text descriptor and
typing in its new name. This can help identify a particular Rule in a complex
Rule arrangement. Note that it is possible to have multiple rules of the same
type in a session where each rule instance has its own configuration.

11.14.5 Managing the Rules
The Rules in your Rules List can be further manipulated by the four command
buttons at the bottom of the Edit Session window.

The Outdent, Indent, Promote and Demote commands are used to order the
Rules in a Hierarchical and Ordered fashion.

Some rules (like the Trigger Check Rule) require indented child rules
immediately below them. This determines what happens when the Trigger
Check Rule is activated. Other rules, like the Ordered List Rule also use child
rules below them to fulfill its purpose. The child rules below the Ordered List
Rule can be re-ordered by using the "Promote" and "Demote" buttons to alter
the order in which they are executed.

As you can imagine the combinations are limitless.

You can also Delete Rules altogether by selecting the Rule with a Click LMB
and then Click LMB on the "Delete" button.

Outdent (Rule)
To Outdent a Rule by one level select the Rule by Click LMB to highlight
it and then Click LMB on the "Outdent" button. This removes the Rule

from dependency upon the Rule it was Indented under.

Note: Be careful here as Rules subsequent to the Outdented Rule that
are Indented will now only be executed if the Outdented Rule
conditions are met. Use the "Promote" and "Demote" buttons to re-
order the Rule List if this is not the desired outcome.
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12.3 Launching the Driver Module
Click LMB on the TRS2006 icon on your desktop or start the TRS2006
program from the Start Programs function in Windows. You will then see the
loading screen with a randomly chosen TRS2006 hint and a rotating gear in
the bottom right corner that keeps rotating as Trainz loads.

Tip: The loading time will vary with the amount of custom content that
you download into the system. It will also take longer after you have
added custom content as TRS2006 then rebuilds its "cache" files to
include the new content.

The TRS2006 Main Menu then appears as shown below. There are four
modules to choose from: Surveyor, Driver, Railyard and Trainz Exchange.
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12 - Engineer’s Guide

12.1 Introduction to the Driver Module
Driver is a lot more than just a driving simulation. First, you get to explore the
tracks from behind the throttle, from trackside as trains come thundering past,
from a bird's eye view tracking along with the trains or from a free-roaming
camera.

Then you can switch to an overview map and control all the junctions and
monitor signals and traffic flows. Running multiple consists, you can control
each train yourself, letting the computer AI system control the trains as you
control the switches.

You may also operate in accordance with the waybill system. This system
issues waybills for resources that need to be delivered to and from various
interactive industries in order to maintain the operation of these industries and
the railroad.

12.2 Entering Driver Directly from Surveyor (Ctrl-F2)
Before we explain how you normally launch a driver session in TRS2006, let
us alert you to a handy feature for those of you who will be building your new
or modified routes and sessions in Surveyor.

In the middle of your Surveyor construction session, you can now try out your
new route and session simply by hitting "Ctrl-F2". This will transfer you directly
into Driver. When you leave Driver mode, you will automatically return to
Surveyor so that you can continue to work on your route having tried it out.
This avoids your having to save your session and then exit Surveyor to load
your session into Driver.

Please note that on your way back from Driver, you will be asked if you wish
to save your session for reloading in future just as you might do in a regular
driver session.

Now, let's get on with the normal approach to launching into driving trains.
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contained in the Description window. Choose the Session you want to load
into Driver by clicking LMB on it, then Click LMB on the "Load" button at the
bottom of the screen.

To load a saved Driver session, Click LMB on the "Saved Session" button and
a screen loads which lists all of your saved Driver sessions. Click LMB on the
one you want to load to highlight it and then Click LMB the "Load" button at
the bottom of the Screen.
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Click LMB on the button to the left of Driver to launch Driver (or press the "D"
key). The following Driver Main Menu now appears:

On the Driver main menu you will see a list of available Routes and Sessions.
When you Click LMB on a Session you can view the information (if any)
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12.5 Anatomy of the Driver Screen

12.5.1 Introduction
Let's take a look at the Driver Screen and where you can find the information
and controls you need. We're going to select one of the tutorials and use it
to demonstrate the common features of the Driver Screen.

At the Driver Main Menu select the "Tutorial 1 - Controls" session from the
"British Midlands 2" route. Load it by Clicking LMB on the "Load" button at
the bottom of the screen and it will begin to load the session.

The Tutorial 1 session does not have any train driving in it, but rather it is a
guided tour of the Driver module’s key interface components. 

12.5.2 Driver Menu
At the top left of the screen is a drop down menu known as the Top Menu. It
only appears when the mouse pointer approaches the top left of the screen.
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Click LMB on the Routes button to return back to the Driver Main Menu screen
with the route/session selection. Expand the list of sessions for the "British
Midlands 2" route. Select one of the two tutorials and then Click LMB on the
Load button on the bottom right corner of the screen. Trainz will load the
session for the chosen tutorial and you will find yourself outside a coal train
with an instructions window to guide you through the tutorial.

12.4 Tutorials + Manual = Fun
To help you get into the various activities available to you in the Driver mode
we have included six tutorials. They are:

• Tutorial 1 - Controls (British Midlands 2)
• Tutorial 2 - Waybills (British Midlands 2)
• Tutorial 3 - Diesel Cab (City and Country USA 2)
• Tutorial 4 - Steam (Outback Australia 2)
• Tutorial 5 - Drivers (Highland Valley Industries)
• Tutorial 6 - Commodities (City and Country USA 2)

Note: The tutorial sessions take place on several different routes and
won’t appear in order on the Driver Main Menu. To get to a tutorial, find
its corresponding route in the above list and expand that route in the
Driver Main Menu.

We will refer to each of these tutorials in the relevant section. You can use the
tutorials to get an "in-sim" handle on how to control your railroad, whether you
are driving a steam locomotive across the American Midwest, climbing the
Alps in a powerful electric locomotive or acting as a yardmaster in a busy
industrial belt route.

This section of the manual complements the tutorials by giving you "blow-by-
blow" descriptions of the controls and information you have at your command
while in the Driver module.

First though we will go through the common interface items to all Driver
sessions.
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12.5.5 Tool Panel
Finally on the bottom right is the Tool Panel. Here you'll find the waybill,
loading, uncoupling and map buttons.

12.5.6 Hiding the Interface (F5)
You can remove all the interface displays and panels from the view screen by
pressing the "F5" key. Pressing the "F5" key again re-displays the interface.

12.5.7 Screenshots ("Print Screen" or "PrtScr")
Want to do some virtual railroad photography? To take a "shot" of the screen
press the "Print Screen" key ("PrtSc" on some keyboards). The picture is
saved as a .TGA graphics file to your TRS2006 directory in the Screenshots
folder. Screenshots are stored in sequential order starting with the filename
"Screen_001.tga". The next screenshot will be saved as "Screen_002.tga"
and so on.

Use a graphics utility program to convert the TGA file to other file formats as
you require.

Tip: You can use the Hide the Interface (F5) toggle to maximize your
view of the action when taking screenshots.

12.5.8 Throwing Switches to Set Turnouts
Turnouts determine the direction your train will take. You can identify turnout
control switches by a transparent green/red arrow hovering over a red circle.
The green arrow indicates the direction the turnout is set to.
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12.5.3 HUD Panels
At the top right of the screen are the Heads Up Display Panels. Depending on
whether you are in DCC or Cabin control mode it displays different information
relating to the currently selected train. It is also where you will find the camera
control panel, the train's current speed and the speed limit for the section of
track the train is on.

12.5.4 Driver Selection Panel
On the bottom left is the Driver Selection Panel. The picture at the bottom is
your currently selected Driver.

By clicking on the Driver’s picture, you can see a list other available drivers (up
to seven).
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In the Map View (see sections 9.3.5 and 12.8.4) you can also see the turnout
names and the directions they are set to.

You can Click LMB on them to change their direction. Signal states
immediately respond to reflect the change in turnout direction. This is very
useful for planning your train's movements as you can also observe the
location/movements of other consists and the location of industries.

12.5.9 Operating Turntables
Turntables are functional in TRS2006. To operate a turntable Click LMB on
one of the red curved arrows either side of the turntable platform to rotate the
turntable in that direction and line up with the next available track. The curved
red arrow turns green to indicate the turntable is moving.
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If you have On Screen Help activated then the switch names and the turnout
direction will be visible at all times. If not you will need to move the mouse over
the turnout control switch to see its name and the turnout direction. The switch
controlling the turnout may be set back a little from the actual place where the
track meets, but will always be on the side where the two (or three) tracks
combine to form one track.

To change the turnout's direction all you need to do is Click LMB on the green
circle below the green/red arrow. The switch throws the turnout and the
green/red arrows change to reflect the turnout direction.

Note: If you are in the Cab View, hold the Ctrl key when you Click LMB
on the turnout switch.

There may also be three-way turnouts. In this case there are three arrows.
Two will be red and one will be green indicating the direction the turnout is set
to. Each Click LMB on the turnout controlling switch cycles through the three
directions: left, right or straight on.

You can also change the turnout direction of the next and previous turnout
relative to the currently selected Consist. Press the "J" key to switch the next
turnout or press "Ctrl J" to switch the previous turnout.
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1. The line may terminate or be closed, meaning a set of points or
turnout within the block it protects is set against it;

2. A part of a train may be occupying a part of the block it protects,
the signal shows red preventing any further traffic from entering
the block; or

3. A part of a train may be occupying a part of the adjacent block 
when the signal will display Caution to indicate that the next signal 
is at Stop

When a train encounters a green light, it is permissible to pass the signal at
normal speed. The signal will stay green until the rear of the train enters the
block, at which time it will change to red. Once the train leaves the block, i.e.
passes the next signal, the first signal will turn yellow, meaning it is safe to
proceed as far as the next signal which is now at stop.

During Driver sessions, any of the circumstances that result in a red or yellow
signal can be revealed. Move the mouse pointer over the signal lamp, and a
message will display the status of the block. Clicking on the signal lamp will
transport you to the obstacle whether it be a junction that needs switching, a
terminating line or another train.

Alternatively, your path can be cleared using the Map Screen overview, using
a simple dispatch simulation style display.

12.5.11 The Radio Message Box
The Radio Message box can be shown at the top of the Driver screen to alert
you to in game messages that may be of interest. To open the message box,
click LMB on the "Toggle new message" microphone icon located at the top
left of the Button Bar located in the bottom right corner of the screen. Click
LMB on the button again to close the Radio Message box.
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Note: The turntable platform will line up with the next available track
at either end of the turntable platform.

12.5.10 Signaling System
The standard TRS2006 signaling system is based on an elementary controlled
block principle. The network is divided into blocks in both directions, all of
which are protected by signals.

Indications are as follows:

Green - Line Clear
The next signal is either green or yellow, proceed at normal speed.

Yellow - Caution
The next signal is red, proceed at low (half) speed.

Red - Stop
The block is occupied, terminates, or is closed.

All of the signals are red unless a train is approaching one, when it will turn
green to allow passage of the train. There are several reasons why a signal
may not be showing green in the presence of a train:
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Saved Driver Sessions are available to resume at a later time. Select "Saved
Sessions" when entering the Driver Module to see a list of saved sessions.
Click LMB on the required saved session and then Click LMB on the "Load"
button to resume where you left off.

Performance Settings (Ctrl-T)
Click LMB on this button or press the "Ctrl T" keys to bring up the
Performance Settings dialogue box. The sliders here adjust the

performance settings and gamma levels of the Driver module for this and
future sessions.

You can accept your changes by Click LMB on the green tick. To reset to the
default settings Click LMB on the "Reset" button or close the dialogue without
applying any changes to the performance settings by Click LMB on the red
cross.

See section 7.3 of this manual for descriptions of what the various
performance settings do.

Metric or Imperial Units (G)
Click LMB on this button or press the "G" key to toggle between metric
(speed in kph, pressure in kpa) and imperial (speed in mph, pressure in

psi). The default units are set in the Surveyor Module when saving the
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12.6 The Driver Menu Bar

12.6.1 Introduction
The Driver Menu Bar is a drop down menu that appears when you move the
mouse cursor to the top left of the screen. When it has fully appeared the
buttons on it become active.

Exit Driver (Esc)
Click LMB on this button or press the "Esc" key to exit this Driver
Session. A window pops up giving you the option to "Save" your current

Session in its current state, "Exit" without saving or you can "Cancel" your exit
command.

Saved Driver Sessions are available to resume at a later time. Select "Saved
Sessions" when entering the Driver Module to see a list of saved session.
Click LMB on the required saved session and then Click LMB on the "Load"
button to resume where you left off.

Pause Session (P)
Click LMB on this button or press the 'P' key to pause your current
session. The "Pause" button will be highlighted indicating the session is

paused. The session will resume and the "Pause" button loses its highlight
when you Click LMB on the "Pause" button or press the 'P' key a second time.

Save Session (Ctrl-S)
Click LMB on this button or press the 'Ctrl S' keys. A window pops up
giving you the option to save your current Session in its current state

under a name of your choice. If you don't want to save the session, cancel by
Click LMB the red cross. Clicking on the green tick will save the session. If that
name already exists you will be given the option to overwrite the existing file
or cancel the save.
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Click on the name of the object in the "Object" list that you wish to view. Use
the scroll bar at the right of the "Object" list if it spans more than can be viewed
in the list window.

Click LMB on the red "X" to cancel what you are doing or Click LMB on the
Green Check Mark to move the camera focus to the highlighted Object. You
will automatically be in the Free-Roaming Camera mode.

On Screen Help (Ctrl-H)
Click LMB on this button or press the "Ctrl H" keys to toggle between
activating/deactivating the On Screen Help. The "On Screen Help"

button will be highlighted if this option is active.

When active, On Screen Help will show the names and direction of all turnout
control switches. You can identify turnout control switches in the view screen
by a transparent green/red arrow hovering over a red circle. The green arrow
shows the direction the turnout control switch is set to.

When On Screen Help is deactivated you need to move your mouse cursor
over a turnout control switch to see its name and the direction the turnout is
set to.

Note: In Cab View (internal) the mouse over trick doesn't work when
the On Screen Help is de-activated. If you want to check the status of
an up-coming turnout control switch, activate the On Screen Help
(button or "Ctrl H").

12.7 View the World - The Camera

12.7.1 Introduction to Looking Around
Let's take a look at the various views that are available to you whilst in the
Driver module. Get a clear view of the Driver Screen. Then you will be ready
to try out the various camera views available to you. Take a moment to get
familiar with these view controls, some time spent doing this will maximize
your enjoyment in Driver. 
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Session. If you are not happy with the default units, go into the Surveyor
module, change the units and save the session.

Find Object (Ctrl-F)
Click LMB on this button or press the "Ctrl-F" keys to open up the Find
Object window.

To filter the objects listed in the "Objects" list Click LMB on either of the buttons
at the end of the displayed line labeled "Type" to select which class of object
to show in the "Object" list. Selecting "All" will show all of the available objects
(this is default). You can also select the object type by Click LMB on the "Type"
text box to see a drop down list of all object types and then Click LMB on the
object type of interest.
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To zoom in and out use the mouse wheel or the "Page Up" or "Page Down"
keys.

When in Cab View in Cabin Control mode you can manipulate the train
controls directly with the mouse, or watch them move as you use the
keyboard. There may also be secondary animations…things like a window you
can open/close or a seat you can raise and lower. Why not explore a little with
the mouse and see what you can manipulate?

Note: Some locomotives use "generic" cabs so in Cab View their cabs
and control layouts appear the same. However, many locomotives
have unique cabs and hence different control layouts.

In Dual Cab locos, pressing the "Alt-C" keys will change the camera to the
other cab.

Note: Some rolling stock have had internal views activated. Choose
the rolling stock of interest by Click LMB on it and then select the
internal camera. In some cases you can also press the "[" and "]" keys
to different viewpoints inside/outside the rolling stock.

12.7.3 The External View Camera (2)
The External View Camera mode is selected by default when you
enter Driver with the focus point of the camera on the front car or
loco of the selected consist. You can select External View Camera

by clicking on the External View button on the Camera Panel or by pressing
the "Keypad-2" key.

To look at your focus point from different angles, Click RMB+H and moving 
your mouse or press the cursor keys on the keyboard.

If you want to zoom in and out use the mouse wheel or the "Page Up" or "Page
Down" keys.
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The camera views are also reviewed during the DCC tutorial.

There are four camera views in TRS2006 and the Map view. You are free to
move between them at any time to make the most of your Driver experience,
although there will be times when it's advantageous to focus on a view to
accomplish a particular action.

The four Camera Mode buttons are on panel on the HUD at the top right of the
screen.

We suggest you also review the Map View topic under the Tool Menu section
as the Map View is also an integral part of viewing, controlling and getting
around your railroad.

12.7.2 Cab View - The Internal Camera (1)
To go inside the Cab, click on Cab View button on the Camera
Mode Panel or press "1".

Note: If you do not end up inside the cab, you have probably not
selected the locomotive. Click LMB on the locomotive and try again.
Look around the internal view by clicking RMB+H and moving your
mouse or pressing the cursor keys on the keyboard. The left, right, up
and down movements emulates the movement of your head pivoting
on your neck.

You can also move to different internal cameras by using the "[" and "]" keys.
Depending on the locomotive the view may move around inside the cab, onto
the running boards or even outside the locomotive. These keys will move you
smoothly through the available camera views each time you press them.
Holding down the Ctrl key whilst using "[" and "]" will snap the camera to the
next position.
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RMB+H and then moving the mouse the view will track the cursor. The further
the cursor is pushed to the edges of the screen the faster the scene travels to
catch up. By moving the cursor while Click RMB+H to the corners of the
screen the view will rotate to follow. You may also use the cursor keys in
conjunction with the mouse control of the view to frame the scene as you see
fit. Don't forget you can also use the mouse wheel or the "Page Up" or "Page
Down" keys to zoom in and out.

12.7.6 Finding and Viewing any Object (Ctrl-F)
To take the Free-Roaming Camera to a specific object, move your
cursor to the top left of the screen causing the Top Menu to appear. The

second button from the right of this menu is a "Find Object" button. Click LMB
on "Find Object" to open up the Find Object menu. Click LMB on either of the
button at the end of the displayed line labeled "Type" to select which class of
object to show in the list. Selecting "All" will show all of the available objects.
Click on the object in the list that you wish to view using the scroll bar at the
right of the list if it spans more than can be viewed in the list window.

Click LMB on the red "X" to cancel what you are doing or Click LMB on the
Green Check Mark to move the camera focus to the highlighted Object. Once
there, you may use the free-roaming camera to roam the area at will.

Use of the find functionality is discussed further in section 12.6.1.

12.8 The Tool Panel
The Tool Panel is located in the bottom right corner of the Driver screen and
contains several buttons that provide access to various miscellaneous tools in
Driver and are discussed in the sections that follow.
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To change the focus point Click LMB on any of the cars or move the view from
car to car sequentially by pressing the "-" and "+" keys.

You can also change your focus point to another consist by Clicking LMB on
it directly, via the MiniMap view (see Section 12.8.4) or by selecting a different
train from the Driver Selection Panel (see Section 12.5.4).

12.7.4 The Tracking View Camera (3)
The Tracking View Camera Mode is selected by clicking on
Tracking View on the Camera Panel or by pressing the "3" key.

Note: If you don't move to tracking view that is because there is no
tracking camera nearby as described below.

This view requires the placement of cameras within the layout itself (using the
camera tools in the Surveyor module as described in section 11.9.2). In the
Driver module, when you select Tracking View, the camera view switches to
the nearest camera to the currently selected train if and only if there is a
camera in range of the train. These cameras are stationary fixtures in the route
you have selected. Upon detecting your locomotive approaching, they become
active. The Tracking Camera turns or pans appropriately to follow your consist
as it passes and until the consist is out of range, whereupon the default
External View Camera is automatically activated if another Tracking Camera
can not pick it up. Not all layouts will be partially or completely equipped with
Tracking Cameras but you can if you wish add them in the Surveyor module
to an existing layout as well as a new one.

12.7.5 The Free-Roaming Camera (4)
The Free Roaming Camera is not connected to any given train it
works like the view controls in the Surveyor Module. Click LMB on
the Free Roaming Camera button or press the "4" key to enter this

camera mode.

Click RMB and the scene will move smoothly to centre on the cursor. By Click
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12.8.2 Commodities Panel - Which Carries What?
The Commodities Panel is accessed by clicking on this button. The
Commodities Panel is used to assign commodities to specific rolling
stock.

Assigning Commodities to Vehicles
A list of available commodities for this route is depicted as icons on the panel.
Click LMB on the required commodity and then Click LMB on the piece of
rolling stock in the view screen you want to carry that particular commodity.
The rolling stock selected must be capable of carrying the commodity you
have selected. You will know this is the case as when you move the cursor
over the rolling stock the commodity icon will appear. Click LMB to assign that
commodity to the car.

You can move the commodity panel by LMB+H and dragging it around and
dropping it so it gives you a clearer view of the available rolling stock.

Some cars may carry a variety of commodities. For example the "Oily Rag"
tank car can be assigned to carry only diesel, petroleum or crude oil. The
variety of commodities that a car is capable of carrying is determined by the
content creator when they create the asset. The commodities available to be
assigned to a valid piece of rolling stock are determined by the industries that
are placed on the route for the session you have selected.

Note: Only rolling stock that is "active" may be assigned to a
commodity. Some older pieces of "non-active" content are not capable
of carrying commodities.
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12.8.1 Waybills - Who Needs What?
Waybills are automatically created by the active industries on the
session you have selected. In the session "Tutorial 2 - Waybills", the
Radcliff Power Plant has generated a waybill for coal.

Click LMB on the Waybill button on the Tool Panel in the bottom left of the
screen to bring up the Waybill window in which outstanding waybills governing
the operation of the session are listed.

The icons of the industries with active Waybills that need filling are listed on
the left of the Waybill window. If there are lots of them you may need to scroll
using the scrollbar. Click LMB on the industry icon to bring up its waybill on the
right panel of the Waybill window.

As you fulfill the listed industry's waybill by moving the relevant product to that
industry they are removed from the Waybill window…job done!

Of course industries continually consume resources so as they run low on
resources they will generate new waybills…so keep an eye on the Waybill
window for new jobs to appear.

To close the Waybill Window Click LMB on the "X" button at the upper left of
the Waybill Window. Clicking the Waybill Icon
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Commodities Tutorial
Before you run the tutorial that looks at Commodities we suggest you
complete and are familiar with the DCC and Driver Commands portions of this
manual.

To go through an in-game tutorial on the aspects of commodities discussed
above go to the Driver main menu and Click LMB on the "5 Commodity
Tutorial" Session for the City and Country USA 2 Route. Then click LMB on
the Green Light labeled "Load" in the lower right hand corner of the screen.
The program loads in the route and session information for the tutorial and the
session will start.

12.8.3 Decoupling
Being able to make up and break up consists is a classic operational feature
of the world of railroading. Decoupling is key to this.

Decouple Mode (Ctrl-D)
Click LMB on the Decouple button or press the "Ctrl D" key to
activate decouple mode. The button will light up to indicate that you
are in this mode. A Radio Message window pops up indicating you
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There are two other icons that appear on the Commodity Panel.

Stop Icon
The first icon is the "Stop" icon. By selecting this icon with a Click
LMB and then Click LMB on a piece of rolling stock it makes the
selected car inactive. It will not load or unload any commodities even

if presented to a valid load or unloading track and issued a Load or Unload
command.

Default Icon
The second is the "Default" icon. By selecting this icon with a Click
LMB and then Click LMB on a piece of rolling stock you are returning
it to its default state. The default state allows the car to pick up any

compatible commodity. Going back to the "Oily Rag" tank car, if it is set as
default it can pick up and carry any liquid commodity (petroleum, crude oil or
diesel). However it still would not be able to pick up and carry a 20ft container
or lumber for example as these are not valid loads for this car.

When you have finished assigning commodities to rolling stock, you can close
the Commodities Panel by Click LMB on the "X" at the top left of the panel.

Note: All rolling stock starts off in the "Default" state for the purpose of
carrying commodities.

Commodity Levels in a Vehicle
To check a car's current state Click RMB on the car and select View Details
from the pop up menu with a Click LMB. An information dialogue box will pop
up describing the list of commodities the car can carry and how much (if any)
of each commodity is loaded. Click LMB on the "X" at the top left of the window
to close.
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current terrain. The map shows the position, length and driver (if present) of
each consist, signal states, the direction of each turnout (green/red arrows)
and important names such as industries, turnouts, trigger points and stations.
Zoom in and out using the "Page Up" and "Page Down" keys, the mouse
wheel or by LMB on the zoom in and zoom out magnifying glass icons above
the Tool Panel at the bottom right of the screen.

The map follows the movement of the currently selected consist. The currently
selected consist shows as green and all other consists show as gray on the
map. Click LMB on one of the gray consists to select that consist, centering
the map view on that consist in the process. The map will then move to follow
it.

Click RMB any point in the map to center the map view to a new location. You
will lose focus on the current consist. The map is now stationary (it stops
following the selected consist) and under your control. You can Click LMB on
the up, down, left and right arrows to scroll the map. Click LMB on any consist
to have the map resume following it.

You can also throw the switch levers on turnouts by Click LMB on the turnout
(green/red arrows). The green/red arrows will toggle and any changes to
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are in decouple mode. Now move your cursor over the couplers between train
cars you want to decouple until you see a red decouple icon.

When the red decouple icon appears, Click LMB to decouple the consist at this
point. When you have successfully performed the decouple operation, the red
coupler icon "opens" and the Radio Message updates to announce a
successful uncoupling.

The act of decoupling creates a new consist and your camera remains
focused on the same car or locomotive as before the decoupling operation.

To re-couple, ensure that you are operating at speeds below 5mph (8kph).
Experiment with different camera positions to make this task easier.

12.8.4 Breaking Out the Maps - Where are We?
Without a map, it is easy to get lost. TRS2006 provides maps of each and
every route to help us find our way.

Map Screen (M)
The second icon on the Tool panel at the bottom right of the screen
activates the Map Screen (M). Click LMB on the Map button to the
left of the de-couple button to switch to a full screen Map View of the
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Note: If a Driver is not currently assigned to a locomotive there will not
be a locomotive icon under their portrait. This means this Driver is
available to be assigned to an available locomotive (see Section 9.4
on Driver Commands for how to do this).

You may select other Drivers by Clicking LMB on the handle above the
selected Driver picture. A complete iconized list of the Drivers available (a
Session can have up to seven Drivers). Along with the Driver's picture you will
also see their assigned locomotive and active Driver Command icon. Click
LMB on the Driver you want to select from the list and that Driver and his Train
are shown in the Driver screen and their picture moves to the currently
selected Driver slot.

You can also select a Driver from the keyboard moving them to the currently
selected Driver slot and making their train the focus of the Driver screen slot
by pressing the "Ctrl-#" keys where the # is the number of the Driver.
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signal states will also occur on the map. This is very useful for planning your
train's movements as you can also observe the location/movements of other
consists and the location of industries.

Exit the map screen by Clicking LMB again on the Map Screen button, or
press the 'M' key.

12.9 The Driver Selection Panel
By default the Driver Selection Panel shows a picture of the Driver of the
currently selected Train along with a miniature icon of the locomotive they are
driving. If a Driverless train is selected a white box with a "?" is shown in the
picture frame.

To the right of the Driver picture are the sequence of Driver Command icons
assigned to that Driver by Click RMB on the Driver's picture you can add more
Driver Commands (see Section 12.12 on Driver Commands for more
information).
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consist. You are ready to roll…

Go through the tutorial to get a feel for the DCC mode. If you are not already
familar with the basic controls, play through the first tutorial "Tutorial 1 -
Controls" before attempting this one.

Below we look at each of the aspects of the DCC mode of operation, so use
it as a reference if you get lost during the tutorial.

12.10.3 DCC Control and Driver HUD
The information displayed in the HUD (Head Up Display) is dependent on the
Driving Mode selected in the Driver Settings menu. When in DCC mode, the
DCC Panel as shown below appears at the right side of the screen.

The DCC Panel consists of a throttle knob and four buttons which are
discussed in the sections that follow.

Note: If the currently selected train has Driver Commands in progress
the DCC Control Panel on the HUD is no longer visible and the train
is not manually controllable. To regain manual control Click RMB on
the driver and select "Abandon Schedule" or "Stop Train" from the
pop-up Driver Command Menu. See Section 12.12 for more
information on Driver Commands.

Tip: The DCC Control Panel and the Camera Panel can be
shown/hidden by pressing the "F9" key. This can also be a reason why
the DCC Panel is not visible.
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While the Driver List is visible you can Click RMB on their icon to bring up the
Driver Command Menu for that Driver. You can then select what you want that
Driver to do from the list of Driver Commands (see Section 12.12 for more
information on Driver Commands). You can do this without changing the
currently selected Driver/Train.

To close the Driver list Click LMB on the handle at the top of the list and it will
slide down and disappear.

Now you know the basics of the Driver Screen layout and how to view your
world you can start on a tutorial to actually do something in Driver.

12.10 DCC Diesel / Electric / Steam Mode

12.10.1 Introduction
We've grouped all the locomotive types (diesel, electric and steam) together,
because in DCC Mode the control mechanisms are the same for all of them.
Think of DCC Mode as equivalent to a high cost Digital Command Controller
with momentum and braking effects. It's easy to use and quickly gets you
moving your train(s) around the route. As in most places in TRS2006 you can
use the mouse and/or keyboard commands to control the simulation.

12.10.2 The DCC tutorial
Go to the Driver Main Menu and Click LMB on the "Tutorial 2 - Waybills"
Session for the British Midlands 2 Route. Then click LMB on the Green Light
labeled "Load" in the lower right hand corner of the screen. The program loads
in the route and session information for the tutorial and the session will start.

An introduction to the tutorial comes up as a window and describes what you
will be doing in this tutorial - other windows will pop-up along the way to
explain aspects of the tutorial and help you achieve the tutorial goals. Click
LMB on the checkmark in the lower right corner of these windows to proceed.

Once you have read through the introductory screens you will see a stationary
British Railway Class 37 diesel locomotive hitched up to an empty car coal
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Pantographs (Keypad 1)
Lastly, if your locomotive has pantographs, click on the "Pantograph"
button on the right of the throttle control to raise and lower them or
press the "Keypad 1" key. If the locomotive has multiple pantographs

subsequent key/button presses will raise them individually or together before
cycling back to all down.

Speed Limit and Current Speed
Your current speed and the track speed limits are shown at the top of the HUD
above the Camera selection panel. You can toggle the units between metric
and imperial by either selecting the "Units" button on the drop down Top Menu
or pressing the "G" key.

You will need to check your current speed regularly against the track speed
limit and signal indications to make sure you operate the train safely.

12.11 Driver Commands and Working with Industries

12.11.1 Introduction
Driver Commands add a whole new world to TRS2006, allowing you to control
a railroad, not just a train. When coupled with Interactive Industries, active
rolling stock and Waybills this aspect of the Driver Module really will bring your
railroad to life.

12.11.2 Operations, Industry and Driver Commands Tutorial
Go to the Driver main menu and Click LMB on the "Tutorial 5 - Drivers" session
for the Highland Valley Industries route. Then click LMB on the Green Light
labeled "Load" in the lower right hand corner of the screen. The program loads
in the route and session information for the tutorial and the session will start.

An introduction to the tutorial comes up as a window and describes what you

184

DCC Throttle Control (W/X/S)
In DCC mode, a simple rotary dial controller is available
below the Camera Selection Panel on the HUD. This dial
controls the movement of the currently selected train and is
analogous to a model railroad DCC controller knob. Click
LMB+H on the dial and drag it clockwise to move forward.

The top central position of the dial is the stopped location. Dragging the dial
anti-clockwise will make it move in reverse.

Stop (S)
To quickly reset the dial and bring the current consist to a halt, click
on the "Stop" button or press "S".

You can also use the "W" and "X" keys for reverse or forward controls and "S"
key for stop. If you are using the keyboard to control the throttle you can refer
to the position of the rotary dial on the HUD to see your current throttle setting.

Handbrake (A)
The "A" key can be used as a handbrake to rapidly stop the train or to stop
loose wagons from rolling away.

Lights (L)
Activate the headlights by clicking on the "Light" button to the right
of the throttle control or pressing the "L" key.

Horn (H)
Press 'H' to operate the horn or click on the "Horn" button to the right
of the throttle control in the HUD. For long blasts of the horn, simply
hold the 'H' key down or Click LMB+H on the "Horn" button. Some

multi-tone horns only have a single blast pattern.

Bell (B)
Toggle the Bell on or off by pressing the 'B' key.



187

Commodities
An Interactive Industry can produce commodities, it can consume them or it
can do both.

An example of an Interactive Industry that only consumes commodities is the
Power Station. It consumes Coal.

An example of an Interactive Industry that only produces a commodity is the
Forestry industry. It produces Logs

An example of an Interactive Industry that both consumes and produces is the
Lumber Mill. It consumes Logs and produces Lumber and Wood Chips.

Below is a flow chart of the Interactive Industries (in rectangular boxes) and
the Commodities (in rounded boxes) included in TRS2006.

Tip: Further industries and commodities are available form 3rd Party
Content Creators via the Download Station.
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will be doing in this tutorial - other windows will pop-up along the way to
explain aspects of the tutorial and help you achieve the tutorial goals. Click
LMB on the green checkmark at the bottom right corner of these pop-up
window to proceed. The red arrows in the bottom left allow you to navigate
back to pages you have already seen if needed.

Once you have read through the introductory screens you will see a stationary
CN diesel locomotive. You are ready to roll…

Go through the tutorial to get a feel for bringing your railroad to life working
with interactive industries, operating turntables, coupling/de-coupling and
utilizing the power of Driver Commands.

Below we look at each of the aspects of the Driver Commands so use it as a
reference if you get lost during the tutorial.

12.11.3 Interactive Industries
Interactive Industries are scenery objects that produce/consume commodities
that are transported by rail. Your job is to get the right train with the right rolling
stock to the right industry for loading and then to move the commodities to the
right industry that consumes it.

Sound easy? Read on!
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Note: As new content is developed by the community we expect new
Commodities, Interactive Industries and Active Rolling Stock to
become available. The possibilities are endless with the open
architecture we have implemented in TRS2006. If you are interested
in creating your own Interactive Industry, Commodity or Active Rolling
Stock, please refer to the User Asset Creation Guide available from
the Trainz Launcher menu under Manuals.

Waybills
To help you out we've put in a waybill system that will tell you which Interactive
Industry requires what quantity of which Commodity. See section 12.8.1 on
Waybills to learn more about the Waybill system in TRS2006.

Industry Details
You can also get the details of what Commodity each Interactive Industry is
producing and how much so you'll know where to source Commodities to
complete your railroad's Waybill requirements. Click RMB on an Interactive
Industry to bring up a pop up menu. Click LMB on View Details to bring up a
window which describes the details of the type and quantity of each
commodity produced by that Industry.
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Active Rolling Stock
You also need to use the right rolling stock to move commodities around the
railroad. Older rolling stock, including some of the rolling stock included with
TRS2006 is not able to carry commodities, let's call them non-active rolling
stock. Of course TRS2006 also includes examples of rolling stock that are
capable of transporting Commodities, we'll call these active rolling stock.

Note: In the Surveyor Module active rolling stock and Interactive
Industries are denoted by a "Tick" in their 3D preview window. See
Chapter 11 - Sureveyor In Depth for details.

Active rolling stock may also have animations associated with them, so you
will see the wood chips being loaded or the panels on the hoppers open as the
coal is unloaded.

To find out the status of a piece of active rolling stock Click RMB on the rolling
stock and select View Details from the pop up menu.

See section 12.8.2 on Assigning Commodities to learn more about the
flexibility of the new active rolling stock and how to assign the match active
rolling stock to the appropriate commodity.
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Note: Some load/unload tracks may require the train to be fully
stationary for a length of time (eg: container car) while others will allow
loading/unloading "on the fly" (eg: coal car).

Special Industry - The Steam Filling Station
Because of their fuel capacity diesel locomotive fuel consumption is not
modeled in TRS2006. Similarly electric locomotives are also considered to
have infinite fuel (unless someone scripts a Rule that makes them dependent
on the Power Station operating!).

However the same cannot be said for Steam locomotives. From time to time
they will need to have their coal/oil and water replenished. Included with
TRS2006 is a Steam Filling Station that provides a steam locomotive with its
coal/oil and water requirements.

Treat the steam locomotive like a mini-industry that consumes coal/oil and
water. Check on its current stockpile of these Commodities by Click RMB on
the locomotive tender (or the locomotive if it does not have a tender) and Click
LMB on View Details. If they are running low you'll need to get the locomotive
to the Steam Filling Station to top up.

Note: Steam locomotives use coal/oil and water in both the DCC and
Cabin control modes.
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Some Interactive Industries also have one or more visual cues as to their
Commodity status. For example, the Coal Mine has piles of Coal that rise and
fall depending on production and Train loading respectively.

Note: The Power Station Industry details also indicate if the Power
Station is operating. This is important to know as a Power Station Rule
may be operating (see the World Builder Guide for more information
on Rules) which means other Interactive Industries are dependent on
the Power Station for electricity. No electricity, no production!

Loading and Unloading
Each Interactive Industry will have loading and/or unloading tracks depending
on whether it is a Commodity consumer, producer or both. These track
locations vary depending on industry, they are usually obvious or they may be
sign-posted. Some industries may load/unload different Commodities on
specific tracks, others use the same track for everything. 

Note: Some Interactive Industries have loading/unloading animation.

To successfully load/unload you will need to be at the right track, with the right
piece of active rolling stock and traveling at the right speed.
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Note: The Driver Commands available to a Driver are updated
continuously depending on the current activity the Driver is performing
and the Driver Commands activated for this Session (set in the
Surveyor Module).

Driver Commands are listed in the order they will be performed as icons along
the bottom of the screen to the right of the currently selected Driver. This
sequence of Driver Commands is known as a Schedule. As each command is
completed it is removed from the Schedule and the next command is
executed.

Note: If the Repeat Schedule command is added to the Schedule the
commands are no longer removed from the Schedule after they are
completed. Once the train has completed the last command before the
Repeat command it begins with the first (leftmost) command in the
Schedule again.

If the Driver list is visible, then to the right of the Driver icons will be an icon
which indicates which Driver Command they are currently performing.

Note: No icon, no Driver Command.

12.12.2 Driver Commands Guide
Now let's examine each of the Driver Commands included in TRS2006 and
what it does.

Note: Due to the open nature of the TRS2006's scripting and Rules it
is inevitable that new Driver Commands will be created by our talented
content creation community. If you are using 3rd Party generated
Driver Commands please refer to the documentation accompanying
them to determine their effect and operation.
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If a steam locomotive runs out of either coal or water it will no longer be able
to move. How embarrassing!

12.12 Driver Command Explanations
Not only can you issue orders to several Drivers at once (up to seven), you
can also give Drivers orders to accomplish tasks based on the Waybill list of
industry requirements at the same time. Once your orders are allocated, watch
as your railroad comes to life around you.

Note: You can only give Driver Commands to Drivers, you can't give
a Driver Command to a Driverless consist, whether it has a locomotive
attached or not.

12.12.1 Assigning Driver Commands
Click RMB on the picture of the Driver that you want to issue Driver commands
to or on his icon in the Driver list (see Section 12.5.4 for more information on
the Driver Selection panel). Click LMB on the Driver Command that you want
to add from the list that appears in the pop up menu.

If the Driver Command has sub-menus (eg: Load) indicated by a ">" to the
right of the Driver Command move the mouse cursor over the Driver
Command to make the sub menu appear. You may need to do this again if
there is a further sub-menu below this (eg: Load > Coal Mine > Loading Track
#1) before you Click LMB on the option you want.
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Note: If there was another Driver in the locomotive you have selected
the Driver to move to they will be bumped off the train as if they had
been given a Get Off Train command.

Both the driver's original train and his new train will stop by applying maximum
braking effort. All schedules are also cancelled as if each train had been given
an Adandon Schedule command.

Get Off Train
The Get off Train command is a default command. This command is used to
order a Driver to get off his current train immediately.

The train the Driver has just got off will stop by applying maximum braking
effort. The Driver will now be unassigned and available to be assigned to a
new train using the Move to Train command.

Notify
When the Notify command is activated, a message is added to the
Radio Message box. See section 12.5.11 for details on how to
access the Radio Message box.

Note: Use the Notify command when you want to be reminded that
you need to pay attention to the originating train. For example this may
be to give it some new commands or to switch some turnouts for the
next stage of its journey.

Couple
The Couple command has a sub-menu that lists all the available
rolling stock and locomotives on the Route that have an available
coupler that you can couple to. Click LMB on the locomotive or item

of rolling stock you want to couple to and the train will immediately try to find
a path to the selected item.
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Drive
The Drive command is a default command and is only available if the train is
stationary.

It immediately moves the train in its current forward direction as rapidly as
signals and speed limits allow. The manual DCC or Cab controls are disabled
and the Info Panel relating to them disappears from the HUD.

Note: Forward default forward direction of a consist is defined in
Surveyor. See section 11.11.2 for details.

Stop Train
The Stop Train command is a default command and is only available if the
Train is moving.

As its name suggests it will stop the train by applying maximum braking effort.
Once the train stops the manual DCC or Cab controls are enabled and the Info
Panel relating to them re-appears.

Change Direction
The Change Direction command is a default command and is only available if
the train is moving.

It stops the train by applying maximum braking effort and then starts it moving
in the opposite direction as rapidly as signals and speed limits allow.

Move To Train
The Move to Train command is a default command. This command is used to
order a Driver to get off his current train and move to another train or to assign
an unassigned Driver to a train. Once selected the mouse cursor will change
to a cross hair. Click LMB on another locomotive to move the Driver to his new
train.
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If it can't find a valid path to the item a Radio Message box will pop up
indicating the problem. Click LMB on the green radio tower button in the Radio
Message box or press the "Enter" key to close the Radio Message box.

If it can find a valid path the train will move to the selected item as rapidly as
signals and speed limits allow. The train will then stop if there are no further
commands.

Note: When searching for a valid path the AI will automatically switch
turnouts that have not been blocked by AI direction markers (see the
World Builder Guide for more information). When acting on a valid
path the AI will switch turnouts accordingly.

Drive To Trackmark
The Drive To Trackmark command has a sub-menu that lists all the
names of all Trackmarks on the Route. Click LMB on the name of the
Trackmark you want to move the train to and the train will

immediately try to find a path to the selected item.

If it can't find a valid path to the item a Radio Message box will pop up
indicating the problem.

If it can find a valid path the train will move to the selected Trackmark as
rapidly as signals and speed limits allow. The train will then stop if there are
no further commands.

Note: When searching for a valid path the AI will automatically switch
turnouts that have not been blocked by AI direction markers (see the
World Builder Guide for more information). When acting on a valid
path the AI will switch turnouts accordingly.
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If it can't find a valid path to the item a Radio Message box will pop up
indicating the problem. Click LMB on white microphone button as described in
section 12.5.11 to open the Radio Message box

If it can find a valid path the train will move to the selected item as rapidly as
signals and speed limits allow and couple to the item.

The train will then stop if there are no further commands.

Note: When searching for a valid path the AI will automatically switch
turnouts that have not been blocked by AI direction markers (see the
World Builder Guide for more information). When acting on a valid
path the AI will switch turnouts accordingly.

Decouple
The Decouple command has a sub-menu that lists all the
locomotives and rolling stock in the order they are arranged behind
the locomotive with the Driver. Click LMB on the locomotive or item

of rolling stock you want to decouple and the train will decouple such that the
selected item is now at the head of a new consist. Upon decoupling a Radio
Message box will pop up announcing that consist X has successfully
decoupled from consist Y.

Note: If the train was moving either under the Drive command or
manual control when you issue the Decouple order the train will first
come to a stop before it acts upon the Decouple command.

Drive To
The Drive To command has a 2 levels of sub-menus. The first sub-
menu lists the industries and stations that are available to Drive To
on the Route. The second sub-menu under the industry you select

lists the loading/unloading tracks for the chosen industry/station. Click LMB on
the loading/unloading track item for the industry/station and the train will
immediately try to find a path to the selected item.
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with suitable commodity) a Radio Message box will pop up indicating the
problem.

Note: If the industry doesn't have enough capacity to unload all of
the commodity from the cars of the train it will unload as much as it
can before moving on to the next command.

Wait For
The Wait For command has a sub-menu listing a range of times from
5 seconds to 1 hour. Click LMB on the required time you wish to wait
for before executing the next command in the schedule.

If you want the train to wait for a time not listed or for more than an hour you
can add more Wait For commands to achieve the desired delay.

Note: The time selected to wait for is in game time. This means that if
you have your game clock running at 60X normal time a 1 hour Wait
For command will take 1 minute of real time before it moves on to the
next command in the schedule.

Abandon Schedule
The Abandon Schedule command immediately deletes the current schedule of
commands and stops the train as if you had also given a Stop Train command.

Resume Schedule
The Resume Schedule command is used if the train has come to a halt for
whatever reason and still has commands to execute in its schedule that you
want it to resume.

Note: If the reason the train was halted has not been removed (eg: a
red signal) the train will not resume its schedule when given the
Resume Schedule command.
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Load
The Load command is usually given in schedule after a Drive To
command is issued to move the train to an industry loading track.

The train will follow normal loading procedures, either a slow drive by or
halting to take on the Commodity. If there are multiple items of rolling stock to
fill the train will fill all of them before completing the Load command.

If there are no further commands in the schedule the train will come to a stop
after loading.

If the Load command is given and the train is not at a valid loading track (ie:
Matched industry loading track commodity with empty active rolling stock
suitable for carrying the commodity) a Radio Message box will pop up
indicating the problem.

Note: If the industry doesn't have enough of the commodity to fill all of
your cars the train will load as much as it can before moving on to the
next command.

Unload
The Unload command is usually given in schedule after a Drive To
command is issued to move the train to an industry unloading track.

The train will follow normal unloading procedures, either a slow drive by or
halting to drop off the Commodity. If there are multiple items of rolling stock to
unload the train will unload all of them before completing the Unload
command.

If there are no further commands in the schedule the train will come to a stop
after unloading.

If the Unload command is given and the train is not at a valid unloading track
(ie: Matched industry unloading track commodity with active rolling stock laden
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12.13 Driving in Diesel/Electric Cabin Mode

12.13.1 Introduction
Diesel and Electric locomotives are similar enough in this simulation to group
together for the cab driving tutorial. Cabin Mode provides a more realistic
driving experience than DCC with more real world physics being employed.
For instance the simulation takes into account factors such as the different
power levels at each throttle notch and the length of the train when applying
the brakes. Each of the levers, switches and dials in the Cab View can be used
to operate the locos or you can use the HotKeys to carry out the same
function. (This lets you control the locos from outside the cab, even in Cabin
Mode).

12.13.2 The Diesel / Electric Cab Mode Tutorial
Go to the Driver main menu and Click LMB on the "Tutorial 3 - Diesel Cab"
Session for the route "City and Country USA 2". Then click LMB on the Green
Light labeled "Load" in the lower right hand corner of the screen. The program
loads in the route and session information for the tutorial and the session will
start.

An introduction to the tutorial comes up as a window and describes what you
will be doing in this tutorial - other windows will pop-up along the way to
explain aspects of the tutorial and help you achieve the tutorial goals. Click
LMB on the "X" in the top left of these pop-up windows to close them.

Once you have read through the introductory screens you will see a stationary
F7 diesel locomotive hitched up to an empty car coal consist. You are ready
to roll…

Go through the tutorial to get a feel for driving a train in Cabin mode.
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Repeat
The Repeat command is used to cycle the current schedule of commands
from start to finish over and over.

For example you may need to get a coal train to run continuously between a
Coal Mine and a Power Station to keep it operating. To your coal train you can
issue a Drive To > Coal Mine > Loading Track #1 command, followed by a
Load command, then a Drive To > Power Station > Coal Unload command,
then an Unload command and finally a Repeat command.

Note: You can add more commands after issuing a Repeat command.
These new commands will be inserted into the schedule immediately
before the Repeat command.

Cancel Repeat
The Cancel Repeat command removes the Repeat command at the end of the
schedule and thus the schedule will no longer be repeated. Commands will
removed from the schedule as they are completed.

Note: The Cancel Repeat command only appears on the Driver
Command list if there is a Repeat command in the schedule.
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Flow - Brake Pipe Flow
The Flow field displays the movement of air in the train Brake Pipe. It should
return to zero before attempting to move away from a standstill, as the
presence of brake pipe flow indicates that the brakes have not released on all
of the vehicles in the train. The time it takes to make a full service application
is dependant on the length of the train. The brakes will release on the forward
vehicles much more quickly than they will on vehicles at the rear. It may take
several minutes to release the brakes on a very long train after a full service
application. The Flow Gauge is the only true indication of system equilibrium
when viewing from the cab, as Brake Pipe Pressure is measured at the
locomotive.

If the flow gauge pointer is bouncing it means the brakes on the train are in the
process of applying or releasing, avoid heavy acceleration during this time.

Brake Pipe - Brake Pipe Pressure
The Brake Pipe field displays the pressure in the Brake Pipes. Flexible hoses
connect the Brake pipe or Train Pipe between vehicles along the length of the
train. Pressure changes required to control the braking are relayed from
vehicle to vehicle via this pipe. The Train Pipe is fed by the Main reservoir. The
maximum pressure is generally prescribed by the Railway's administration
and is maintained by a feed valve. Over use of the airbrakes over a long
descent can deplete the air in each vehicle's auxiliary reservoir more rapidly
than the brake pipe can recharge them resulting in runaways.

A fully pressurized brake pipe results in brake release.

Brake Cylinder
The Brake Cylinder field displays the pressure in the Brake Cylinders of the
currently selected locomotive/car. Each car is fitted with one or more brake
cylinders. A piston inside the cylinder moves as a result of pressure changes
in the train pipe. The piston's force is transmitted via rigging to brake blocks or
discs at the wheels. Since a pressurized cylinder results in brake application,
a reading of 0 Brake Cylinder pressure indicates that the brakes are released
on the locomotive. The Brake Pipe Flow Gauge and the Train Pipe Pressure
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12.13.3 The Driver HUD
The Current Speed and Speed Limit panel remains 
but you will notice that the DCC Control panel has
been replaced by the Diesel Cab Info panel. This
panel contains all the critical information for
monitoring what the locomotive of your currently
selected train is doing.

Note: If the currently selected train has Driver
Commands in progress the Diesel Cab Info
Panel on the HUD is no longer visible and the
train is not manually controllable. To regain
manual control Click RMB on the driver and
select "Abandon Schedule", "Get off Train", "Move to Train" or "Stop
Train" from the pop-up Driver Command Menu. See section 12.12.2
on Driver Commands for further information.

We will go through each of these items individually before looking at the
individual commands for controlling a diesel/electric locomotive in the Cab
Mode.

Train Braking System Overview
The Westinghouse or 'Automatic' airbrake is the standard braking system
used by TRS2006. It was introduced in 1869, and has endured with essentially
little modification to the present day.

TRS2006 currently considers all the vehicles in a consist to be fitted with
Westinghouse equipment regardless of era or region. The system is based on
a pressurized air pipe connected to reservoirs on all the vehicles in the train.

Simply put a pressure reduction in the pipe results in airbrake application.
When the brake pipe is pressurized or "charged", the Westinghouse is
considered a "failsafe" system. This means that a brake application can be
actuated by anything from an emergency application on a loco, passenger car
or guard's van, a burst hose, a derailment or an otherwise parted train.
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the direction of travel.

Brake - Stopping or Going
The Brake field displays the current application of brakes. The train brake can
have the following settings: Release, Lap, Application, Emergency and Handle
Off.

12.13.4 Diesel Electric Cabin Mode Controls
To control a locomotive in Cab Mode you can either manipulate the various
buttons, levers and dials in the Cab View (1) with the mouse or you can utilize
the keyboard shortcuts. Because different trains may have unique cab layouts
we will be focusing on the keyboard shortcuts.

If you want to operate the Cabin controls directly in Cab View you can do so
by moving the mouse over the various controls and viewing the tooltip
describing the control. Then Click LMB+H and move the control into the
appropriate position. We will be noting the tooltip text so you can relate it to an
explanation of the keyboard controls.
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Gauge are the driver's means of estimating brake cylinder pressure at the rear
of a train.

If there is any brake cylinder pressure showing on the gauge or HUD, the
brakes have applied on the vehicle you have selected. By selecting a vehicle
toward the rear of a long train, you can see how much longer it takes for the
brakes to apply at the back of the train.

Main Res - Main Reservoir
The Main Res field displays the pressure in the Main Reservoir. This is a
storage tank for compressed air used by the braking and some auxiliary
systems. It is fed by a compressor.

Equalizer - Equalizing Reservoir
The Equalizer field displays the pressure in the Equalizing Reservoir. The
Equalizing Reservoir overcomes the difficulty of setting the brakes to a desired
level on a long train. Small changes in train pipe pressure made by the driver
will not display correctly on the gauge until the pressure has stabilized along
the length of the train, as brake pipe pressure is measured at the locomotive.
When applying the brakes, air will vent from the Equalizing Reservoir and it's
rate is not affected by the length of the train. A relay valve detects pressure
reduction and discharges air from the brake pipe until it's pressure is the same
as that of the equalizing reservoir. This serves as a guide for the driver as to
the pressure the train pipe will settle at, and thus how hard the brakes will
apply. Watch the equalizing reservoir when making a brake application to
gauge how hard the brakes will be applied.

Throttle - Notch Setting
The Throttle field displays the current throttle notch setting which can range
from 0 (no application of tractive effort) to 8 (maximum application of tractive
effort).

Reverser - Which Way
The Reverser field displays the Reverser setting. The Diesel/Electric Reverser
has 3 positions; Forward, Reverse and Neutral. As it suggests it determines
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Application (A)
Select the Application setting by moving the trainbrakelap lever into the
"Application" position or by pressing the "Z" key.

This shuts off main reservoir connection and opens the train pipe to the
atmosphere. The resulting reduction in train pipe pressure causes the brakes
to apply. A full application or "equalization of pressures" occurs at 64-psi for a
90-psi train pipe such as that in use on the F7 diesel.

Air vents out of the equalizing reservoir, and its gauge provides a guide as to
the amount of reduction being made. The flow of air must be lapped off at the
desired pressure by moving the brake handle to the lap position.

Gradually the Brake Pipe pressure will stabilize at the same pressure as the
equalizing reservoir. A heavy freight train can generally be slowed by a Brake
Pipe reduction of 10-psi, a fast moving passenger train can require heavier
reductions of up to 30-psi.

The brakes of a long train will take more time to react, as changes in pressure
must be transmitted by the train pipe to every vehicle in the consist. The
brakes will be held at this level until the handle is moved to the release/run
position, when air will flow from the main reservoir into the brake pipe and the
brakes will gradually release. The flow gauge serves as a guide to air
movement within the Brake Pipe, a reading above zero indicates that the
brakes are either in the process of application or release or are otherwise
venting air somewhere in the consist.

Note: Use the 'A' key to apply handbrakes to consists without
locomotives to prevent them from rolling away.

Emergency Brake (Pause Break)
Select the Emergency setting by moving the trainbrakelap lever into the
"Emergency" position or by pressing the "PauseBreak" key.

Like the service position, this allows air to escape into the atmosphere, though
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Train Brakes (Q/Z/A/Pause Break)
The tooltip text in the Cab View for the Train Brake is "trainbrakelap lever".

Release (Q)
Select the Release setting by moving the trainbrakelap lever into the
"Release" position or by pressing the "Q" key.

In this position it connects the train pipe to the main reservoir, raising pressure
in the pipe and thus releasing the brakes. While motoring it gently maintains
brake pipe pressure to counteract any leaks in the system.

Leave the handle in the Run/Release position while motoring.

Lap (Z)
Select the Lap setting by moving the trainbrakelap lever into the "Lap" position
or by pressing the "Z" key.

This shuts off the flow of air from the main reservoir into the train pipe, and
closes the connection to the atmosphere that is made during a brake
application. It can be used to make a partial application, and TRS2006 also
permits a partial release both on Freight and Passenger trains.

Watch the equalizing reservoir when making a service, and when its pressure
has decreased by 10-30 psi, move the handle to the lap position.

Modern locomotives are fitted with self-lapping brake systems, which shut off
the flow of air automatically when a reduction is made. To make an application
on self-lapping systems, simply move the handle into the initial service
position, the brakes will be held at that level until they are released. Greater
braking effort can be achieved by moving the handle further into the braking
range.

On self-lapping systems, simply move the handle to the initial service position
and leave it there. If braking is insufficient, move the handle further into the
braking range.
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away" from the rest of the train. This stretches the train to the limits of the
couplers and reduces strain.

Reverser (F/R/V)
The tooltip text in the Cab View for the Reverser is "reverser lever". The
Reverser has three settings: Forward, Reverse and Neutral. You select the
Forward setting by moving the reverser lever into the Forward position or by
press the "F" key. Select the Reverse setting by moving the reverser lever into
the Reverse position or by pressing the "R" key. The Neutral setting is selected
by moving the reverser lever into the Neutral position or by pressing the "V"
key.

As the settings indicate, the Reverser position determines the direction the
train will travel relative to the cab with the driver. This is important to remember
in dual cab locomotives.

The Neutral position disengages any tractive effort regardless of throttle
setting. The locomotive should always be stopped before changing the
reverser setting to the opposite direction.

Note: You cannot change the position of the Reverser unless the
Throttle is at the idle position.

Throttle (W/S/X)
The tooltip text in the Cab View for the Throttle is "throttle lever". In Cab View
select the required Throttle setting by moving the throttle lever to the required
notch position (0 = no tractive effort, 8 = maximum tractive effort).

When using the keyboard press the "W" key to increase the Throttle one notch
position, while the "X" key to reduces the Throttle one notch position and the
"S" key immediately sets the Throttle notch position to zero.

Correct use of the throttle depends on various factors such as the type of
locomotive, the weight and length of the train, the severity of grades and
weather conditions. The variety of operating conditions cannot be discussed
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the air is vented from the system more rapidly so the train will stop more
quickly.

Independent Brake (E/D)
The Independent Brake as the name suggests is independent of the main train
braking system. It is used to apply braking force only on the selected
locomotive.

Note: Not all locomotives have an independent braking system. The
tooltip text in the Cab View for the Independent Brake is
"independentbrake lever".

Independent Brake (E)
In Cab View the independent brake lever has a continuous range from fully off
(red range) to fully on (green range). Set the Independent Brake by moving the
independentbrake lever across this range.

In keyboard control mode the Independent Brake is set by pressing the "E"
key. However, this only toggles the Independent Brake between being fully on
or fully off.

Application of the Independent brake takes some pressure away from the
Main Reservoir and the Brake Cylinder pressure will rise. Remember this only
applies to the locomotive and not the rest of the train.

Independent Brake Bail (D)
The Independent Brake Bail can only be operated from the keyboard by
pressing the "D" key. It immediately vents only the locomotive brake cylinder
without affecting the braking effort on the rest of the train.

If the Train Brake or the Independent Brake is applied when you use the
Independent Brake Bail the locomotive Brake Cylinder will fill again with air
and rise in pressure.

This is mainly used to "stretch" the train by allowing the locomotive to "run
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idle before allowing traction motor voltage to decay. Pressing the "S" key
returns the throttle to 0, but it is only intended for emergency use, as such
sudden changes in power propagate a wave motion throughout the train. This
kind of surge increases the risk of drawbar or coupler failure, along with
possible damage to loads or a very uncomfortable ride for your passengers.

Avoid heavy handed use of the throttle, sudden changes in force send surges
along the train.

Dynamic Brake (C)
The tooltip text in the Cab View for the Dynamic Brake is "dynamicbrake
lever". To activate the Dynamic Brake, ensure the Throttle is set to the Neutral
position, then move the dynamicbrake lever fully into the green range or press
the 'C' key. The throttle lever and corresponding keys are now used to control
braking effort.

To deactivate the Dynamic Brake move the throttle lever to the 0 notch setting
or press the 'S' key. Then move the dynamicbrake lever fully into the red range
or press the 'C' key. The Dynamic brake is now inactive and the Throttle will
once more control tractive effort.

The Dynamic Brake is a means of reducing locomotive speed by an electrical
system, which converts the traction motors into generators. The operation and
effect of this system applies braking power only to the locomotive(s). Power
required to rotate the generators through gearing on the wheels and axles,
retards the locomotive's travel. Current generated by the traction motors is
dissipated in resistance grids located in the engine hood of the locomotive.
The grids are cooled by motor driven fans that are powered by a portion of the
current generated.

Although similar in effect to an independent air-brake application, Dynamic
Brake is fully electrical; it does not produce friction between brake shoes and
tires, thus avoiding heat and wear on these parts. The load indicating meter
shows the current generated by the traction motors and may be compared in
effect, with a brake-cylinder pressure gauge.
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in the context of this manual, and generalized operating instructions are
therefore provided.

For each throttle position, a definite maximum load current and corresponding
tractive effort may be developed. The increase as the throttle is moved from
one position to the next is immediate. Since the total tractive effort of the
locomotive is divided into eight steps available at the eight throttle notches, it
is necessary to advance all the way into the last notch in order to develop full
tractive power. Further, since the current is controlled, it is perfectly safe to do
so, in fact it is often necessary under certain conditions.

The load indicating meter or Ammeter provides the best guide for throttle
handling when accelerating a train. By observing this meter, it will be noted
that the pointer moves to the right (increased amperage) as the throttle is
advanced. Thus for maximum acceleration without slipping, the throttle should
be advanced one notch each time the pointer begins moving back toward the
left, until full power is reached in notch 8.

It is well understood that the worst treatment that can be given to a traction
motor is to allow it to stand at "stall" for any appreciable length of time with
load current applied to it. It is therefore most important, having given due care
to ensure that the brakes are released, and that the train slack is out, to start
the locomotive to move as quickly as possible, accelerating to a speed that will
bring the load meter pointer down in a minimum of time.

When starting off, it is good practice to advance the throttle promptly to a notch
that will start the train moving. If after starting, acceleration is too fast, you can
back off the throttle once all the slack is out, in order to maintain desired
speed. Once the slack has run out, the throttle may be advanced as desired
to suit operating conditions and the needs of the schedule. It is good practice
to hesitate at each notch position, to allow the engine to come up to the new
run speed, and to prevent slipping.

When decelerating, it is also important to consider the action of slack running
in and out on the train. Always avoid reducing the throttle from high power to
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has multiple pantographs subsequent key presses will raise them individually
or together before cycling back to all down.

Note: Only electrical locomotives will have pantographs and hence
pantograph switches.

12.13.5 General Diesel/Electric Train Operating Principles

Grades
When starting to climb a hill, the locomotive and train will slow down, and the
increased load will be indicated by the load meter pointer moving toward the
right.

When traveling down a hill, due care may be required to keep your train under
control. When making a long descent, keep in mind that several successive
brake applications and releases can result in depletion of the system, and it's
therefore sometimes necessary to plan your approach to braking. It may be
necessary to set a constant partial application to control your speed.

Many locomotives are fitted with dynamic brake, which may be used in
conjunction with the train brake to control speed when descending a grade.
When descending a long grade, try to estimate how much braking is required
to keep the train moving under controlled speed. It's safer to make an
application that may initially slow the train more than desired, than it is to make
several successive applications and releases.

Operating Over Crossings
The severe mechanical shocks encountered by the traction motors when
passing over crossings and station yards, may cause the brushes to bounce
and flashover the motors.

At speeds above 40 mph, reduce the throttle to fifth notch position or below
while all units are passing over the crossing. This is not necessary at low
speeds. It is also recommended during dynamic braking at high speeds for the
same reason. This procedure will ensure decay of motor and generator
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Dynamic braking is valuable in many phases of locomotive operation. It is
particularly valuable when descending grades, though it can effectively be
used to retard train speed while coming to a halt if desired (10 mph minimum),
reducing the necessity for air brake.

Advance cautiously through the braking range until desired braking effort has
been reached. The amount of braking strength available varies with train
speed, and with the throttle in notch 8 continues to rise, as the speed
decreases until reaching its maximum value at around 20 mph. It is
permissible to start from a standstill on a downgrade with Dynamic Brake
applied.

When braking a heavy train on a severe grade, the maximum available
braking effort may not be sufficient to maintain desired speed. An application
of the Train Brake may be used in addition to the Dynamic Brake, in order to
maintain permissible track speed.

Lights (L)
The tooltip text in the Cab View for the Lights is "light switch". Toggle the
headlights on or off by moving the light switch or by pressing the "L" key.

Horn (H)
The tooltip text in the Cab View for the Horn is "horn lever". To operate the
horn move the horn lever or press the "H" key to operate the horn. For long
blasts of the horn, simply hold the horn lever or 'H' key down. Some multi-tone
horns only have a single blast pattern.

Bell (B)
The tooltip text in the Cab View for the bell is "bell switch". Toggle the Bell on
or off by moving the bell switch or by pressing the "B" key.

Pantographs (Keypad 1)
The tooltip text in the Cab View for the Pantographs is "pantograph switch".
Activate the Pantographs on your locomotive by moving the pantograph
switch to its various positions or press the "Keypad 1" key. If the locomotive
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LMB on the green checkmark in the bottom right corner of these pop-up
windows to proceed.

Once you have read through the introductory screens you will see a stationary
Queensland Railways PB15 steam locomotive ready to roll…

Go through the tutorial to get a feel for driving a train in Cabin mode.

Below we look at each of the aspects of the Cabin mode of operation, so use
it as a reference if you get lost during the tutorial.

12.14.3 The Steam HUD
In some respects the Steam Cab HUD Panel is
similar to the Diesel/Electric HUD Panel in terms of
the fields that monitor Train Brake readings. You will
of course note that there are no Throttle or Reverser
fields, these have been replaced by the Regulator
and Cutoff. In addition you have the Boiler and
Water fields which monitor your current steam-
making capacity.

Note: If the currently selected train has Driver
Commands in progress the Steam Cab Info
Panel on the HUD is no longer visible and the
train is not manually controllable. To regain manual control Click RMB
on the driver and select "Abandon Schedule" or "Stop Train" from the
pop-up Driver Command Menu.

Let's go through each of these items individually before looking at the
individual commands for controlling a steam locomotive in the Cab Mode.

Note: Only steam specific HUD items that differ from those of
diesel/electric locos will be listed here. See section 12.13.3 for details
on HUD items that are generic to both diesel/electric and steam locos.
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voltage to a safe level before the shock occurs.

Running Through Water
Under ABSOLUTELY NO CIRCUMSTANCES should any locomotive be
operated through water deep enough to contact the bottom of the traction
motors.

Water any deeper than 3 inches above rail level is likely to cause damage to
the traction motors. Every precaution should be exercised under
circumstances of water over track, and speed should not exceed 2 mph in
such conditions.

Auran cannot accept responsibility for damage caused by attempting to
operate your Trainz in sub-marine environments.

12.14 Up to Another Challenge? - Driving in Steam Cabin Mode

12.14.1 Introduction
So you want to get one of the steam-powered behemoths from yesteryear
moving? Controlling a steam engine is quite different from a diesel or electric
engine. Forget about dynamic brakes and "notch" throttle settings, these
machines use steam regulation as the method of control. Of course you still
have the train brake, but the regulator/reverser are the combined
throttle/power settings and balancing these and maintaining your steam is the
art of steam engine driving.

12.14.2 The Steam Cab Mode Tutorial
Go to the Driver main menu and Click LMB on the "Tutorial 3 - Steam" session
from the route "Outback Australia 2". Then Click LMB on the Green Light
labeled "Load" in the lower right hand corner of the screen. The program loads
in the route and session information for the tutorial and the session will start.

An introduction to the tutorial comes up as a window and describes what you
will be doing in this tutorial - other windows will pop-up along the way to
explain aspects of the tutorial and help you achieve the tutorial goals. Click
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Together the Reverser (or Cutoff setting) and the Regulator act as the Train's
throttle.

Cutoff - How Much Steam?
The Cutoff field displays the percent cutoff as dictated by the position of the
Reverser lever (sometimes known as a Johnson Bar) is expressed as a
percentage (minus 75% to plus 75%). Negative values indicate the valve gear
has been set to move the locomotive in reverse.

The higher the Cutoff value the greater the duration of steam application to
each piston stroke.

Long cutoff, represented by higher percentage values (40 to 75%) for the
cutoff, maximize the tractive effort applied to the locomotive wheels. This is
mainly used to get the locomotive moving from a standstill or when tackling an
ascent.

Short cutoff, represented by lower percentage values (less than 40%) for the
cutoff, are used to maximize the speed attainable by the locomotive during
easy sections of the route and where speed restrictions permit.

Water - Nearly Steam
The Water field displays the percentage of the boiler filled with water. The
water level should be maintained at around 66% as a hot fire without much
water is a potentially catastrophic situation. The steam pressure in the boiler
may rise faster than the safety valves can cope and…well you just don't want
to go there!

The injectors allow water to move from the tender (or engine mounted water
tank) to the boiler. Moving the water into the boiler can also be used to reduce
the rate of pressure increase in the boiler as the thermal energy of the fire is
now being used to heat the incoming cool water.
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Boiler - Under Pressure
The Boiler field measures the current steam pressure in the boiler.

The steam pressure in the boiler is dependent on a number of factors and
maintaining a head of steam is one of the challenges in running a steam
locomotive.

Of course driving the locomotive uses up steam and reduces the boiler
pressure. See Section 12.15 on General Steam Driving Principles to learn how
to drive a steam locomotive with an eye to maintaining your head of steam.

When the nominal boiler pressure is exceeded, Safety Valves lift to vent
excess pressure to the atmosphere. A good crew will avoid this waste of steam
and fuel by striking a good balance between the temperature of the fire, the
pressure in the boiler, and the conditions of the road ahead. When
approaching a heavy ascent for example, a hot fire will be required to maintain
adequate steam pressure. Conversely when approaching an easy section with
a hot fire, the rate of pressure increase in the boiler can be eased to prevent
lifting safety valves by adding more water to the boiler, or indeed more coal if
there is hard work to do up ahead.

Note: Nominal Boiler Pressure is different for each locomotive type.

Note: Take care not to add excessive coal, as this will lower the
temperature of the fire for a time. A great rule of thumb is "a little coal
often", try between 2-4 shovels every kilometer (that's 3-6 shovels
every mile).

Regulator - Give Me Steam!
The Regulator field displays the current position of your regulator the range of
values is expressed as a percentage (0-100%).

The Regulator in conjunction with the Reverser setting determines how much
and at what portion of the piston stroke that steam is sent to the cylinder.
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See Section 12.15 on General Steam Train Operating Principles for more
information.

Regulator (W/X)
The tooltip text in the Cab View for the Regulator is "regulator lever". In Cab
View select the required Regulator setting by moving the regulator lever to the
required position (0 to 100%) or pressing the "W" key to increase or "X" to
decrese.

Fireman (Space)
To maintain your steam you need to ensure you have a fire in the firebox
sufficient to maintain boiler pressure. As the fire burns it consumes fuel (coal
or oil). To stoke the fire by adding fuel, press the 'Space' key. In some
locomotives you will see an animated fireman actually shoveling coal - make
sure you have opened the firebox door with your mouse in Cab View or your
fireman will not go to work. As the fire is stoked it burns hotter (red is a cool
fire, white is a hot fire) and starts to raise the boiler pressure.

Lights (L)
The tooltip text in the Cab View for the Lights is "light switch". Toggle the
headlights on or off by moving the light switch or by pressing the "L" key.

Whistle (H)
The tooltip text in the Cab View for the Whistle is "whistle lever". To operate
the whistle move the whistle lever or press the "H" key to operate the whistle.
For long blasts of the whistle, simply hold the whistle lever or "H" key down.
Some multi-tone whistles only have a single blast pattern.

Bell (B)
The tooltip text in the Cab View for the bell is "bell switch". Toggle the Bell on
or off by moving the bell switch or by pressing the "B" key.
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12.14.4 Steam Cab Controls
To control a locomotive in Cab Mode you can either manipulate the various
buttons, levers and dials in the Cab View (1) with the mouse or you can utilize
the keyboard shortcuts. Because different locomotives may have unique cab
layouts we will be focusing on the keyboard shortcuts.

If you want to operate the Cabin controls directly in Cab View you can do so
by moving the mouse over the various controls and viewing the tooltip
describing the control. Then Click LMB+H and move the control into the
appropriate position. We will be noting the tooltip text so you can relate it to an
explanation of the keyboard controls.

Note: If you are operating a multi-steam locomotive consist you will
need to control each locomotive individually in Cab Control mode. Try
a triple header and see if you can keep up with the task!

Note: Only steam specific controls that differ from diesel/electric locos
will be listed here. See section 12.13.4 for details on cab controls that
are generic to both diesel/electric and steam locos.

Reverser (F/R)
The tooltip text in the Cab View for the Reverser is "reverser lever". The
reverser determines the steam Cutoff and has a range of -75% to +75%.
Negative values indicate the valve gear has been set to select reverse
movement, conversely positive values set the valve gear to select forward
movement. The neutral or mid-gear position (0% cutoff) prevents any tractive
effort being applied to the locomotive wheels.

You adjust the reverser setting by moving the reverser lever either
forwards/backwards or by pressing the 'F'/'R' keys. The Neutral setting is
selected by moving the reverser lever into the Neutral position.

Note: The Reverser is sometimes known as the Johnson Bar.
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rates depending on the speed of the engine and how hard it is working which
can vary dramatically with grades.

A second system is often available on engines for pumping water into the
boiler. These are axle driven water pumps. They pump at a rate governed by
how fast the axles are turning which in turn is governed by the speed of the
train. Obviously they are no help when you are stopped. But when you are
running they can be used to continually feed water into the boiler. How do you
adjust the feed rate when you cannot adjust the speed of an axle driven
pump? The Bypass Valve is adjusted for this purpose. This valve adjusts how
much of the water from the axle pumps is simply bypassed back into the
tender and how much goes to the boiler. So the bypass valve also needs
attention as you are driving.

On some locomotives, there are steam driven water pumps that provide yet
another way of pumping water into the boiler.

Another key control valve on the backhead is the Blower Valve. The Blower
Valve is used to control a jet of steam that is blown up the middle of the
chimney in the smoke box at the front of the steam engine. It accelerates the
flow of air through the chimney pulling a strong draft through the firebox to
keep the fires burning strongly. When the engine is moving the exhausting of
the steam used in the cylinders that drive the train provide a good draft. But
when the train is stopped or if you fire is not burning as hot as you would like,
it is wise to open up the blower to maintain this draft through the fire.

12.15.2 Reverser & Regulator
The Steam Reverser Handle (also called a Johnson Bar or Steam Cutoff) has
multiple positions and adjusts the steam locomotive's valve gear in such a way
that the pistons drive the driving wheels in the appropriate directions. In the
center or neutral position, no tractive effort will be developed by opening the
throttle.

When first starting a steam engine, place the Reverser Handle in the full
forward position. Once the consist is moving forward at a constant speed,
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12.15 General Steam Train Operating Principles

12.15.1 Making Steam - Fire & Water

Note: Not all of these functions are currently implemented so that they
may be controlled on steam engines in TRS2006.

A Steam Engine needs a full head of steam to operate effectively. To generate
the steam you build a fire in the firebox by shoveling coal through the firebox
door found in the middle of the backhead. The backhead is that part of the
boiler that makes up most of the front of the cab of the locomotive.

You must also have the boiler filled up appropriately with water. A hot fire and
an empty boiler is a catastrophic situation. Maintaining the water level in the
boiler is of great concern. The water glass in the engine shows you the level
of water in the boiler. Try and keep it at about 2/3 of the way up the glass.

When the session begins the light-up crew has already got your boiler up to
pressure and your water levels will be good to go.

While standing in the station or otherwise stopped, you may use the steam
available in the boiler to add more water to the boiler. To do this, you adjust
the valve on the backhead that controls the provision of steam into the Steam
Injector. The Steam Injector is a precision piece of equipment which uses a
venturi system to use high pressure steam to push water form the tender into
the boiler under pressure through a check valve which only allows water into
the boiler if the pressure behind the water exceeds the pressure in the boiler.
Use the Steam Injector to bring the water level up to the right level and then
turn it off.

Once the train is moving, the Steam Injector can be set carefully to just the
right setting so that the amount of water entering the boiler matches that being
used up as the steam is used to drive the train. If you have equilibrium here,
the water level will be maintained at a given level. But as an engineer, you
must continually adjust the flow of water as steam will be used up at different
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12.15.3 Cylinder Cocks
When first starting up an engine with cold cylinders, water condenses quickly
in the cylinder as steam is introduced. Excess water in the cylinders is not
compressible and the cylinders can be badly damaged. Relief valves called
Cylinder Cocks are provided on the cylinders to let the water escape easily.
Always start an engine with the cylinder cocks open using the Cylinder Cock
Valve on the backhead. After the engine has traveled a short distance, close
the valve to cease the release of steam through these valves.

When a steam engine is brought to a stop, the valves should be open once
more before resuming the above cycle.

12.15.4 Grades
Naturally gradients also affect the train so keep an eye on your speed and
adjust the Cutoff/Regulator accordingly. On a positive gradient (uphill) you will
begin to lose momentum, so you might need to lengthen the cutoff to say 40%.
This is where it is important to maintain your boiler pressure as a longer cutoff
consumes more of your steam.

If you are on a negative gradient (downhill) you may want to coast by reducing
the Regulator to 0%, leaving the Cutoff at 20% and then touching the brakes
to keep to the speed limit.

Note: When traveling down a hill, due care may be required to keep
your train under control. When making a long descent, keep in mind
that several successive brake applications and releases can result in
depletion of the system, and it's therefore sometimes necessary to
plan your approach to braking. It may be necessary to set a constant
partial application to control your speed.
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bring the Reverser Handle back towards the short cutoff position, thus
adjusting the valve gear appropriately for most efficient operation to preserve
your use of coal and water. Move the Reverser Handle forward into the high
cutoff range when accelerating or climbing grades.

The Reverser is used with the Regulator to control a combination of speed and
tractive effort.

Correct use of the Regulator depends on various factors such as the type of
locomotive, the weight and length of the train, the severity of grades and
weather conditions. The variety of operating conditions cannot be discussed
in the context of this manual, and generalized operating instructions are
therefore provided.

Opening the Regulator on a steam engine delivers steam to the valves which
govern the distribution of the steam to the main cylinders which in turn drive
the driving wheels through the main rods on each side of the engine.

When starting off, it is good practice to advance the Regulator very gently. The
finest of steam era engineers started their trains so smoothly that passengers
hardly noticed that they were moving. It is also important to pick up the slack
in all of the couplers in along train. Once the slack has run out, the Regulator
may be advanced as desired to suit operating conditions and the needs of the
schedule. Steam engines are notorious for the ease with which you can get
wheel slippage, which is quite a spectacular site to watch. To avoid slippage,
start gently and do use the sanders if conditions warrant. Sanders deposit
sand just in front of the driving wheels to improve traction.

When decelerating, it is also important to consider the action of slack running
in and out on the train. Always avoid reducing the Regulator quickly. Sudden
changes in power propagate a wave motion throughout the train. This kind of
surge increases the risk of drawbar or coupler failure, along with possible
damage to loads or a very uncomfortable ride for your passengers.
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12.16 Cab Controls HUD
A new feature to TRS2006 is an on screen graphical representation of the
Raildriver Cab Controller. By no means a replacement for the real thing, it
allows you to drive a train under cab controls without having to remember all
the keyboard controls.

The Cab Controls HUD is accessible through the Cab Controls HUD rule. For
the HUD to appear, the rule must be added to the session and configured to
"Show" the HUD. When the session starts and runs the rule, the Cab Controls
HUD appears below the Cabin Controls at the right side of the screen and has
has five vertical levers.

From left to right the five levers are Reverser, Throttle/Regulator, Dynamic
Brake, Brake and Indendent Brake. See sections 12.13 and 12.14 for details
on how these settings affect diesels/electrics and steam locomotives
respectively.

Note: The Cab Controls HUD will not appear unless your session is in
Cabin Control Mode.
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Note: When descending a long grade, try to estimate how much
braking is required to keep the train moving under controlled speed.
It's safer to make an application that may initially slow the train more
than desired, than it is to make several successive applications and
releases.

12.15.5 Wheelslip
For various reasons, the locomotive may break traction which may occur
during motoring or braking. Possible causes of wheel-slip are many, ranging
from bad weather, to leaves on the rails.

Sand is used to control wheelslip. It is poured onto the track via pipes which
open ahead of the driving wheels increasing the friction between the steel
wheels and the steel rails. It will often be necessary to reduce power in order
to regain traction once wheel-slip has begun. This sanding system can be
activated by moving the appropriate lever in the cab View or can be toggled
on and off by pressing "V" . If the wheel slip is light reduce the Regulator, apply
sand and advance the Regulator again.
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13.2 Playing With Rollingstock
Click LMB on any entry and the selected engine or rollingstock item appears.
Click LMB, RMB+H and roll you mouse forward or back to zoom in or out. Click
RMB+H and roll it from side to side to rotate the camera around the asset to
see all sides of it.

Rotating
You can Click LMB+H on either of the circular arrows in the
lower right hand corner to have the asset rotate without you

moving the mouse.

Zooming
Click LMB+H on either the "+" or "-" in the lower left corner to
zoom in or out.

Horn/Whistle
If the asset you are viewing is a locomotive you can hear its horn/whistle
by Click LMB on the "Horn" icon. Alternatively, press the "H" key.
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13 - Railyard

13.1 Introduction
Railyard allows you to examine each of the engines and rolling stock assets in
your collection in detail and discover the background and specifications of
each item.

From the TRS2006 main menu Click LMB on the button next to "Railyard" or
by pressing the "R" key and the Railyard screen will load.

The Railyard screen is where you can find out more about your locomotive and
rolling stock assets. Your collection appears in a list on the right hand side of
the screen and includes any custom content that you have downloaded. 
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revealing more information about each item in the list. Click LMB again on the
"Info" button to make the info panel disappear and be replaced by the asset
list.

Note: Some assets have no information, in that case the Info panel will
be blank.

Beside each item in the list is a red button. Click LMB on the red button to flag
that the selected item should be in a list of your favorites. Click LMB on a few
more. Then Click LMB on the Favorites button to sort the list with your
favorites at the top. By developing a Favorites list here, you will be able to use
the Favorites list instead of the longer list when you assign locos and items of
rolling stock to consists later in Surveyor.

To see more categories for your assets, Click LMB the left pointing red
arrowhead at the bottom of the asset list. The asset list moves to the left
exposing the extra categories which are Origin and Company.

Origin is usually a country like UK, USA or AUS. Company is the Railroad
Company that the asset belongs to. You can sort your assets alphabetically by
Origin or Company by Click LMB on the heading.
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Light
The light is toggled by Click LMB on the "Lights" icon. Alternatively,
press the "L" key to toggle the light.

Pantographs
If the asset you are viewing is an electric locmotive with pantographs,
you can activate the pantograph animation by Click LMB on the

"Pantograph" button. Alternatively, press the "P" key to animate the
pantographs.

Navigating the Collection
Click LMB on the areas above or below the red ball on the vertical bar at the
right of the screen to move the list up or down.

Click LMB on the Info button to replace the list of assets with a display of
information about the requested item.

Click on the List button to return to the list.

Click on the Toggle Info Red Arrow in the lower right to shift the list to the left
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14 - Trainz Exchange

This is the Trainz mini-browser designed to showcase the latest content,
events and updates in the world of Trainz.

By registering with Planet Auran and logging on to the Internet, you will find
tons of new information uploaded here on a regular basis. What is in the box
is really only the beginning of your enjoyment with Trainz.

Content and information displayed in this window is updated and varies.

You can even download the latest assets directly from links in Trainz
Exchange wihtout have to exit Trainz.

Note: Details on registering with Planet Auran can be found in section
7.1 of this manual.
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Note: If you have the "Favorites" button selected you can still sort your
favourite assets by Name, Origin or Company.

To hide the extra categories Click LMB on the right pointing arrowhead at the
bottom of the asset list.

To leave the Railyard, Click LMB on the "Main Menu" button at the bottom left
of the screen.

Tip: Your selection of favorites can be displayed in Surveyor in the
Trainz Menu. Click on the Red Light to toggle between the full list and
your favorites selection.
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present in the rules list (as shown in the screenshot below) is all that is
required to have iTrainz Chat available when running that session. 

Remember that to work correctly, iTrainz Chat does require that TRS2006 is
configured with your Planet Auran account.

Tip: When configuring a session to have iTrainz Chat, make sure the
Online Chat rule is flush against the left hand side of the rules list so
that iTrainz Chat will be available throughout the session. Having
Online Chat nested as a child rule may mean that iTrainz Chat is not
initially available when the session first starts.

Tip: If an existing session created by someone else does not have the
Online Chat rule included, you can easily create your own iTrainz Chat
capable version of that session by adding the rule and using the Save
As option on the Surveyor Menu Bar. See section 11.13.1 for further
details on saving sessions.

15.1.2 Interface
When a session with the Online Chat rule is started, the Chat HUD panel will
appear at the right hand side of the screen along with the other Driver
interface HUD panels.
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15 - iTrainz
TRS2006 introduces new online support features that allow interaction
between Trainz users over the internet through Planet Auran.

There are two modules in TRS2006 that make use of the online interaction
capabilities, iTrainz Chat and iPortal. What these modules do and how to use
them is examined in the sub sections that follow.

Note: To use the iTrainz features such as iChat, you must be
registered with Planet Auran and have your TRS2006 installation
setup with your Planet Auran account. Chapter 7 of this manual
describes how to do this.

Note: Although interaction with other online Trainz users is indeed
possible, this is not to be mistaken for being a multi-player shared-
world gaming environment.

15.1 iTrainz Chat
iTrainz Chat is a module that allows you to exchange instant messages with
other online Trainz users when in a Driver session. As well as being able to
exchange instant messages with other online TRS2006 users, you can
manage your contacts list and see when your contacts are online.

Note: You can only exchange iTrainz Chat messages in a Driver
session. iTrainz Chat messaging is not available in Surveyor or any
other Trainz module.

15.1.1 Online Chat Rule
To access the iTrainz Chat features you must be in a Driver session that has
the Online Chat rule included in the session's configuration.

The Online Chat rule itself is very simple to use and does not have any
configuration requirements of its own to deal with. Simply having the rule
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15.1.3 Contact List
The Contact List is where you manage your contacts, check on the status of
a contact, initiate chat windows and send/receive invites (invitations to chat).

A contact is simply a Planet Auran/Trainz community member you have
designated as being on your contact list. You can either list that user as a
friend or ignore them.

To open the contact List window, click on the Status Button on the Chat HUD
Panel. Note that you must be online and connected to Planet Auran to open
the Contact List window.

If you have never used iTrainz Chat before, your list will be empty but that
doesn't mean you don't have friends. It just means you haven't built your list
of contacts yet.

Tip: The Trainz forum is a great place to meet new friends. Go to
http://www.auran.com/TRS2006/ and follow the Forum links to make
some new friends.

For the sake of an example and further explanation, this manual will assume
that from now on, you have some assorted contacts (both friends and users
you want to ignore).
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Located at the left side of the Chat HUD panel is the status button. This button
is used to indicate the current state of the iTrainz Chat connection to Planet
Auran as well as being clickable to open access to iTrainz Chat features.
There are three possible states that the status button can be in:

Idle
Currently connected to iTrainz Chat on Planet Auran but there are no
new messages. This button can be clicked to open the Contact List
window.

Not Connected
Indicates that you are not currently connected to Planet Auran. There
can be several reasons why this is the case that will be examined
later in this chapter.

New Message
There are new messages or invites (an invitation) to chat groups for
you to look at. Clicking on the new message/invite clears the New
Message state and changes it back to Idle state.

Adjacent to the status button there are three head icons colored red, white and
black. Each of these icons has a number value. These icons represent three
different categories of fellow Planet Auran users as defined by you:

• Red - Friends
• White - Acquaintances
• Black - Offline users

The number indicates how many users from that particular category are also
connected to Planet Auran with TRS2006 iTrainz Chat. If you are not
connected, all user groups will be 0.

You manage which users belong to which category through the Contact List
that can be opened by clicking on the Status button (which is examined in the
next section).
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As this user is an invitee, their name only appears on the contact list if the
Invites checkbox at the top of the window is enabled.

Note: The username must be the EXACT Planet Auran/Trainz forum
username of the user you wish to add to your contact list. Usernames
are not case sensitive and there is a 20 character limit. Be careful of
underscore characters - spaces are not allowed in Planet Auran
usernames.

Once invited, that invitee's name will appear on your list with a head icon
adjacent to it. Depending on whether that user is connected or not, the head
will either be red (online) or black (offline).

If the username entered is not valid, the name may flash briefly on the contact
list and disappear straight away. Regardless of the flash or not, the invalid
username won't be added to the list.

The list of contacts you add is global to all sessions with iTrainz Chat enabled
so what contacts you add/remove on one session will affect all other sessions.
The Contact List is not specific to any one session.

Note: iTrainz Chat is only supported in TRS2006 and not every
registered Planet Auran member is a TRS2006 user who will be able
to join you for iTrainz Chat.
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Across the top of the Contact List window there are 4 check boxes with
adjacent icons. These checkboxes determine which contacts from your list will
be visible.

• Friends - Only show friends (either online or offline)
• Online - Only show users currently online (friends and

acquaintances)
• Invites - Show invitations and sent invitations.
• Ignored - Show ignored users.

By default all of these checkboxes are enabled. Once you start un-checking
these boxes, users in your contact list may disappear according to
circumstances. Before hunting for a lost friend, ensure the checkboxes are
appropriately set.

Sending Invites and Broadcasting
At the bottom of the Contact List window is a section containing the send
broadcast button, invite button and an associated text input box.

Clicking either icon results in the entered text being used for that icon's
purpose.

Invitations - Adding New Friends
Other users are added to your Contact List by inviting them. The invited

user need not be online for an invitation to be issued as the invite is held on
the Planet Auran server system until it can be pushed to the invitee when they
next come online.

To add another user on your contact list, enter their Planet Auran name in the
text entry box and then click on the Send Invite icon.
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Ignore
A user on your list that you have opted to ignore. You cannot receive invites

or messages from someone you have chosen to ignore.

Clicking on the contact's name opens a chat window with them, while clicking
on the information icon to the right of that name opens the Buddy Info window
for that contact. See the next two sections for further discussion of these
features.

15.1.4 Buddy Info
To the far right of the usernames in the Contact List window is the information
icon:

Clicking on this icon opens up the Buddy Info window for that user, where you
can choose whether to make a contact a friend, ignore them, or delete them
entirely from your list.

To set the buddy as being a friend or someone to ignore, select the
appropriate radio button. Close the window to return back to the Contact List
which will now be updated to reflect that buddy's new status.
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Broadcasting
Clicking on the Broadcast icon in the lower left corner of the Contact List

opens up the Broadcast window.

In the text entry box at the top of the Broadcast window, enter in your
broadcast message and press "Enter" to send the message to all of your
online friends. Note that only friends that have a chat window with you already
opened will see the broadcast message.

Contact List Members - Your Friends
At the center of the Contact List window is your list of buddies which are listed
in the order that you added them. 

Next to the left side of each name, there is an icon indicating that user's status.

Online Friend
An Online Friend is someone who is in a session with the iTrainz Chat rule,

online and who you have opted to flag as a friend.

Offline Friend
A friend who is not currently connected with iTrainz Chat.
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15.2 iPortal
The iPortals is a special type of portal asset that allows train consists to be
transferred between your Driver session and that of another online TRS2006
user.

This however does not mean Trainz has multiplayer game functionality. The
iPortals allow a train to be moved between two separate sessions. Otherwise
the sessions are still independent and have no other links or synchronization.

15.2.1 Placing and Configuring an iPortal
An iPortal is a scenery object with track and is placed and linked into your
route in the same way an industry is as described in section 11.7.2. The two
iPortal assets can be easily found in the scenery items list as they both start
with "iPortal".

To function in the Driver session, the iPortal needs to be configured. There are
no rules needed, just open the properties window for an iPortal placed on your
route.

To get the iPortal working, not only must your TRS2006 installation be
configured to work with your Planet Auran account, but the iPortal itself also
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Note: Now that the status of a buddy has been changed, that buddy
may not be visible anymore in the Contact List because of how the
checkbox settings at the top of the window are currently set.

Clicking on the Remove Buddy link closes the Buddy Info window and returns
back to the Contact List with that buddy removed.

15.1.5 Chat Window
The Chat Window is where the user can exchange text messages with a
specific contact. A chat window with someone in your list is opened by either
clicking on their name or the icon to the left of their name in the Contact List
window.

Messages can be sent to the other user that the Chat Window was opened
with by clicking on the text entry box at the bottom of the window, typing the
message and pressing "Enter" to send. Your typed messages will be shown in
the Chat Window along those from your friend.

The Chat Window can be closed by clicking on the 'X' in the top left corner of
the window. Each time the chat window is closed and re-opened the chat
history is restored with the selected contact for the current session.
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16 - Content & Assets
Content broadly describes anything that you can add to your TRS2006
software that will expand the collection of objects available to you within the
game. This includes locomotives, rolling stock, track, vehicles, people,
buildings, bridges, tunnels, routes, rules, sessions, scenarios etc. Content is
created by community members just like you and is available from many
places on the Internet. The major source of content is a huge library of over
30,000 objects that can be accessed using Content Manager. This section of
the manual will tell you a little more about identifying and utilizing new content
for TRS2006.

16.1 The KUID System
Whilst you should not need to know much about the KUID (or Koolthingz
Unique IDentifier) system, it is a term you will come across if you start delving
into the world of custom content. A KUID is simply a way of identifying content
for your TRS2006 software. Here is an example:

<KUID:43750:12345:02>

The first part of the KUID (43750 in this example) identifies the content creator,
so all content from any particular author will have the same first set of digits.
When you register at Planet Auran, you will be given a unique content creator
I.D. that you can find in your User Profile.

The second set of digits is the unique identifier for a specific asset from the
author.

There is also a third number. This is the item’s version number and is used to
allow Content Creators to update their creations without having to introduce a
new KUID.
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has several parameters that need setting as well.

iPortal id
Unique ID name that this portal is to be identified by.

Send to user
Name of the remote TRS2006 user that you wish to exchange train consists
with. This setting isn’t needed if you are just transfering trains to other iPortals
on your own route.

Destination iPortal id
Unique ID name of the destination iPortal that this iPortal is to exchange trains
with. This can either be remotely located on another user’s system or from
your own route.

Send Trains
Specifies whether trains are sent over the internet and exchanged with
another user or just transferred locally to another iPortal.

Check for trains
Enable this option if you want the iPortal to wait for trains that another iPortal
may send to it.

Driver mode after create
Determines how trains emitted from the iPortal will be controlled on your route
once they have exited the iPortal.

Trains transferred through an iPortal will retain their vehicle loads so one
potential fun activity is to operate your route such that it requires an incoming
loaded train from someone else through the iPortal.

Don’t forget to use iTrainz Chat so you can communicate with your friend and
arrange iPortal exchanges. iTrainz Chat will also let you know if your friend is
online.
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17.2 Getting Started and Customizing CMP
First let's take a look at the layout of CMP.

17.2.1 Menus
The menu items generally duplicate in-game functions. Many menu actions
have keyboard shortcuts which are shown to the right of the action listed in the
menu.

17.2.2 Bars
There are four bars that you can use to monitor and control various CMP
functions. The Status Bar is fixed, however the other bars are floating and
dockable which allows you to arrange the appearance of CMP as you see fit.
The visibility of each bar can be toggled in the View menu.

Tool Bar
A bar of buttons that allow the user to quickly access commonly used functions
like New Asset, Clone Asset, Open for Edit, Disable/Enable Toggle, Delete,
Launch Trainz and Help.
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17 - Content Manager Plus

17.1 Introduction
Content Manager Plus (CMP) has a number of functions rolled into one
integrated package giving you control and access to the many thousands of
assets available for Trainz. The main functions that CMP offers are:

• Download Station Index
• Downloading Content
• Content Management
• Archiving/Backup
• Uploading Content
• Creating/Editing/Verifying Content
• Paintshed

We will examine each of these functions in the sections below.

Note: Content Manager Plus can only be used with TRS2006, it
cannot be used with previous versions of Trainz.
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Ticket Status
If you have a First Class Ticket (FCT) it shows how many days are left on the
FCT and your total downloads (right-click to reset this). If you don't have a FCT
it shows your daily download total and the limit (currently 100MB)…click on the
ticket to open a browser window which allows you to upgrade to a FCT.

Status Bar
Displays warning/error messages in red/orange/yellow as well as a running
total of items displayed out of the total items available including those on the
download station.

Network Speed
A panel that displays your relative download speed in a graphical form when
you are downloading. Note that it dynamically adjusts the Y axis to keep the
graph on screen.

17.2.3 Main View Panel
The Main View panel can show assets in text or thumbnail mode. Click LMB
on the button on the title bar to select one or the other.

The thumbnail view shows assets with a thumbnail picture of the asset as
uploaded to the Download Station. Thumbnails are downloaded from the DS
as required, so they may take some time to appear.

The text view is more like a spreadsheet with columns containing various
information on each asset. You can elect to view more or less columns by
right-clicking on the header and selecting the columns to show or hide. The
column width can be adjusted by dragging the vertical dividers in the header.
The order of the columns can be changed by dragging and dropping the
column header to a new location.

Just under the title bar are a number of tabs. Clicking on these tabs
immediately shows a filtered view of the assets in the Main View panel which
correspond to search filters as described in the Sorting, Searching and
Organizing Content section. 

17.2.4 Action Panels
The width of the panels can be adjusted by dragging the vertical divider to the
right of the Action panels. There is a minimum width.

You can view/hide the Action panels by toggling with the TAB key or from the
View menu.

Each of the Action panels can be opened and closed by clicking on the icon
in the Action panel's header bar. The action panels are:

Download Helper
Used to download files from the Download Station. See section on the
Download Station and Downloading for details.

Search
Used to find assets. See section on Sorting, Searching and Organizing
Content.

Asset Details
Drag an asset(s) from the Main View panel onto this panel to see the asset in
more detail, including a thumbnail picture. Use the < and > navigation buttons
to scroll through multiple assets. You can rate an asset by clicking on the star
rating (1 to 5 stars), alter its name and description as well as view license
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17.3 Settings
You can bring up the Settings window by either clicking on the Settings button
in the Tool Bar or using the File -> Settings menu option. The settings are
divided between four tabs:

Archives
Lists all the archives of which CMP is aware. You can Add, Remove or Update
archives. Note that removing an archive only removes it from the list, it does
not remove the archive file.

Filters
Lists all the search filters including the default ones. You can remove individual
search filters (default or custom) and restore the default filters. Warning!
Restoring the default filters will also remove any custom filters.

Internet
Enter your Planet Auran username and password and your internet
connection type to get access to the Download Station while on-line. Don't
have a Planet Auran account yet? Then click on the Register Now! link to
register and get access to the Download Station and Community Forums…it’s
easy and free!

Miscellaneous
Here you can enter your user ID (available once registered with Planet Auran).
You must have a user ID to make content for TRS2006 and to find your
content using the "My Content" search filter.

You can also choose Main View settings, icon sizes, sound settings and delete
confirmation choices.

Then there is the option to remove assets from the Download Helper pane
automatically once downloaded, what to do with assets that are open for edit
when launching TRS2006, ability to choose a custom script editor and whether
you want search filter parameters to be applied automatically or require the
use of the Apply button.
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information.

Uploads
Used to upload assets to the Download Station. See section on Uploading for
details

Archiver
Used to archive/backup assets. See section on Archiving for details.

Pick List
This is used as a "clipboard" for assets. Drag and drop an asset(s) from the
Main View onto the Pick List panel to add it. You can remove an asset by
clicking on the "-" button to the right of the asset name or remove all assets by
clicking on the Clear button. To view the Pick List assets in the Main View
panel, click on the View In Main List button. 

17.2.5 Icons
Throughout CMP there are a number of icons with specific meanings which
help you quickly identify an asset's attributes. All icons have tool tips so if
you're not sure what the icon represents hover over it with the mouse cursor
to show its tool tip.

Category
These icons denote the category of the asset, be it a train, route or other
component of the Trainz world.

Status
These icons give you information on the Location, Archive, Modification,
Version, Editing, Origin and Error status of the assets.

Ratings
A zero to five star rating for an asset. Adjust the rating by selecting the number
of stars for an asset in the Asset Details action panel.
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17.4.5 Adding a Search Parameter
The default Search panel has a search parameter of "Name" with no value
entered.

To change the search parameter click on the drop down list and select the
required parameter from the list. If the parameter allows a value to search on,
then click on the value input box immediately to the right of the parameter and
select or enter the required value.

To add another search parameter click on the "+" button to the right of an
existing search parameter and a new search parameter line appears with the
default "Name" parameter with no value set.

Each new parameter and value must be satisfied for items to show in the Main
Panel view, in other words all search parameter lines are "AND".

There is also a "?" button to the left of the parameter name. If this is enabled,
you can click on it to add a logical operator of "does not equal" to the
parameter e.g. "does not equal" Built-In will show only those items that are not
Built-In to TRS2006.

Tip: when searching on Author ID, put in the author's UserID
(#nnnnnn) rather than their username. Once the items have been
found, CMP downloads further information about the asset including
the author's username. Thereafter you can also search using the
author's username.

17.4.6 Removing a Search Parameter
To remove a search parameter, click on the "-" button to the right of the search
parameter.

To remove all the search parameters click on the Reset button. This returns
the Search panel to its default of "Name" parameter with no value entered.
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17.3.1 First Class Ticket and Overcoming Download Limits
All registered users of TRS2006 gain free access to the Download Station.
However, we limit your daily downloads to 100 MB and a maximum speed of
4 kilobytes per second. 

You have the option of upgrading your Download Station access with a First
Class Ticket (FCT). The FCT gives you unlimited downloading from the
Download Station. What is more, the downloads are at broadband speeds so
you get what you want faster. You can get a FCT from our website…in fact
clicking on a non-FCT in CMP will open a browser window at our web shop.

17.4 Sorting, Searching and Organizing Content

17.4.1 Sorting
You can sort on a column by clicking on the column's heading. Subsequent
clicks toggle the direction of sort, ascending or descending order.

17.4.2 Searching
The Search panel allows you to put in one or more search parameters to find
the content you are looking for quickly. Results of the search are immediately
shown in the Main View panel unless the Settings for CMP have been selected
so that the user needs to click on the Apply button to perform the search. 

17.4.3 Default Search Filters
A number of default Search Filters are defined for the most common searches.
These are listed in the form of Tabs in the Main View panel. Clicking on the tab
immediately applies the named search filter.

Note that you can modify a default Search Filter by adding or removing search
parameters. Let's say you select the "All" Default Search filter and add an
extra search parameter in the Search panel (see below). When you do this,
the Search Filter tab changes to "Current Search" to indicate that the assets
being viewed no longer reflect the Default Search filter.
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For some, this large quantity of assets can be overwhelming and you may
want to limit what you see in Trainz, or perhaps you have no interest in a
particular countries' locomotives and rolling stock.

To reduce the number of assets visible in-game you can use the Disable or
Delete function in CMP. 

Note: When disabling or deleting items you may be "breaking" assets
that are dependant on that item. To check if the item you are about to
disable/delete is a dependency, select the item, right-click and choose
View Dependant Assets. This brings up a dialogue box listing the
assets that are dependant on that item. Do you still want to
disable/delete it?

Disabling an asset means that it is still present on your computer, but not
available within Trainz. To disable an asset, select it (one or more) and click
on the Enable/Disable button on the tool bar. To make a disabled asset
available in Trainz, select it (one or more) and click on the Enable/Disable
button on the tool bar.

Deleting an asset removes the asset completely from your computer. Of
course this makes it unavailable in Trainz. If it was a Download Station item it
will still be listed in CMP, but you will have to re-download it to make it active
in the game. To delete an asset, select it (one or more) and click on the Delete
button on the tool bar.

WARNING: Make sure you back up your custom (non-DS) assets.
Once they have been deleted there is no way to recover them.

Note: Built-in assets cannot be Deleted, but they can be Disabled.
Installed, non-built-in assets can be Disabled or Deleted.

252

Current Search and Saving Search Filters
As soon as you modify an existing search filter your search is displayed on the
Current Search tab.

You can also save your own custom searches and they will appear as one of
the tabbed Search Filters in the main view. Here is how…

Once you are happy with the parameters you have selected for your custom
search, click on the Save button to bring up a Save Filter dialogue. Enter a
name for the search filter and click on the Save button. 

The search filter is now added to the tabs in the Main View panel. You can
manage your Search Filters in the Settings dialogue (see Settings).

17.4.7 Keywords
You can use keywords to enhance the description of assets and make them
easier to find. By default all assets have their name text as keywords. Content
Creators can also add keywords to their content when they create assets to
assist in finding them amongst the thousands available.

You can also add your own keywords to content by right clicking on one or
more selected assets and clicking on Edit Keywords in the context menu.
Enter the desired keyword and click on the Add button. You can continue
adding keywords in this way to the selected content.

Once the keywords have been added, in the future you can use the Keyword
search parameter to find the relevant items quickly and easily. 

17.4.8 Disabling, Enabling and Deleting Assets
Once an asset is installed on your computer it is available within Trainz for use
in Surveyor. TRS2006 comes with about 7,000+ items of built-in assets which
are also available in-game.

Note: Some built-in content is not available for use in Surveyor. This
is determined by the content creator who contributed the item.
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Download Helper panel, CMP checks the selected assets for dependencies
and then adds them below the parent asset so the asset is complete. Assets
with dependencies have a "?" icon to the left of the asset's name. Clicking on
the arrow head will show the dependencies in the main screen display.

If you drag a lot of items onto the Download Helper, it may take some time to
check all the assets for dependencies and add them. 

If you already have the assets (parent or child) on the local machine the
Download Helper will not download them again. If the asset is in a known
Archive (see Importing Content and CDPs Archiving), when you start the
download process CMP will get the required assets from the archive.

To view dependencies for a local asset, select it and right-click then choose
View Dependencies from the context menu. A dialogue opens up listing the
dependencies for the asset. You can view the dependencies in the main list by
clicking on the button.

Tip: After viewing the dependencies in the main view you can return
to your previous view by clicking on the "Click here to resume your
previous search" text in the Search panel.

* This is true of assets that have been correctly created and they and their
dependencies are on the Download Station

17.5.3 Managing Your Download Helper List
As you add assets to the list and their dependencies are found, the total size
in MB of the selected assets are shown at the top of the Download Helper
panel.

You can remove individual items from the list by clicking on the "-" button to
the right of the asset's name. Removing an asset removes its dependencies
too. Removing a dependency just removes it, although the parent asset may
not work properly if the removed dependency was critical.
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Tip: Want to just quickly see an asset in Trainz from within CMP?
Select the asset and right-click, from the context menu choose View
In… and then the relevant Trainz module. After viewing the asset,
return to CMP by quitting out of the Trainz module. Note that assets
must be on your local machine to do this as you cannot view items you
haven’t downloaded.

17.5 The Download Station and Downloading
The Download Station, at time of writing, has nearly 40,000 assets available
for you to download and add to your Trainz software. CMP maintains an index
of assets on the Download Station which is constantly being updated via the
internet as new assets are added.

Important! Before you start downloading from the Download Station, you must
register your TRS2006 serial number with Auran and enter your username and
password in the Internet tab of the Settings window.

Use the searching and sorting capability of CMP to browse through the assets
and find what you are looking for; see the section on Sorting, Searching and
Organising Content.

17.5.1 Selecting Assets to Download
Downloading assets has never been simpler. Just select the items you want to
download in the main view panel (you can select multiples by using the SHIFT
and CTRL key modes), then drag and drop them on the Download Helper
panel. 

You can also add assets to the Download Helper panel by right clicking on
them and selecting Download from the context menu.

17.5.2 A Word About Dependencies
Some assets require other assets (dependencies) to make them complete, for
example a locomotive needs bogies, engine sounds, engine specifications
etc… CMP takes care of this automatically*. When you drop an item into the
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Import Content allows you to specify a folder containing the content and on
confirmation CMP will import all the content it finds in the selected folder and
its sub-folders. A dialogue box appears listing the items that have been
imported…you can view the items in the main list by clicking on the button in
the dialogue box.

Import CDPs allows you to select one or more CDP files in an open file
dialogue. CMP imports the asset(s) in the CDP file(s) and a dialogue box
appears listing the items that have been imported…you can view the items in
the main list by clicking on the button in the dialogue box.

17.7 Archiving
The Archive function in CMP allows you to "back up" your downloaded or
custom content. It is not designed as a way of distributing content to others,
use the CDP method instead. 

Why not use CDP's to archive your content? You could, but the advantage of
archives is that CMP knows about what you have put in your archives. Every
time you create an archive, CMP records what assets are in the archive and
where the archive has been saved.

Then, when you need the asset (if you have deleted it), instead of downloading
the asset again needlessly, it takes the asset from the archive. If you have
moved the archive, say to a CD-R, then a dialog box appears requesting you
select the location of the archive. CMP then updates the location of that
archive for use next time.

Some points about Archives beyond what has already been mentioned above:

1. When an asset is archived it is flagged with an archive status
icon ( ).

2. Built-in assets cannot be archived.
3. If an asset is already installed and an archive containing that

asset is installed the already installed assets are marked as 
"open for edit".
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You can remove all the items in the list by clicking on the Clear button.

Assets are downloaded in the order they are arranged in the Download Helper
panel list. To change the order of the list, just drag and drop the assets until
they are in the order you desire. Note that dependencies can only be arranged
beneath the dependency's parent asset.

To keep an item in the Download Helper list, but not download it immediately,
uncheck the checkbox to the far left of the asset. Use this feature to manage
your download quota if you don't have a First Class Ticket.

17.5.4 Starting and Stopping a Download
Once you have selected the assets for download and arranged your download
list you can begin the download by clicking on the Start button. CMP contacts
the DS and begins downloading assets. As each asset is downloaded a blue
bar shows the download progress for the asset and the DS icon to the right of
the asset's name is replaced by a Local icon to indicate success in
downloading/installing the asset. 

The speed of the download is graphed in the Network Speed toolbar if it has
been selected as visible. 

Once the download has started you can stop it by clicking on the Stop button.
Assets not yet, or partially downloaded, remain in the Download Helper list
ready for download. To resume the download, just click on the Start button
again.

Once the downloads are complete you can clear the list by clicking on the
Clear button, or this can be done automatically by checking the Remove
Downloaded Items from the List Automatically checkbox on the Miscellaneous
tab in Settings.

17.6 Importing Content and CDPs
To import existing content, either in folder form, or as a CDP there are two
options available in the File menu.
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a dialogue box appears asking if you want all of the assets installed. You can
select the "all" option in the dialogue or you can bypass this dialogue and then
select which assets to install in the Archiver panel…select the assets by
highlighting them (you can use the Shift and Ctrl keys to select multiple) , then
right-click and choose "Install". A dialogue box confirms the assets have been
installed.

17.8 Creating and Editing Content
There are a number of ways to create and edit content in CMP.

First it is important to know how assets are stored for use in TRS2006. Rather
than a mixture of Jet Archive and "open" custom folders as things were
handled in the past, TRS2006 stores its assets in a database, the Trainz Asset
Database (TAD). 

To create new assets they must be developed and then committed to the TAD
before they can be used in TRS2006. 

Similarly, assets that you want to edit need to be "copied" out of the TAD
(Open for Edit), edited and then committed back into the TAD before the
changes can be seen in TRS2006.

To help create valid or "sane" content for TRS2006 we have developed
Content Creator Plus (CCP) which checks content to make sure it meets our
content creation guidelines before it is committed to the TAD. See the section
on CCP for more information.

To Commit an asset to the TAD that is Open for Edit, select the asset(s) in the
Main View and right-click, then choose Edit -> Commit from the context menu.

Tip: Keyboard shortcut to commit one or more selected assets is Ctrl-
M.

An asset modified locally is flagged with a Modified status icon in the Main
View.
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4. You can use the Archive Settings (select Settings) to add or
remove archives as well as update their location.

17.7.1 Creating Archives
Simply select the assets you want to archive and drag them onto the Archiver
panel. If the asset(s) have dependencies you will be prompted to select which
item's dependencies you want to include in the archive. Note that you cannot
archive built-in assets.

Another method is to select the asset(s) you want to archive in the main list,
then right click and choose Archive from the context menu. The asset(s) are
added to the Archiver panel.

Any unwanted asset(s) can be deleted from the archive list by clicking on the
"-" button to the right of the asset's name.

When you are ready to create the archive, click on the Archive button in the
Archiver panel and you will be prompted to name and save the archive to a
location.

The named archive and its location are stored in CMP's archive list for future
reference. 

Note: Assets that are "open for edit" need to be committed before
being able to be added to an archive.

17.7.2 Installing Assets in Archives
There are a number of ways of installing/restoring assets in an archive.

1. In CMP, select the archive from a list which appears when
clicking on the "?" button in the Archiver panel header.

2. Double-click on an archive (.cmpa) file in Explorer.
3. Drag and drop an archive onto CMP.

In each case the action loads the selected archive into the Archiver panel and
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17.8.2 Editing Content
There are a range of options when it comes to editing content. Similar to
creating content, once the content has been edited, it needs to be committed
to the TAD before the changes are manifest in TRS2006.

Open for Edit
Use this if you want to extract the asset out of the TAD. To do this select an
asset in the Main View and right-click, then choose Edit -> Open for Edit from
the context menu. The asset is flagged with an Open for Edit status icon.
Behind the scenes your TRS2006\Editing directory now has a copy of the
asset sitting in a folder. If you want to automatically open the folder in Explorer
use the next option "Edit in Explorer".

Edit in Explorer
This is the same as the Open for Edit option, but also opens up an Explorer
window with the Open for Edit asset's folder showing. To do this select an
asset in the Main View and right-click, then choose Edit -> Edit in Explorer
from the context menu.

Edit in Content Creator Plus
This is the same as Open for Edit, but in addition loads the selected asset into
CCP. To do this select an asset in the Main View and right-click, then choose
Edit -> Edit in Content Creator Plus from the context menu.

Edit Script
This is the same as Open for Edit, but also opens the asset's script file ready
for editing. The default script editor is Notepad, but you can also select a
custom editor in Settings -> Miscellaneous. Select an asset in the Main View
and right-click, then choose Edit -> Edit Script from the context menu. If the
asset selected doesn't have a script associated with it you will get an error
message and the asset will be left in the Open for Edit mode.
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17.8.1 Creating Content
Besides importing new content/CDPs you can create new content for
TRS2006 in a number of ways.

New
Use this option to create an entirely new asset from scratch. Clicking on the
New button in the tool bar or selecting File -> New from the menu will launch
CCP and begin the creation process. See Chapter 19 of the manual for more
details on CCP. Once the asset has been created it needs to be Committed to
the TAD to become available in TRS2006.

Create New Version
Use this option to update an existing asset. Select an asset in the Main View
and right-click, then choose Create New Version from the context menu. A new
version of the asset is created which is Open for Edit and the KUID version for
the new asset is incremented. You can now make the desired changes and
then Commit the new version to the TAD. This new version will automatically
obsolete the older version it was created from.

Note: You can only use this option with assets you have created.

Clone
Use this option to base a new asset on an existing asset. Select an asset in
the Main View and either right-click then choose Clone from the context menu
or click on the Clone button in the tool bar or choose the File -> Clone option
in the menu. A new asset appears with a KUID based on your user ID and in
Open for Edit mode. Notice the Clone status icon appears in the CMP main
view. You can clone any local assets.

Paintshed
Refer to the Paintshed section of the manual for information on how to create
assets from Paintshed templates and to create new Paintshed templates.
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messages.

Similar to the Download Helper and Archive panels, you can remove assets
from the Uploads panel by clicking on the "-" button to the right of the asset
name.

Once you have your assets organized in the Uploads panel, click on the
Upload button to begin the uploading process.

Firstly a Planet Auran license agreement appears. Once you have read the
license and accept it click on the Accept button.

In CMP a dialogue box opens showing the success or failure of the upload. If
successful, at the same time, CMP logs you onto Planet Auran and the secure
website opens up in a browser window at the Your Content page. 

In the Planet Auran browser window you can click on the "Unprocessed"
button to confirm your asset has been received. It will have a generic name
"upload.cdp" and will also have a time/date stamp so you can identify it.

You can still stop the upload process at this point, by clicking on the "Do not
process" link.

Once a day at around GMT 11:30 unprocessed uploads are processed by the
Download Station and the asset now is moved to the "Waiting for Approval"
station. This is where the content is manually checked for any issues and if it
passes the manual inspection the asset is marked as Approved and you will
receive an email confirming its approval. Please note that as this is a manual
process, the time between processing and approval can vary. We try and get
this done quickly, but we also have weekends, public holidays, sick days,
urgent matters and sometimes an overwhelming amount of content to
approve, so we ask for your patience.

Once you receive an email that your asset(s) have been approved the asset
is usually available on the Download Station within six hours.
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17.8.3 Reverting Content
When an asset is Open for Edit it can be returned to its previous state in the
TAD by using the Revert option. This essentially deletes the asset's editing
folder and turns off the Open for Edit flag. To Revert an asset select the asset
in the Main View and right-click, then choose Edit -> Revert from the context
menu.

Another Revert option, available only for built-in content, is to Revert to
Original. In this case the modified asset is reverted back to its original state as
supplied with TRS2006. Select a built-in asset in the Main View and right-click,
then choose Edit -> Revert to Original from the context menu.

WARNING: When reverting assets all changes made to the asset
are lost. In the case of Revert to Original this means any and all
changes, in the Revert case it means all those changes made
since the asset was last committed to the TAD.

17.9 Uploading
The uploading process has now been streamlined and is integrated with the
Download Station and Planet Auran. 

Important! Before you start uploading to the Download Station, you must
register your TRS2006 serial number with Auran and enter your username and
password in the Internet tab of the Settings window. Your User ID (in the
Settings|Miscellaneous tab) is automatically entered based on your
registration details.

Firstly select one or more assets that you want to upload in the Main View,
then either drag and drop them to the open Uploads panel or right-click and
choose Upload from the context menu.

The selected asset(s) will be moved to the Uploads panel. A dialogue box
appears giving you the option to also include the selected asset's
dependencies. Also if any of the assets are broken or are not your assets then
these assets will be flagged in the dialogue box with appropriate error
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Find the "Alco - Simple Stripe" template asset (it should be near the top when
the list is sorted by name) and right click on it. A menu will appear with a list
of options. Towards the bottom of this menu is Edit submenu. Open it and
move LMB-click on the "New Paintshed Asset" item.

Once clicked, PaintShed will now be started with the Alco template loaded and
ready to paint.

18.3 Interface
The PaintShed interface has 4 buttons across the top of window and 5 views
of the vehicle you will be painting (front, rear, top, left and right). The tools
offered by the buttons can be applied directly to any of the 5 available sides of
the locomotive.
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18 - PaintShed

18.1 Introduction
PaintShed is a utility included with TRS2006 that allows variations of existing
rolling stock to be painted and labeled with an accessible and easy to use
interface.

The aim of PaintShed is to allow novice and expert users alike to create
customized locomotives and rolling stock to further enhance their Trainz
experience.

Previously PaintShed was an extra application that had to be installed
separately but for TRS2006 it is now integrated into the CMP suite of tools
(see the previous chapter for an examination of CMP).

18.2 Starting PaintShed
To get PaintShed running, first start up CMP and select the "PaintShed
Templates" tab found near the top of the CMP interface. This will result in a list
of template vehicles being displayed that can be used with PaintShed.

PaintShed requires a vehicle template asset to use as a foundation for you to
paint on. This means you won't be able to use just any vehicle for your repaint
but TRS2006 comes with a good variety of templates for you to work with.
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Logo
Allows a logo (bitmapped image) to be applied and moved around
on the vehicle's skin.

Save
Save the painted vehicle for export into Trainz or so you can come
back and edit it later.

The exact use of these buttons and what they allow you to do is explained in
the sections that follow.

18.4 Painting the Skin
Painting the skin involves filling areas of the skin with a chosen color. The
different areas of the skin that can be filled will depend on the template asset
used to create the currently open skin. You can see the fill areas of the
template by pressing the spacebar key. Press spacebar again to toggle off the
template display.

18.4.1 Choosing Colors
To choose a color, click on the Paint button (1st of the 4 buttons at the top of
the PaintShed window) to open the Color Chooser window. The Paint button
serves as a toggle to show/hide this window.

Two paint colors can be assigned to help speed the painting process. These
two colors are displayed in the Assigned Color display located in the lower left

266

The 5 different side views of the vehicle shown make up what is known as the
vehicle's skin. The skin constructed here will be applied to the 3D vehicle to
create your own version of that vehicle.

From left to right, the PaintShed buttons are:

Paint
Allows different parts of the vehicle's skin to be filled with a particular
color as defined by the template used.

Text
Allows a text label to be applied and moved around on the vehicle's
skin.
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select a lighter or darker shade of the chosen color.
3. Type a number between 0 and 255 for each of the Red, Gren and 

Blue values in the lower right of the window.
4. Type a number between 0 and 255 for each of the Hue, Saturation 

and Luminosity values in the lower right of the window.

Click LMB on the Add To Custom Colors button in the lower right of the window
once satisfied with the chosen color. The chosen color is now displayed in the
Custom Colors section in the lower left of the window. Click the OK button to
return to back to the Color Chooser window and begin painting with that color. 

Click LMB on the Cancel button to return to the Color Chooser window at any
time.

18.4.3 Customizing the Palette
As well as choosing a custom color for use in the Assigned Color Display, it is
also possible to create a custom color for ready access on the Palette. 

To do this, double Click LMB on a palette color to open the Color Selector
window. This is the same window used to set a custom color as mentioned in
the previous section and as such a custom palette color is created in exactly
the same way.

18.4.4 Saving and Loading Custom Palettes
Custom palettes can be saved to disk and used later with other skins. Click
RMB on the Assigned Color Display to show the custom palette menu.
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corner of the Color Chooser window. 

The palette of colors across the top of the window are ready to be selected for
use. Click LMB on a palette color to assign it to the left mouse button. Click
RMB on a palette color to assign it to the right mouse button.

Click LMB on the double-ended arrow ( ) located above the Assigned Color
Display to switch the assigned colors between the mouse buttons.

Click LMB on the small black and white icon ( ) below the Assigned Color
Display to reset the colors to black and white.

18.4.2 Custom Colors
To select a color that is not in the default palette, double LMB click on the
relevant color in the Assigned Color Display area. This will display the Color
Selector window.

Choosing a color from the Color Selector window can be done in one of four
ways:

1. Click LMB on one of the Basic Colors displayed in the top left of 
the window.

2. Click LMB in the Color Palette section on the right of the window. 
Move the color bar to the right of the Color Palette section to 
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18.4.5 Applying Colors
When the cursor is moved back into the skin windows, clicking LMB will fill in
the clicked area of the skin with the designated left mouse click color while
clicking RMB on the area uses the chosen right mouse click color.

When the cursor is above one of the 5 sides of the skin and it becomes a
paintbrush ( ), this means that PaintShed is in the required mode to fill an
area in with the currently chosen color.

Tip: Remember that if you are unsure what areas the skin template
allows you to fill with color, press the spacebar to toggle the skin
template’s filling area display.

Undo/Redo
In the bottom center of the Color Chooser window, there is a pair
of undo/redo buttons () that can step back or forward between fill
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Click LMB on the Load Palette item to display the Open Palette window.

Click LMB on the different palettes in the list to the left of the window. The
palette colors are displayed in the Palette Preview section to the right of the
window. Click the Open button to load the palette for use in PaintShed.

Click LMB on the Cancel button to return to the Color Chooser screen at any
time.

To save the current palette in the Assigned Color Display, Click LMB on the
Save Palette item in the custom palette menu. This will display the Save
Palette window.

Type a name for the palette into the text box at the top left of the window.
Alternatively, click one of the palettes in the list to save over it. Click LMB on
the Save button to save the palette for later use.

Click LMB on the Cancel button to return to the Color Chooser screen at any
time.
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Click LMB on the More Font Options button to display the Font window.

Select the font type, style and size in the Font window and Click LMB on the
OK button. 

Back in the Text Designer window, check the appropriate boxes in the top right
corner to underline or strikethrough the text. All changes to the text are
replicated in the Preview section of the Text Designer window. 

Click LMB on the Add button to add the text to the skin. To return to the main
PaintShed screen without adding the text, click the Close button.
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actions performed on the skin. The standard undo/redo keys of Ctrl-Z and Ctrl-
Y are supported so you can still undo/redo even when the Color Chooser
window is not visible.

Fill All
The fill button in the bottom right corner of Color Chooser window will
apply the currently selected left mouse click color and apply it to the

entire template. Be careful as this action cannot be undone.

Note: When filling in a section of the skin with color, a corresponding
area on the opposing side may also be filled in the equivalent position.

18.5 Adding Text
Text may be added to further customize a skin. To add text, click on the text
button (2nd left button at the top of the PaintShed window) to open the Text
Designer window.

Type some text into the text field found in the center of the window. 

Click LMB on the black and white color swap in the top left corner of the
window to select different foreground and background colors for the text. This
will open a Color selection window for the text.
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How the text is cloned depends on the cloning option chosen. If "Clone in
Position" is selected, the cloned text will appear in the same location on the
opposing skin.

If "Clone to Opposite End" is selected, the duplicate text will be positioned at
the opposite end on the opposing side.

Moving one piece of cloned text will result in the other cloned piece moving
around on its skin segment in a synchronized way.
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In the main PaintShed view, a dashed border surrounds the currently active
text. Click and drag the text to move it to a different position on the skin. Use
the arrow keys on the keyboard to move the text in smaller increments.
Holding the Shift key down whilst using the arrow keys moves the text in larger
increments.

Note: Text cannot be positioned on sections of the skin onto which you
cannot paint - check the template by pressing the spacebar. 

To move text to a different view of the vehicle, simply drag into that other view.

To edit the text, double Click LMB on it to display the Text Designer window
again. Click LMB on Save once changes to the text have been made. Click
LMB on Close to return to the main Paint Shed view without making changes
to the text.

Even if the text is deselected to do other things, you can always re-select it to
edit/move as desired.

18.5.1 Cloning Text
The Cloning Options are used if you want to have the same piece of text
cloned on the opposite side of the skin that your text is placed on. This means
text placed on the front side will be duplicated on the back side or text placed
on the left side will be duplicated on the right side.
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window and your chosen logo is added to the skin. To return to the main
PaintShed screen without adding the logo, click the Cancel button.

Click LMB+H and drag the logo into the desired position on the train. Use the
arrow keys to move the logo in small increments. Holding the Shift key down
whilst using the arrow keys moves the logo in larger increments.

The logo can be moved to any of the skin sections by simply selecting and
dragging it in the same way you do with text. Note that logos cannot be
positioned on sections of the skin onto which you cannot paint - check the
template.

18.7 Saving the Skin
Saving a skin allows it to be used again and also exports the vehicle with the
skin applied for use in Trainz. To save a skin, Click LMB on the Save button
which is the right-most button at the top of the PaintShed interface. This will
open the Save window.
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18.6 Adding a Logo
PaintShed provides a number of logos that can be added to the skin as well
as the facilities to insert a user-provided bitmap image. To add a loco, click on
the logo button (3rd left button at the tope of the PaintShed window) to open
the Logo Chooser window.

Choose one of the supplied logos or Click LMB on the Browse for New Logo
button to search through your computer for one of your own.

Note: If you are going to browse for your own logo, you will need to
have a bitmap (.bmp) file ready to find and add.

Note how the Image Properties section allows the logo to be mirror and flipped
both horizontally and vertically. Also note how the Cloning Options seen in the
Text Designer window are available for logos. The cloning options for logos
work in exactly the same way as they do for text.

Click LMB on a logo name in the left of the Logo Chooser window to preview
that logo in the right of the window.

Once selected, Click LMB on the Add button to return to the main PaintShed
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18.8 Opening an Existing Skin
It is possible to continue working on a previously created skin rather than
creating a new one each time. 

To open an existing skin, find the asset in CMP (see the previous chapter for
details on using CMP). Click RMB on the asset listing and open the Edit sub-
menu and Click LMB on "Edit in Paintshed".

This will open PaintShed with your vehicle skin ready to edit in the state it was
when you last saved it.
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Type a suitable name for the skin into the text field at the top of the Save
window. As this is actually going to be the name of your painted vehicle, use
an appropriate name that you can remember so you can find your vehicle
easily later on.

Note: Trainz does not enforce unique names of assets but it is highly
recommended that you do use a unique name.

Click the Save button to save the skin with the specified name. This will create
a new vehicle asset with your paint scheme. PaintShed will spend a few
moments creating the vehicle asset and once complete will return back into
CMP.

The CMP view you are returned to will have the Current Search tab selected
with the vehicle asset you just created listed.

Run Trainz, go to Railyard and see if you can find your new vehicle to admire!
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19.2 Getting Started

19.2.1 Starting a New Model Asset
From within Content Manager Plus launch Content Creator Plus using the File
-> New option in the top menu.

A screen showing the different Kinds of assets that can be created will be
displayed.
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19 - Content Creator Plus

19.1 Introduction
Content Creator Plus (CCP) is a program launched from within Content
Manager Plus to generate a config.txt file for the different kinds of Trainz
model assets, or to edit and amend existing config.txt files.

Trainz model assets are classified under different Kinds. Each Kind has
particular data requirements to be entered using the appropriate input
dialogue boxes. A data Container is a portion of the config.txt file that covers
a particular function for the model, for example the model mesh files to be
used, or the effects to be applied.

Within the Container the commands that Trainz recognizes are called Tags.
Each Tag indicates data values to be used or a function to be implemented.
Dialogue boxes and drop down menus are provided for the data entry and
inbuilt error checking will indicate faulty data or entries. An error message
display will assist in creating a correctly configured model.

Certain input fields are mandatory, while others are optional, required for more
complicated models or additional model functions. The program can also load
a previously created config.txt file, for validation, amendment, additions, or as
the basis of a new model configuration file.

The program validates the config.txt file as acceptable for the Download
Station prior to uploading a model or package.

The Content Creator's Guide (CCG) is separately available, for information on
the tags that may be used for each Kind, their functionality, and the data
values required.
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19.2.2 Configuring the Program
The first step is to use the Preferences menu to enter your Personal Details,
located in the top Menu under Edit -> Preference. These are optional personal
details you may enter. The fields will auto fill the values in the config file, when
the appropriate tags are chosen from the drop down menu.

Enter your name or forum name in the Name box.

The Organisation entry may be "My Trainz" for example.

The E-Mail address field is a contact address.

Enter your Website address in the Website box.

The License text entry will display the license details you would like to have
included in the model. Typically include details of model usage, distribution,
limitations, or modification approvals for your model, that you wish to apply.

When you have entered the details, use the Save option. These details will
now be included in all config.txt files for models that you create, when you
choose to place these tags in your asset.
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Choose the correct Kind for the model, and the main input screen will be
displayed.

The main input screen is divided into a number of display areas:

1. Tree view
2. Tag space
3. Graphic View Port (only displays when a mesh is selected)
4. Error Message Box

The screen sections of the program are fully resizable by dragging the frame
edges.
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When opening an existing model config.txt file for editing, CCP will display all
the entered containers in the tree view. The example diagram below is the tree
view for a Kind Traincar model.

The top "node" or Kind is called traincar and is the main container for the
complete config.txt file. Traincar is the name of the Kind that we are currently
creating (when creating other Kinds, for example a bogey, the node would be
called bogey). Under that container are other sub containers in the config file. 

The tree may be freely expanded or collapsed (by clicking with the LMB on the
plus or minus symbols). When you click on one of the nodes, it will show the
tags that are included for that container in the tag space so you can add new
entries or edit existing values.

While some containers may be renamed, others are required to retain a
unique name. In this case, attempting to rename a container may give a
warning message, for example "You cannot rename the container "mesh-
table" because it is a unique type."

When you click RMB on one of the nodes a contextual menu will popup with
five different sections.
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19.2.3 Menus

File -> Save
Save the current config.txt file. Used to save and replace a previously saved
file.

File -> Exit
To exit the program, you will be asked if you wish to save the config.txt file.

Edit -> Cut, Copy, Paste
To remove, copy or paste containers or multiple tags, useful for reproducing
similar entries, such as multiple sound files, or attached track entries for
example.

Edit -> Refresh:
To referesh the screen display.

Edit -> Preferences
To set the program preferences .

Help
The Help file and Details about the program.

19.2.4 The Tree View
When an existing config file is loaded using the File -> Open menu, the
program will "parse" the text file and gather two different kinds of information:
the Containers and the Tags. The tags are values being assigned to a
property, and a container is a section of the config.txt file that groups a number
of tags or other containers. 

With many possible tags and containers, the best way to manage the display
of containers and tags is to load them in a hierarchy as a tree view (as for
example, the tree view of Explorer). When starting a new model, the Tree view
will be empty, and containers and tags will be added as required to build up
the config.txt file for the model.
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Section 4
The rename option allows the container name to be changed. For example, all
the meshes under the mesh table can have a unique custom name, but a
container cannot be renamed using a name that already exists. The tree view
will allow the name to be edited, by clicking RMB on the name, and using the
rename option. 

Section 5
The remove option allows deletion of unwanted container from the config.txt
file, particularly useful if editing a config.txt file from an existing model asset to
create a new model. Click RMB on a container name to open the options for
the container, and select an item by clicking on LMB.

19.2.5 The Tag Space
This section of the program displays the content of a container. It dynamically
changes as you either select different containers or add/delete tags.
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Section 1
The first section is the available sub container section, and shows sub
containers that may be added to the opened container (in this example, an
Effects container has been added). Select a sub container by clicking LMB on
it. Depending on the type of container added, a number of compulsory or
mandatory entry dialogue boxes may appear in the tag space.

Section 2
The second section is the tag section. This shows the list of non compulsory
tags. (A non compulsory tag is an optional tag for additional functionality).
Clicking LMB on one of the choices will add the tag in the tag space that
represents the container. Any non compulsory tags may also be deleted.
Occasionally, some containers have no additional optional tags.

Section 3
These options allow the chosen entries to be removed or copied to the
clipboard. To paste the item in another location, use the Paste function in the
top menu bar.
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19.2.6 The Graphic View Port
When a mesh is referenced for the model, the mesh file name needs to be
specified, using the file browser. The mesh file name may be typed, with any
local path, or browsed for the file name. The program will load the referenced
mesh file and the view port will display the rendered image for viewing, to
verify it is correctly selected, or to see the mesh shape or details.

Buttons below the view port allow the camera to be moved, and allows the
mesh to be rotated or zoomed in and out. You may use the mouse within the
image box to move or rotate the image.When you click LMB on a container
that holds a mesh, the rendered mesh will change to the one you've selected.
The mouse roll button may also be used for zooming.

19.2.7 The Error Box
When a config.txt file is loaded or saved, the program will validate the data
input to make sure that everything is correct. The error box is used to output
error/warning messages to the user to assist error checking if the model is not
working in Trainz. 
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Section 1
The Kind: This is the label or title of the container (the asset Kind): When
clicking on a container, a new container display is loaded in the tag space. In
this example, the main container "traincar" is selected, and the name of that
container is set as the title, "Traincar".

Section 2
The tag list: The name of every mandatory and/or selected optional single tags
will be displayed on the left hand side of the space. (On some occasions, it will
be a text box, in which case the tag name may be changed).

Section 3
The delete button: A tag that has a delete button is a non compulsory
(optional) tag and clicking LMB on the delete button will remove the tag from
the container (it will be placed back in the tree view menu, for possible re-
selection).

Section 4
The list of values: For every tag, there is an associated value to be entered so
that the program passes that value to the tag. There can be different ways of
entering the value (combo box, text box, tick box, or several text boxes).
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While loading the file, CCP will parse the file and show any warning and error
messages based on missing or incorrect tags, or tags that should not be
included in the file.

Note: As soon as the file is opened with CCP, changes are made to
the config.txt file, even if you exit the file without saving. For this
reason, If you wish to retain the original config.txt for reference, you
should open the asset in Explorer, and make a backup of the config,txt
file, before you open it in CCP.

If you import an asset with a Trainz-build 2.4 or earlier, into CMP, any error
messages will assist you in making the asset compatible with TRS2006. If you
open that asset in CCP it will convert it to Trainz-build 2.5, and additional
errors may be flagged, requiring fixing. 

If you import an asset after entering a Trainz-build 2.5 tag in the config.txt file,
CCP will NOT convert the file to Trainz-build 2.5 format. It will expect all
relevant Trainz-build tags to have been entered prior to import. Error
messages will assist in file correction.

19.3.3 Formats for Entering Tag Data
Tags require different types of entry, depending on the type of data required.
Some will require a simple text string and others will require more complex
data like a VectorX , a float list or a Boolean value. The program will generate
different types of Graphic User Interface (GUI) for different data types.

String, floating point or integer number
These three data types are simple text or numeric values. A string entry is text,
a floating point number (or float) includes a decimal point, and an integer
number has no decimal point. The value you type in an entry box will be
directly associated with the tag.

VectorX
Vectors are a series of required values. The X represents the dimension of the
vector (the number of input values required). For a Vector3, there will be three

290

Clicking LMB on an error message will display the relevant tag in the program.
Clicking RMB on a message or error line will display a contextual menu with
the option to copy the message to the clipboard.

19.3 Using The Program

19.3.1 Creating a New Asset
In the file menu in Content Manager Plus, using the option File -> New will
open a list, where the Kind for the new asset may be selected.

This form shows all the asset Kinds supported by the program. Select a kind
and the program will generate the basic config.txt file structure for that kind,
using the mandatory tags. Mandatory tags may not be sufficient to create a
fully working asset. You may also add additional optional tags and containers
to your config.txt file for a more complex model.

19.3.2 Opening an Existing Asset
In Content Manager Plus, select the existing model and use RMB to open a
menu, choose Edit in Content Creator Plus and the program will load the
config.txt file for examination or editing. 
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Boolean Entry
A Boolean entry is a simple true or false value. It is represented by a check
box.

Clicking LMB in the box will toggle the tick mark on or off. A tick represents true
and for an unchecked box, the entry is false.

Data Choices
Where a large list of choices is offered, it is convenient to display the available
selections in a combo box.

Open the box and select a value by clicking LMB on that value. A check mark
is shown in the box. Multiple choices may be selected by ticking additional
boxes in the list.
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text boxes requiring three floating point numbers (numbers which include a
decimal point) to be entered.

Float List Entry
A float list for a tag will take a series of floating point number values.

The list above includes a series of four floats, each of which can be removed
if required. Additional values may be added to the list by clicking on the add
button to add a new float entry box.

KUID Entry
The KUID entry is made up of three different parts: The user ID, the content
ID and the version ID

When the personal details option has been filled in, the first field will be filled
automatically with your user ID. Otherwise, the program will default to a -1
user ID. The second entry is the content ID which represents the Identification
number of the asset that you are currently creating. The third value is the
version ID which is the version identification number of the content that you
are currently creating or editing. The maximum value for the version ID is 127.
If this limit is reached, a different Content ID is used for the model.

Note: When creating a new asset the KUID is assigned automatically,
and is not editable by the user.
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Asset Browser
This kind of GUI is a KUID entry but for simplicity, a list of installed assets by
name, instead of kuid, is presented in the browser. It is used to retrieve
dependencies of the model, such as an interior, bogey or horn sound for a
traincar.

Click LMB on the small browse button ( ) and this browse form will pop up.
Some browsers will filter the file types so a valid file is offered for selection.
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File Browser
A file browser GUI is used to locate data stored on the computer hard drive, a
mesh file name and local path for instance, a script file, an animation file or a
texture file.

Clicking on the small browse button ( ) with LMB will open a file browser.

Once the file is located click LMB on the OK symbol and the field will be filled
with the file name and path name.

The file type selections in the browser will reflect the types that are required to
fill the dialogue box. In the following browser opened from the mesh dialogue
box, the correct available mesh extensions are offered (*.IM, *.LM, *.LM.TXT).
From a script dialogue box, the file types will be of the *.gs or *.gse types. A
texture search will offer the *.bmp, *.jpg and *.tga file types.
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19.3.5 Inheritance Template
The model asset Kinds have a certain relationship to each other. The
following chart shows how these are related, the way the classes are
inherited in the game.
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Browse through the list of installed assets, or type in a partial name in the top
box to locate the asset required, select the asset from the list, and then click
LMB on the Select button. This will internally store the asset KUID in CMP. A
null KUID may also alternatively be selected, where that option is required by
the original asset.

Some files shown may have similar names, and you will need to determine the
correct file. If you know a kuid for the required asset to be selected, you can
locate that kuid in CMP, note the name of the asset and then locate it by name
in this browser. It is advisable to give all assets relevant and distinctive names.

After an asset is loaded with the browser, LMB clicking on the small "C"
content button ( ) will take you to that asset in CMP. You can then verify that
it is the correct asset, or check details.

19.3.4 Saving the config.txt File
Use the file menu option Save to save the config.txt file. You do not need to
specify a location, CCP will automatically save the file correctly.
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Leave the NaturalPoint application running (you can minimize it to the System
Tray though) and start TRS2006.

20.2 Using Track IR in TRS2006
TRS2006 supports Track IR in the Internal (Cabin) and Roaming camera view
modes when in Driver. When in either of those modes, activate Track IR
camera view control by pressing Ctrl-H. Press Ctrl-H to toggle back to normal
camera control of mouse & keyboard.

Note: You may find that re-centering of the Track IR is necessary to
access a full range of viewing angles. By default this is the F12 keys.
Hotkeys for Track IR can be set under the "Hotkeys" tab of the
NaturalPoint application.
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20 - Track IR
TRS2006 supports the use of Track IR by NaturalPoint software. This means
you can use infrared tracking of head movement to control the camera in
driver - effectively allowing you to "look around" in the Trainz world.

Note: It is assumed that you already have the NaturalPoint software
and infrared camera system setup

20.1 Getting NaturalPoint Ready
To use Track IR in TRS2006, the Natural Point software needs to be started.
Open it by going to it on the Windows Start Menu

Once launched, click on the Motion tab near the top center of the NaturalPoint
application. In the blue box labeled "Edit Motion Type", ensure that the
"trackIR Enhanced (Absolute)" radio button is selected.
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surface into a two-dimension painting which they then lay on the surface of a
polygon or set of polygons to give the illusion of detail or texture. In fact, in the
world of 3D Modeling, these painting are called "textures". Creating complex
detailed textures is a bit of an art form. But the good news is that you can often
uses textures provided by other. Or you can use a digital camera to take a
picture of something in the real world that gives you the texture you want.
Textures can, for example, be developed from pictures of real logos on trains
and then used on our 3D models.

TRS2006 does not include a "paint" program but software such as Microsoft
Paint which is likely already on your machine can be used. Another popular
tool used by website developers is Paint Shop Pro by Jasc Software. The
premiere product commercially is Adobe PhotoShop but it is significantly more
expensive.

Once you have built and admired your 3D model of say, a boxcar, you then
add several key points to the model and label them properly. The are points
such as the centers of the bogeys (trucks) and the centre point of the couplers.

Now you go through a procedure of exporting the 3D model to TRS2006. This
process turns the model into a file which TRS2006 recognizes and then is
willing to add to your roster of rolling stock. The model is then run through the
Trainz Exporter Verification Tool before you’re able to see it appear in the
game.
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21 - gMax
gMax is a powerful subset of 3Dmax, one of the leading commercial packages
for developing 3D Models and Animations. 3Dmax is produced by Discreet
Technologies. gMax was created to provide owners of sophisticated games
systems such as TRS2006 with the ability to develop their own animated 3D
Models for use in the game. Auran Technologies has licensed the right to
include gMax interfaces into its product. GMax itself is available to you as a
free download as an owner of TRS2006.

The use of gMax is thoroughly described in the help files and tutorials that
come with it as well as in two books that are available commercially. Learning
how to use gMax is a much longer process than to learn everything else in
TRS2006. It can be quite complex. But the good news is that lots of help is
available from other TRS2006 users on the TRS2006 Community forum. Also
there is a list of excellent tutorials available on the TRS2006 website covering
many of the aspects of designing and building objects. gMax itself comes with
an excellent set of tutorials to help you learn how to build 3D models and
animate them. In this section we will provide a very high level overview of how
new assets are developed using gMax to provide an insight into what is
involved.

To build a 3D, you manipulate a variety of different 3D shapes such as lines,
planes, cylinders and spheres to develop the shapes you need to represent
the parts in, say, a locomotive. These can be made as simple or as complex
as you wish. But prudent designer try to keep their designs as simple as
possible while achieving the effect they want in order to keep the "polygon
count" low.

What is a "polygon count"? 3D models in the end consist of many small
patches of surface. For example a cube has six faces and a polygon count of
6 (surfaces). More complex shapes such as the nose of an F7 diesel will have
higher polygon counts.

To keep polygon counts low, designers often resort to putting the details of a
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22.2 Driver

General Driver Controls
Headlight L
Pantograph KP 1
Horn H, KP + (plus)
Sand toggle V
Bell B

Help toggle Ctrl-H
Decouple toggle Ctrl-D

Map M
Pause P

Driver 1 Ctrl-1
Driver 2 Ctrl-2
Driver 3 Ctrl-3
Driver 4 Ctrl-4
Driver 5 Ctrl-5
Driver 6 Ctrl-6
Driver 7 Ctrl-7

Find Object Ctrl-F

HUD Panel Controls
HUD interface toggle F5
HUD driver bar toggle F6
HUD button bar toggle F7
HUD custom hud toggle F8
HUD controls toggle F9

DCC Mode Train Controls
Accelerate/forward X
Decelerate/backward W
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22 - Keyboard Controls Summary

Note: KP = Keypad

22.1 Trainz Main Menus

Trainz Main Menu (Trainz Entry Screen)
Driver Main Menu D
Surveyor Main Menu S
Railyard R
Trainz Exchange X
Quit/Exit Trainz Escape, Q

Surveyor Main Menu
Exit to Trainz Main Menu Escape, M
New route N
Delete route/session D
Open selected route/session Enter

Driver Main Menu
Exit to Trainz Main Menu Escape, M
Session Save/Load Panel Tab
Delete selected session D
Start selected session Enter

Railyard Screen
Exit to Trainz Main Menu Escape, M
Favorites F
Info Tab
Horn H
Lights L
Pantographs P
Interface toggle Ctrl-Space
Close Ctrl-W, Ctrl-Q
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External view 2
Tracking view 3
Roaming view 4

Camera Controls:
Camera up (up)
Camera down (down)
Camera left (left)
Camera right (right)
Zoom in Page Up
Zoom out Page Down

Cabview Camera Controls:
Previous cab view [ (left bracket)
Next cab view ] (right bracket)
Camera snap to previous view Ctrl-[ (left bracket)
Camera snap to next view Ctrl-] (right bracket)

22.3 Surveyor

General Surveyor Controls
New map Ctrl-N
Save map Ctrl-S
Edit map Ctrl-E
Options Ctrl-O
Performance options Ctrl-T
Find object Ctrl-F
Mini-map Ctrl-M
Rules Ctrl-R
Undo Ctrl-Z
Redo Ctrl-Y
Hide/display interface Ctrl-Space
Quick drive Ctrl-F2
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Stop S
Apply handbrake A

Cabin Mode Train Controls
Release brakes Q, KP9
Brake lap Z, KP6
Apply brakes A, KP3
Emergency brakes Pause/Break

Independent brake toggle E, KP 4
Independent brake bail D, KP 0

Increase throttle W, KP8
Decrease throttle X, KP2
Throttle 0 S, KP5

Reverser handle forward F, KP Star (* = asterisk)
Reverser handle backward R, KP Slash (/ = forward slash)

Dynamic brake toggle C, KP7
Shovel coal Space
Fireman wave Shift-Space
Cabin fans Shift-F
Firebox door toggle KP1

Injector up I
Injector down O

Blower up N
Blower down Shift-N

Cameras

Camera View Mode:
Internal view 1
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Rotate displacement anti-clockwise Shift-[ (left bracket)
Rotate displacement clockwise Shift-] (right bracket)
Decrease displacement scale Ctrl-[ (left bracket)
Incease displacement scale Ctrl-] (right bracket)

Selection box B
Apply displacement F
Cancel selection D

Paint Mode F2

Paint Controls:
Rotate texture counter-clockwise [ (left bracket)
Rotate texture clockwise ] (right bracket)
Decrease texture scale Ctrl-[ (left bracket)
Increase texture scale Ctrl-] (right bracket)
Decrease cursor radius – (minus)
Increase cursor radius + (plus)
Get texture G
Fill selected grid L
Selection box B
Selection fill F
Cancel selection D

Objects Mode F3

Object Controls:
Object mode O
Spline mode S

Previous object – (minus)
Next object + (plus)
Add object A
Move object M
Rotate object R
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Bookmarks
Go to bookmark 1 1
Go to bookmark 2 2

3,4,5,6,7,8,9...
Go to bookmark 10 0

Set bookmark 1 Ctrl-1
Set bookmark 2 Ctrl-2

3,4,5,6,7,8,9...
Set bookmark 10 Ctrl-0

Clear bookmark 1 Ctrl-Shift-1
Clear bookmark 2 Ctrl-Shift-2

3,4,5,6,7,8,9...
Clear bookmark 10 Ctrl-Shift-0

Topology Mode F1

Topology Controls:
Height up U
Height down D
Height adjust A
Decrease cursor radius – (minus)
Increase cursor radius + (plus)
Decrease height sensitivity [ (left bracket)
Increase height sensitivity ] (right bracket)
Get height G
Use height H
Plateau P
Add water W
Delete water Q
Adjust water height E
Extend section X
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World Mode F6

World Controls: 
Add clock A
Move clock M
Delete clock D

Time of Day backward – (minus)
Time of Day forward + (plus)
Previous weather [ (left bracket)
Next weather ] (right bracket)
Previous environment Ctrl-[ (left bracket)
Next environment Ctrl-] (right bracket)

Add world origin O
Find world origin F
Edit world origin E

Tools Mode F5

Tool Controls:
Place camera A
Move camera M
Delete camera D
Place ruler R
Move ruler T
Delete ruler Y
Absolute height S
Paste rotation anti-clockwise [ (left bracket)
Paste rotation clockwise ] (right bracket)
Relative height L
Select area B
Paste area P
Cancel selection X
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Get object G
Delete object D
Name object N
Adjust object height H
Split spline Q
Spline height H
Remove spline point X
Insert spline point I
Smooth spline S

Tracks Mode F4

Track Controls:
Spline mode T
Object mode Y
Trackmark mode V

Previous selection – (minus)
Next selection + (plus)
Add track A
Move track M
Rotate object / trackmark R
Get track G
Delete track S
Straighten track B
Toggle junction direction J
Define name N
Split spline Q
Spline height H
Remove spline point X
Insert spline point I
Smooth spline S
Get spline gradient J
Apply spline gradient K
Get curve radius L
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22.5 Standard Dialog Controls
These controls are generic accross the various dialog boxes seen in both
Surveyor and Driver.

Save S, Ctrl-S, Enter
Don’t Save D, Ctrl-D
No Save Enter, E, Ctrl-e, D, Ctrl-D
Cancel Escape
New N, Ctrl-N
Load Enter
OK Enter, Space
Reset R
Yes Enter, Y
No Escape, N
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Trains Mode F7

Train Controls:
Train mode T
Consist mode C

Previous selection – (minus)
Next selection + (plus)
Add train A
Move train M
Rotate train R
Get train G
Delete train D
Train properties P
Change train heading H
Decouple train X

22.4 Mini-Map
Show/Hide Mini-Map Controls:

Surveyor Ctrl-M
Driver M, Ctrl-M

These controls apply to the Mini-Map in both Surveyor and Driver. They all
toggle the visiblity of various objects by type.

Background texture toggle Alt-B
Gradients toggle Alt-G
Junctions toggle Alt-J
Signals toggle Alt-S
Triggers toggle Alt-T
Trackmarks toggle Alt-M
Industries toggle Alt-I
named objects toggle Alt-N
Objects toggle Alt-O
Train consists toggle Alt-C
Trackside labels toggles Alt-L



313

24 - Beta Testers
TRS2006 has utilized many beta testers over the development period. Some
of our testers have been consumed by the task of testing and others have
squeezed in time when they could. No matter how great or small the
commitment, each beta tester knows how valuable their individual contribution
has been and we would like to thank them publicly here for their efforts. They
not only help us find all the bugs and iron out the idiosyncrasies, but they
continually keep us focused on what the customer wants. We don’t always see
eye to eye on issues, but the friendly discussions that take place are
invaluable in bringing a product of this magnitude together. In the end, there is
no doubt that a better product results from the efforts of the beta group.

Thanks once again to you all.

Trainz Railroad Simulator 2006 Beta Testers:
• Chuck Barkman - CeeBee
• Jeff Barr - Magicland
• John Bathols - John_SB
• Jim Birkhimer - Mr.Den
• Garry Cantle - Winnaa
• Simon Clough - Lost_Soul
• Anthony Connor - axe1970
• Wayne Cook - gandy-dancer
• Karsten Cornelsen - coerni
• Steve Cummins - magicentro
• Alastair Jacques Dussart - Beanpole
• Kenny Ericson - Rc1166
• AJ Fox - AJ_Fox
• Michael Fox - foxgraphix
• Rhian Geleick - weedfreak
• Richard Giberson - Rik81
• Ron Gutowski - aardvark1
• Martin Hammel - _mutton_
• Dave Hammer - dh2k3
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23 - Credits
Producer: Scott Probin
Programming: Christoph Bergmann, Cliff Cawley, Francois 

Coulombe
Art: David Affran, Ian Manion, Vaughan Kidd,

Jason Robson
Design: Henk Plaggemars, Scott Probin, Christoph

Bergmann, Cliff Cawley, Greg Lane
Original Concept: Greg Lane
Scripting: Cliff Cawley, David Walsh
Quality Assurance: Adair Bricknell, Paul Byrom, Scott Cameron,

Michael Dobele
Sound: Ultrasonique Audio
Manual Writing: Henk Plaggemars, Scott Probin, David Walsh, 

Scott Cameron
Marketing: Paul Olsen, Graham Edelsten, Tony Hilliam
Localization: Christoph Bergmann, Kain Whitehouse, Scott 

Probin, David Walsh
Community Support: Lance Jago
3rd Party Relations: Lance Jago, Henk Plaggemars, Scott Probin
Web Team: Lionel Thomas
Communications Director: Dr. John Banks
Legal: Andrew Edelsten, Graham Edelsten
Admin/HR Support: Chris Green, Ann-Marie Hutson, Melissa Keam
Network Administrator: Jeff Dunbar

DVD Limited Edition Video Supplied by:
Main Line Motion Pictures - http://mainlinemotionpictures.com
Video copyright Main Line Motion Pictures
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25 - Third Party Content Creators
To all of you, and especially those of you who have contributed product for this
Trainz release, we would like to congratulate you for a fantastic effort. Without
you we simply couldn’t have released TRS2006. 

BSI - Pro Train Perfect Dresden-Nuernberg
• Richard Glod
• Matthias Gose
• Oliver Henn
• Rolf Steinberg

Cardiff Workshops - Wadalbavale
• David Owen - Davido
• Nathan & Amanda Van Der Meulen - Natvander

IBerTrainZ- Iberior Interior
• Luis Arakama - milcien
• Joseba Barrio - gerok
• Diego Lorenzo - didoz
• Alejandro Martín - ave_252
• Gonzalo Ojeda - gonzaojf
• Angel del Pozo - geloxo
• José Luis Ramírez - Pepelu
• Francisco Rodríguez - Rodgilfr
• Luis Rubio - Transiberiano
• Jordi Sacasas - tramsoller
• Emiliano Sordo - Gor
• Aritz Tusell - aritztg
• Alberto Zato - zatovisualworks

iPortal
• Kenny Ericson - RC1166
• Lars Ljungberg - LLJ
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• Chris Hucklebridge - psycho_aussie
• Tim Leach - leachy
• Roland Leloup - cernunos
• Errol Lynch - benny200
• Klaus Malorny - KlausM
• Ian Manion - vulcan
• James Moody - Bloodnok
• Wayne Padget - LocoGold
• Andre Peche - casey38
• Bob Rogers - bobrog
• Nicolas Romantzoff - nicroman
• Brian Round - Smileyman
• Joe Schlener - jschlen
• Otto Schneiter - Yethi
• Dave Smith - chuffchuff
• Branko Spoljaric - Barney
• Geoff Steele - stryker
• Tim Stoecker - zxt
• Peter Vawser - Peter8
• Bruce Vigurs - alby6
• Anthony Wain - Muliebuck
• Charles Whitedog - cwhitedog
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• Wayne Young - wayne65
• Terry Mcconnell - bl262000
• Charlie Lear - cjlear

Trainz Narrowgaugers
• Mark Baldwin - markb01
• Al Barten - abarten
• Rich Blake - slugsmasher
• David Drake - dmdrake
• Peter Hilton - pgh3
• Todd Hohlenakmp - prowler901
• Charlie Lear - cjlear
• Ben Neal - bdaneal
• Max Nelson - elvenor
• Peter Pardoe-Matthews - narrowgauge
• Robert Pearson - rpearson
• Shane Perriman - thecowboy
• Mike Sutton - sirgibby
• Linda Irene Tingvik - shortline2

TrainzLand
• Alan - Silversmith
• Roger Cabo - CAB
• Suhela Cabo - Suh
• Karsten Cornelsen - coernie
• Rainer Gahn - RFG
• David Hamann - Marinus
• Ralf Cruger
• Ujvari Gabor
• Guido Kriscar
• Andras Suranyi
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MagLev Project
• Craig Scott - beadyboy
• Lance Jago - prr001
• Ian Manion - vulcan

Marias Pass Approach
• Steffen Gross - sg1
• Lothar Hake - lotharhake
• David Hamann - Marinus
• Vilém Jánský - Bald
• Josef Pav - josefpav

Monorail
• Jack Emmerichs - JFE
• Russ Milland - rmilland
• Justin William Smith - LimeBye
• Jack Straessle - jjslll54

Rail-sim.co.uk - Hawes Junction
• Mike Banfield - Mike10
• Alex Barnard - Wulfruna
• David Dallaston - PikkaBird
• Stuart Downs - Deltic_Kid
• Steve Dark - Sdark
• Paul Franklin - Chileanllama
• Terry Franks - Tafweb
• Paul Hobbs - paulhobbs
• Andrew Howard - AndrewH
• James Moody - Bloodnok
• Don Woodman - Wulf9

Razorback Railways
• Greg Furlong - shutter
• Larry Lewis - jenolan
• Dave Reece-Pinchin - daverp
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TRHA Virtual Railway Simulations Group
• Jon Hull - austin316hockey
• Tom Landers - tlanders
• Jay Larkin - crazy_irishman
• Dave Lawrence - aradlaw
• Russ Milland - rmilland
• Terry Morris - Thor1
• Al Sharpe - skybear
• Martin van Kuilenburg - martinvk
• Derek Boles
• Ferd Mels

World of Trainz
• Philip Campbell - Phil_C

EMD SD70 Locomotives
World of Trainz

World of Trainz has been involved in creating content for Trainz for over two
years. I have created many tutorials to aid in the creation of content for Trainz.
World of Trainz has content available as both payware and freeware. The
website is http://www.worldoftrainz.com.

The SD70 locomotive was the last US EMD locomotive to feature a Spartan
Cab. They have 4000 horsepower, weigh 394,000 pounds and are 72 feet and
4 inches in length. The SD70's included with TRS2006 are built as close as
possible to the prototypical locomotives. Like the real item they consume fuel
based on the load and notch setting as do all locomotives available from World
of Trainz. 

The features of the SD70's include but are not limited to the following:
• Highly detailed and accurate texturing and modeling.
• Accurate custom physics (Engine Specs)
• In Cab Control Mode windscreen wipers turned on in interior mode 

stay on when viewing exterior of the locomotive. In DCC Control 
Mode windscreen wipers turn on and off depending on the weather 
conditions.

• Head up views for both the engineer and the conductor.
• All digital gauges work
• Door handle must be clicked on to open doors.
• Includes alpha numbers which allows customizable locomotive 

running numbers.

Future Plans and Products from World of Trainz: The next scheduled release
from World of Trainz is the General Electric AC6000CW followed by many
other GE locomotives. Also planned are several more EMD locomotives.
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TTR 54 The Toronto Rail Lands 
Simulation - 1954
Toronto is located in the Canadian province of Ontario. Established in the early
1800's and located on an excellent sheltered natural harbour on Lake Ontario,
on eof the Great Lakes. It has grown into one of Canada's largest cities. As it
grew, it also became a major railway centre with many railways being located
there. In the 1930's many of these railways consolidated and by 1954, the
Canadian National Railway (CNR) and the Canadian Pacific Railway (CPR)
had become the two national railways in Canada. In 1954, both had major
roundhouses, freight yards and servicing facilities in the downtown Toronto
area which are now called the "rail lands".

TTR 54 is a faithful model and simulation of the Toronto Rail Lands in the mid-
1950's at their peak. At that time the rail lands occupied most of what is now
the downtown Toronto core area. We have included over 800 switches in this
route in order to accurately model the whole area in order to bring the area
back to life again.

The TTR 54 is a route built by a team who are the Railway Simulations Group
of the Toronto Railway Historical Association (www.trha.ca). The TRHA was
formed with the specific mission of establishing a world class railway museum
in the heart of downtown Toronto in the CPR Roundhouse, the Roundhouse
Park and the magnificent Union Station. Our group's long term goal is to
develop multiple versions of the rail lands for different eras and then use them
in planned full size museum simulators at this site.

Iberia Interior
IBerTrainZ

IBerTrainZ was founded three years ago in search of a way of gathering
Spanish, Iberians and Latin-American users and creators of Trainz, who we
named ibertrainzers. Joined up by a website and forum, www.ibertrainz.com,
staff, collaborators and members (more than 1700 registered) share a
common passion for localizing and supplying ibertrainzers with Trainz models,
information and fellowship, all for free and fun.

Our route ‘Iberia Interior’ prototypically depicts a section of a RENFE
electrified double–track line in Central Northern Spain, or Northern Castile.
Long straight sections of track with gentle curves on a flat wheat and oat
countryside, scattered with some industries and not very large towns and
villages.

Locomotives and rolling stock in sessions represent the state of railway
operations in Spain in the 1980’s and early 90’s, by using powerful diesels as
the 333, a ficticious but possible electric 282, a shunter, different passenger
coaches, goods wagons, hoppers, flatcars and tanks.

Sessions:
• Main Line - Basic exploration of the line with passenger and freight 

consists.
• Night Trip - Some railway operations on the early night hours.
• Command Post - Shunting operations following commands to

assemble new consists.

We are keeping on creating all kinds of free objects and rolling stock for
trainzers, even of interest for non Spanish ones, and continuing fostering our
trainz fellowship at our website and forum, www.ibertrainz.com.
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Monorail
The Trainz Monorail Project

The Trainz Monorail Project has implemented the most famous monorail
system in the US for Trainz TRS2004 and, with some additional features, for
TRS2006

The demonstration session includes examples of all the vehicles, all the
components of the beamway, several different types of stations and even the
waterfalls shown here.

Additional resorts and stations are planned along with some other surprises.

Note: This content is not included with TRS2006 and is available from
the TRS2006 website www.auran.com/TRS2006.
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MagLev
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Trainz NarrowGuagers
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Wadalbavale Line
Cardiff Workshops

Cardiff Workshops was formed by David Owen (Davido) and Nathan Van Der
Meulen (Natvander), who teamed up to create quality scenery and rollingstock
found in NSW, Australia. 

We have created a variety of content for TRS2006. The Wadalbavale Line is
a fictional NSW branchline that meanders through scenic rural and coastal
countryside. Also included in our collection are the 48 and 81 Class locos in a
variety of liveries, the 400 Class railmotors and the Silver City Comet in two
liveries, including as it appeared when retired. To support the layout, a variety
of scenery assets including stations, goods sheds and signals have been
added to the collection. This is just a small selection of what Cardiff
Workshops will have to offer.

Sessions:
• 10:04 Passenger - An easy passenger run in a 400 Class railmotor.
• 474 Local Goods - Run a local goods train, shunting wagons along 

the way.

Cardiff Workshops is always working on more NSW Content, including
passenger and freight rollingstock, a collection of stations and associated
station buildings and scenery items and other railway related assets. There will
also be further signals added to the collection included with TRS2006, along
with a comprehensive "Safeworking and Signalling Guide for Trainz"
document.
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Modula City
TrainzLand

TrainzLand was founded 2002 and provide high quality products for Trainz.
High resolution skies, object management.

Modula City is a high level city simulation for streetcars and trams. A lot of
details, funnies and surprises will make the city to one of your dreams. Modula
City includes two streetcars already. No matter if you're managing a route, or
enjoy the wide range of details while driving your tram. Navigate your tram on
many miles through the city and further scenery. Push your tram to the limit on
the coastal high-speed track. 

Passengers wait for you at the stations. Don't disappoint them.

In Modula City 2004 you have the possibility to create Tram Routes. A Tram
Route basically is a list of Stations and on of their Tracks. Modula City 2004
has two types of Stations. Stations that are placed on the ground are generally
single track stations. High-Platform-Stations are generally double track
stations. Signed in front of the name with a H-.

Trainzland is working on the new Metro City Add-On for Trainz. The new city
ambience is breathtaking. New scenery shadowing, crystal clear textures and
high frames will await you. Four trams with realistic driving experience and
controlling included. Ride on elevated tracks or subway lines and feel the new
breeze of Trainz.

www.Trainzland.com
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Hawes Junction
rail-sim.co.uk

The group is formed from a selection of some of the most respected creators
of content for the UK scene. For full details of the group members please see
our website.

The route comprises the 6 miles of the branch from Garsdale to Hawes as well
as 12 miles of the mainline of the Settle-Carlisle line. Included are a 4F and
Class 37 locomotive as well as some relevant coaches and a selection of
goods stock.

There are both Passive and Active versions of the sessions. Use the passive
ones to learn the ropes or simply watch the action unfold and then take-over
the controls in the active version.

It is the intention of the team to complete the construction of the entire Leeds-
Settle-Carlisle route. Please check our website for updates on progress.
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Blue Sky Interactive

http://www.bluesky-interactive.com/

HP-Trainz

http://www.hp-trainz.de/

Razorback Railways

http://www.razorbackrailway.com/


